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1 Product overview

This chapter presents an overview of the hardware components of the HP xw4400 Workstation.

° Product features on page 2

° Product specifications on page 5

° ENERGY STAR on page 14

° Dual-core CPUs on page 15

° HP Cool Tools on page 15
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Product features

Component view

The following image shows a typical HP xw4400 workstation. Drive configurations can vary.

For complete and current information on supported accessories and components, see

http://partsurfer.hp.com.

Figure 1-1 Component view

Table 1-1 Component view

Item Description Item Description
1 Power supply 9 Processor
2 Hard drive 10 Memory module
3 Optical drive 11 System board
4 Side access panel 12 PCI Express card
5 System fan 13 PCI card
6 Chassis 14  Speaker
7 Diskette drive 15 Front bezel
8 CPU heatsink

2 Chapter 1 Product overview
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Front panel components

ENWW

The following image shows a typical HP xw4400 Workstation. Drive configurations can vary.

Figure 1-2 Front panel components

Table 1-2 Front panel components

Item Symbol Description Item Symbol Description
1 Optical drive eject button 8 4,0. IEEE-1394 Connector (optional)
2 Power on light 9 Diskette drive eject button
3 Power button 10 Diskette drive activity light

0] T
4 o Hard drive activity light 11 Diskette drive (optional)
-
5 Universal Serial Bus 2.0 (USB) (x2) 12 5.25—inch drive bays (x2)
-
6 n Headphone connector 13 Optical drive activity light
7 . Microphone connector 14 Optical drive

Product features 3



Rear panel components

The following illustrations shows a typical HP xw4400 workstation.

Figure 1-3 Rear panel components

Table 1-3 Rear panel components

Item Symbol Description Item Symbol Description
1 Power supply Built-In Self Test (BIST) LED 9 Graphics adapter
2 Universal chassis clamp opening 10 USB 2.0 (x2)
-
3 6 PS/2 mouse connector (green) 11 Q Microphone connector (pink)
4 E Parallel connector (burgundy) 12 (( N Audio line-out connector (lime)
5 \ Audio line-in connector (light blue) 13 USB 2.0 (x5)
(3 -
6 'i"i' RJ-45 network connector 14 Serial connector (teal)
lolol
7 Cable lock slot 15 PS/2 keyboard connector
8 Padlock loop 16 Power cord connector

The rear panel connectors are labeled with industry-standard icons and colors to assist you in connecting your peripheral
devices.

4 Chapter 1 Product overview
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Serial number and COA label location

Each workstation has two unique serial number labels (1) and a Certificate of Authentication (COA) label
(2) (for Windows preinstalled systems only). In general, the serial number labels can be found on the
top panel or on the side of the unit and at the rear of the unit. Keep this number available when contacting
customer service for assistance.

Figure 1-4 Serial number and COA label location

Product specifications

The following table lists the physical dimensions for the HP xw4400 Workstation.

Table 1-4 Physical characteristics

Weight (typical 16 kg (35 Ib)
configuration)

Tower dimensions 45 cm (17.7 in.) high
16.8 cm (6.6 in.) wide
45.6 cm (17.9in.) deep

Power supply
Two types of power supplies are available with the HP xw4400 Workstation:
e  460-watt standard power supply
e 475-watt, 80Plus energy efficient power supply compatible with Energy Star requirements
The following sections describe the specifications of these power supplies.
Standard power supply

This section describes the standard power supply for the HP xw4400 Workstation.

ENWW Product specifications 5



Source voltage

Description

+3.3V PCI, PCI Express, audio, CK-410, ICH7R, super I/O, BIOS ROM, and on-board
logic
+5V Storage (disk, optical, diskette), PCI, PCI Express, ICH7R, audio, keyboard/
mouse
+12 V-A PCI, PCI Express, and system fans
+12 V-B Storage (disk, optical, diskette), PCI Express x16 auxiliary connector
+12 VCPU Input to on-board regulator that supplies power for the CPU
12V PCI
5VSB Sleep circuitry

Table 1-5 Max current per rail

Voltage rail Maximum continuous current

3.3V 15A

5V 21A

12 VCPU 15A

12 V-A 155 A

12 V-B 1A
V12N 3A
5VSB 20A

/A WARNING! Do not exceed 110 watts of a 5-volt and 3.3-volt power combination.

Do not exceed 31.5 amps (378 W) of a 12-

volt (CPU/A/B) power combination.

Do not exceed 460 watts of total continuous output power.

Power supply specifications

Table 1-6 Power supply specifications

Item

Description

Power supply

460-W custom power supply (Wide Ranging,
Active PFC)

Operating voltage range 90-269 VAC

Rated voltage range 100-240 VAC 118 VAC
Rated line frequency 50-60 Hz 400 Hz
Operating line frequency range 47-66 Hz 393-407 Hz

Rated input current

74A @ 100-240VAC 7.4A @ 118 VAC

Heat dissipation

Typical 1121 BTU/hr..= (283 kg-cal/hr.)

6 Chapter 1 Product overview
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Table 1-6 Power supply specifications (continued)

Item Description
(Configuration and software dependent) Maximum 2415 BTU/hr. = (609 kg-cal/hr.)
Power Supply fan 92x25 mm variable speed
Energy Star compliant Yes
Blue Angel Compliant (<5 W in S5 — Power Off) N/A
FEMP Standby Power Compliant @115V (<2 Win Yes
S5 — Power Off)
Power Consumption in ES Mode — Suspend to <7W

RAM (S3) (Instantly Available PC)

Power consumption and cooling

The following table lists the power consumption for one typical configuration based on primary power
consumptions. Another typical configuration is listed below.

e 1x3.4-GHz Pentium D processor
e 2x1-GB, 667-MHz memory

e FX1500 graphics card

e 2 x 160-GB SATA hard drives

e 2 optical drives

e Diskette drive

e 1 monitor, powered separately

Table 1-7 Example 1 energy consumption

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled

Windows Idle (S0) 132 W 128 W 132 W
Windows Busy Typ (S0) 194 W 189 W 195 W
Windows Busy Max (S0) 259 W 245 W 261 W
Sleep (S3)* 35W 28 W 41W 34 W 34W 27TW
Power Off (S5) 23W 1.2W 28 W 1.8W 22W 1.2W

* Energy Star low energy mode.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.
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Table 1-8 Example 1 heat dissipation**

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled
Windows Idle (S0) 451 BTU/hr. 437 BTU/hr. 451 BTU/hr.
Windows Busy Typ (S0) 662 BTU/hr. 645 BTU/hr. 666 BTU/hr.
Windows Busy Max (S0) 884 BTU/hr. 836 BTU/hr. 891 BTU/hr.
Sleep (S3)* 11.9 BTU/hr.  9.56 BTU/hr.  13.9 BTU/hr.  11.6 BTU/hr.  11.6 BTU/hr.  9.22 BTU/hr.
Power Off (S5) 7.85 BTU/hr.  4.09 BTU/hr.  9.56 BTU/hr.  6.14 BTU/hr.  7.51 BTU/hr.  4.09 BTU/hr.

* Energy Star low energy mode.

** Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Ef NOTE: When you power down your workstation with the power button on the front panel, the power
consumption falls below 10 watts. To reach zero power consumption, unplug the workstation from the
power outlet or use a power strip with a switch. For additional information on power-saving features,

see your operating system documentation.

The following table lists the power consumption for another typical configuration based on primary power

consumptions.

e 1x2.93-GHz Core 2 Extreme processor

e 2x1-GB, 667-MHz memory
e FX3500

e 2x160-GB SATA hard drive
e 2 x Optical drives

e 1 diskette drive

Table 1-9 Example 2 energy consumption

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled

Windows Idle (S0) 137 W 134 W 141 W
WindowsBusy Typ (S0) 196 W 191 W 198 W
Windows Busy Max (S0) 257 W 253 W 268 W
Sleep (S3)* 35W 28W 41W 34 W 35W 27TW
Power Off (S5) 1.9W 1.2W 29W 1.8W 1.9W 1.2W

* Energy Star low energy mode.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Chapter 1 Product overview
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Table 1-10 Example 2 heat dissipation**

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled
Windows Idle (S0) 468 BTU/hr. 457 BTU/hr. 481 BTU/hr.
Windows Busy Typ (S0) 669 BTU/hr. 652 BTU/hr. 676 BTU/hr.
Windows Busy Max (S0) 877 BTU/hr. 863 BTU/hr. 915 BTU/hr.
Sleep (S3)* 11.9 BTU/hr.  9.56 BTU/hr.  13.9 BTU/hr.  11.6 BTU/hr.  11.9 BTU/hr.  9.22 BTU/hr.
Power off (S5) 6.48 BTU/hr.  4.09 BTU/hr. 9.89 BTU/hr. 6.14 BTU/hr.  6.48 BTU/hr.  4.09 BTU/hr.

* Energy Star low energy mode.
** Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Bf NOTE: When you power down your workstation with the power button on the front panel, the power
consumption falls below 10 W. To reach zero power consumption, unplug the workstation from the power
outlet or use a power strip with a switch. For additional information on power-saving features, see your
operating system documentation.

System fans

The workstation includes a rear system fan, one memory fan, one CPU heatsink fan, one power supply
fan, plus an optional front system fan is available for special considerations.

Resetting the power supply

If an overload triggers the power supply overload protection, all power is immediately disconnected. To
reset the power supply unit:

1. Disconnect the power cord.
2. Determine what caused the overload and fix the problem.
3. Reconnect the power cord and reboot the workstation.

When you power down the workstation through the operating system, power consumption falls below
the low power consumption but does not reach zero. This on/off feature extends the life of the power

supply.
80Plus power supply

This section describes the 475 watt, 80Plus energy efficient power supply.

Table 1-11 Power supply source voltages

Source voltage Description
+3.3V PCI, PCI Express, audio, CK-410, ICH7R, super I/O, BIOS ROM, and on-
board logic
+5.1V Storage (disk, optical, diskette), PCI, PCI Express, ICH7R, audio, keyboard/
mouse
12 V-B PCI, PCI Express, and system fans

ENWW Product specifications 9



Table 1-11 Power supply source voltages (continued)

Source voltage Description
+12 V-D Storage (disk, optical, diskette), PCI Express x16 auxiliary connector
+12 VCPU Input to on-board regulator that supplies power for the CPU
-12vV PCI
5VSB Sleep circuitry

Table 1-12 Max current per rail

Voltage rail Maximum continuous current

3.3V 15A
51V 21A

12 VCPU 15A
12 V-B 175A
12V-D 12A
V12N 3A
5VSB 225A

/A WARNING! Do not exceed 110 watts of a 5-volt and 3.3-volt power combination.

Do not exceed 34.5 amps (414 W) of a 12-volt (CPU/B/D) power combination.

Do not exceed 475 watts of total continuous output power.

Power supply specifications

Table 1-13 Power supply specifications

Item

Description

Power supply

475-watt custom power supply (Wide Ranging,
Active PFC)

Operating voltage range 90-269 VAC

Rated voltage range 100-240 VAC 118 VAC
Rated line frequency 50-60 Hz 400 Hz
Operating line frequency range 47-66 Hz 393-407 Hz

Rated input current

10 A@ 100-127 VAC 10A @ 118 VAC
6 A @ 200-240 VAC

Heat dissipation

(Configuration and software dependent)

Typical 1013 BTU/hr. = (255 kg-cal/hr.)
Maximum 2027 BTU/hr. = (511 kg-cal/hr.)

Power Supply fan 92x25 mm variable speed
Energy Star compliant Yes
Blue Angel Compliant (<5 W in S5 — Power Off) N/A

10 Chapter 1 Product overview

ENWW



Power consumption and cooling

ENWW

Table 1-13 Power supply specifications (continued)

Item Description
FEMP Standby Power Compliant @115V (<2 Win Yes
S5 - Power Off)
Power Consumption in ES Mode — Suspend to <7TW

RAM (S3) (Instantly Available PC)

The following table lists the power consumption for one typical configuration based on primary power
consumptions. Another typical configuration is listed below.

° 1 x 3.4-GHz Pentium D processor
e 2x1-GB, 667-MHz memory

e  FX1500 graphics card

e 2x160-GB SATA hard drives

e 2 optical drives

° Diskette drive

e 1 monitor, powered separately

Table 1-14 Example 1 energy consumption

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled
Windows Idle (S0) 118 W 115 W 116 W
Windows Busy Typ (S0) 199 W 198 W 203 W
Windows Busy Max (S0) 210 W 205 W 207 W
Sleep (S3)* 31w 23W 3.3W 26 W 3.0W 22W
Power Off (S5) 1.8W 1T1W 21 W 1.35W 1,8W 1T1W

* Energy Star low energy mode.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Table 1-15 Example 1 heat dissipation**

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled
Windows Idle (S0) 403 BTU/hr. 392 BTU/hr. 397 BTU/hr.
Windows Busy Typ (S0) 678 BTU/hr. 674 BTU/hr. 694 BTU/hr.
Windows Busy Max (S0) 716 BTU/hr. 698 BTU/hr. 705 BTU/hr.
Sleep (S3)* 10.34 BTU/  7.61 BTU/hr. 11.4 BTU/hr. 8.7 BTU/hr.  10.2 BTU/hr. 7.5 BTU/hr.

hr.

Product specifications
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Table 1-15 Example 1 heat dissipation** (continued)

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled
Power Off (S5) 6.0 BTU/hr.  3.52 BTU/hr. 7.17 BTU/hr.  4.61 BTU/hr.  6.04 BTU/hr.  3.45 BTU/hr.

* Energy Star low energy mode.
** Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Bf NOTE: When you power down your workstation with the power button on the front panel, the power

consumption falls below 10 W. To reach zero power consumption, unplug the workstation from the power
outlet or use a power strip with a switch. For additional information on power-saving features, see your
operating system documentation.

The following table lists the power consumption for another typical configuration based on primary power
consumptions.

e 1x2.93-GHz Core 2 Extreme processor
e 2x1-GB, 667-MHz memory

e FX3500

e 2 x160-GB SATA hard drives

e 2 xoptical drives

e 1 diskette drive

Table 1-16 Example 2 energy consumption

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled

Windows Idle (S0) 107 W 106 W 108 W
WindowsBusy Typ (S0) 168 W 165 W 169 W
Windows Busy Max (S0) 182 W 179 W 183 W

Sleep (S3)* 3.57W 281 W 3.87W 3.10W 3.57W 274 W
Power Off (S5) 1.79 W 1.02 W 2.09W 1.33 W 1.75W 1.0W

* Energy Star low energy mode.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Table 1-17 Example 2 heat dissipation**

115 VAC 230 VAC 100 VAC
LAN LAN LAN LAN LAN LAN
Enabled Disabled Enabled Disabled Enabled Disabled
Windows Idle (S0) 366 BTU/hr. 360 BTU/hr. 368 BTU/hr.

Chapter 1 Product overview
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Table 1-17 Example 2 heat dissipation** (continued)

Windows Busy Typ (S0) 574 BTU/hr. 564 BTU/hr. 578 BTU/hr.

Windows Busy Max (S0) 621 BTU/hr. 611 BTU/hr. 625 BTU/hr.

Sleep (S3)* 1218 BTU/  9.59 BTU/hr. 13.21 BTU/ 10.58 BTU/  12.18 BTU/  9.35 BTU/hr.
hr. hr. hr. hr.

Power off (S5) 6.11 BTU/hr.  3.48 BTU/hr. 7.13 BTU/hr.  4.54 BTU/hr.  5.97 BTU/hr.  3.41 BTU/hr.

* Energy Star low energy mode.
** Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

B NOTE: When you power down your workstation with the power button on the front panel, the power
consumption falls below 10 W. To reach zero power consumption, unplug the workstation from the power
outlet or use a power strip with a switch. For additional information on power-saving features, see your
operating system documentation.

System fans

The workstation includes a rear system fan, one memory fan, one CPU heatsink fan, one power supply
fan, plus an optional front system fan is available for special considerations.

Resetting the power supply

If an overload triggers the power supply overload protection, all power is immediately disconnected. To
reset the power supply unit:

1. Disconnect the power cord.

2. Determine what caused the overload and fix the problem.

3.  Reconnect the power cord and reboot the workstation.

When you power down the workstation through the operating system, power consumption falls below
the low power consumption but does not reach zero. This on/off feature extends the life of the power

supply.

Environmental specifications

ENWW

This section describes environmental specifications of your workstation.

Operating: 5 to 35°C (40 to 95°F)
Temperature Non-operating: -40 to 60°C (-40 to 140°F)

NOTE: Derate by one degree C (1.4 degrees F) for every 305m (1,000 ft.)

altitude over 1,524m (5,000 ft.).

Operating: 8 to 85% RH, non-condensing
Humidity

Non-operating: 8 to 90% RH, non-condensing

Operating: 0 to 3,048m (10,000 ft.)
Altitude

Non-operating: 0 to 9,144m (30,000 ft.)
Shock Operating: '4-sine: 40g, 2-3ms

Product specifications
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Non-operating:
e  Ya-sine: 160 cm/s, 2-3ms (~100g)
e  square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive
shock events.

Operating random: 0.5g (rms), 5-300 Hz
Vibration Non-operating random: 2.0g (rms), 10-500 Hz

NOTE: Values do not indicate continuous vibration.

ENERGY STAR

The ENERGY STAR® program, a government-backed initiative, promotes energy efficiency by
identifying ways to reduce energy consumption. Select HP workstations participate in the ENERGY
STAR program.

B NOTE: ENERGY STAR is not supported on Linux-based workstations.

For those workstations that support ENERGY STAR and have it enabled, the power management
features will be set as follows:

e  Monitor—Enters power savings mode after 15 minutes of inactivity.

e System—Enters standby mode after 30 minutes of inactivity.

B NOTE: If you mustrestore the operating system, reset the ENERGY STAR settings (if applicable) after

the restore.

To verify the factory default power settings for your product, select Start > Control Panel and double-
click Power Options.

ENERGY STAR compliance

EE)

HP products purchased with the ENERGY STAR configuration are compliant with the U.S.
Environmental Protection Agency (EPA) Computers Program. The EPA ENERGY STAR configuration
does not imply endorsement by the EPA. As an ENERGY STAR partner, HP has determined that
products with the ENERGY STAR configuration meet the ENERGY STAR guidelines for energy
efficiency.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. HP
products achieve this result by reducing the power consumption when not being used.

ENERGY STAR on HP Workstations uses Advanced Configuration and Power Interface (ACPI) power
management. The system can wake as a result of a user action (keyboard or mouse) or from the network
or a modem.

The Power Management feature, when used in conjunction with an external ENERGY STAR-compliant
monitor, supports the power-down features of the monitor. The Power Management feature allows an
external monitor to go into low-power mode when the Energy Save timeout occurs.

NOTE: Usingthe ENERGY STAR Save Monitor feature with non-ENERGY STAR-compliant monitors
might cause video distortion when the Energy Save timeout occurs.
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Dual-core CPUs

The HP xw4400 Workstation contains a dual-core processor. Like HT Technology, dual-core processors
enable better performance over traditional processors. Dual-core processors provide the system with
two true processors in a single socket, rather than the two "virtual" processors provided by HT
Technology. Dual-core processors can better handle the load of multi-threaded applications (such as
rendering an image in Digital Content Creation) and highly multi-tasked environments (such as running
several productivity applications while listening to music).

HP Cool Tools

ENWW

HP xw4400 Workstation comes preloaded with additional software that is not automatically installed
when you first boot your system. Additionally, a number of valuable preinstalled tools on your workstation
can enhance your workstation experience. To access or learn more about these applications:

e Open the HP Cool Tools folder by selecting Start > All Programs > HP Cool Tools.
e Click the HP Cool Tools icon on the desktop.
To learn more about these applications, click HP Cool Tools—Learn More.

To install or launch the applications, click the appropriate application.

Dual-core CPUs 15



16 Chapter 1 Product overview ENWW



Installing or restoring the operating
system

This chapter describes the installation and restoration of the operating system.

° Installing the operating system and software on page 17

° HP software on page 20

° Restoring the Microsoft Windows XP operating system on page 21

° HP Backup and Recovery Manager restore points on page 22

° Protecting the software on page 23

° Ordering backup software on page 23

If your workstation was shipped with a preinstalled operating system, it is configured automatically the
first time your workstation is powered on.

Adding optional hardware devices to your workstation before the operating system successfully installs
can cause errors and prevent the operating system from installing properly.

CAUTION: After the automatic installation has begun, do not power off your workstation until this
process completes. Powering off your workstation during the installation process might damage the
software that runs the system.

Installing the operating system and software

The following sections discuss operating system and HP software installation procedures.

Microsoft Windows XP Professional and Vista Business

If operating system reinstallation is necessary, Microsoft® Windows XP™ Professional and Vista™
Business can be installed from the appropriate operating system installation disks. Insert the first disk
and follow the prompts to complete the installation process.

Language selection

At the first boot of the factory preinstalled operating system, you might be prompted to select a language
for the operating system. After selecting the language, read and follow the instructions on the screen
to complete the installation of the operating system. This process might take quite a while, depending
on the system hardware configuration and the language choice. During the process, do not power off
your workstation unless you are directed to do so.

Creating recovery disks

When a new operating system is installed, you are prompted to create recovery disks. Refer to Restoring
the Microsoft Windows Vista operating system on page 20 or Restoring the Microsoft Windows XP
operating system on page 21 for details on the HP Backup and Recovery process.

Installing the operating system and software 17



Installing or upgrading device drivers

To install hardware devices after the operating system installation is completed, the appropriate device
drivers must be available. In addition, for optimum performance, your operating system must have the
most recent updates, patches, and software fixes. Access the following resources for driver and software
updates:

e Visit the Microsoft site to obtain updates for your operating system, including current patches and
software fixes.

e Device drivers are provided on a CD supplied with the peripheral device.

e  Some peripheral device drivers developed for Windows XP or Vista might not be shipped with your
workstation. To locate the current device drivers, see http://www.hp.com/go/workstationsupport.

e Fordocumentation on installing drivers and workstation operation, visit http://www.hp.com/support/
workstation_manuals/ .

Linux-preinstalled workstations

If you have a Linux-preinstalled workstation, follow the instructions in this section to set up your operating
system and software.

After the boot process completes, you can view additional HP Linux documentation by opening your
Internet browser (the browser is automatically set to use the local HP documentation page as its default).
You can also access Linux Web links for Red Hat (Internet access required) by using your Internet
browser.

For additional information about setting up Linux-preinstalled or Linux-enabled workstations, refer to
the HP User Manual for Linux at http://www.hp.com/support/linux_user_manual.

For more information about HP and Linux, see http://www.hp.com/linux.

Starting up the Linux operating system

The first time your workstation is booted, the Red Hat First Boot utility displays. This program enables
you to enter your password, network, graphics, time, and keyboard settings for your workstation.

/\ CAUTION: After the automatic installation has begun, do not power down your workstation until the
process is complete. Powering down your workstation during the installation process might damage the
software that runs your workstation or prevent its proper installation.

When you enable the YPBInd feature in the Network tab of the Linux Setup Tool, you might get a blank
screen for about 15-30 seconds after you have selected and saved all of your settings and exited the
utility. This behavior is normal. The boot process continues its execution after the screen returns.

Restoring the Linux operating system

To restore the Linux operating system, the HP Driver CD and Red Hat box set are required. Download
the latest HP Driver CD to get any new enhancements.

Linux does not support mixed drive types for a manufacturing preload. When restoring the operating
system, mixed drive types can be handled with the restoring media.

Downloading the latest HP driver CD contents

See http://www.hp.com and select Software and Drive Downloads. Find your workstation and
operating system. Select your driver CD under Software, and follow the directions under Release
Notes.
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Installing the operating system with the HP driver CD contents
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10.

Boot your workstation from the Red Hat box set Binary CD 1.

Insert the Linux operating system CDs from the Red Hat box set as prompted.
Continue following the prompts until the operating system is successfully installed.
Configure the X server to start on reboot.

Reboot your workstation.

Follow the prompts to set up your system with the Red Hat First Boot utility.

When prompted in First Boot to add additional CDs, insert the HP Driver CD into the CD-ROM tray
of your workstation.

Click Install next to “Additional CDs.” The HP Driver CD window opens.
Click Press to begin install.

When the install is done, you will have two options— Reboot now... on the left side and Press to
continue, reboot later... on the right side.

Click Reboot now...

Upgrading device drivers

To upgrade a Linux device driver, see http://www.hp.com/go/workstationsupport.

Linux-enabled workstations

Linux-enabled workstations are not preinstalled with Linux. They require the HP Installer Kit for Linux
and the purchase of a Red Hat box set. The Installer kit includes the HP CDs necessary to complete
the installation of all versions of the Red Hat box set that have been verified to work on HP workstation
hardware.

Verifying hardware compatibility

To determine which Linux versions have been verified to work on HP workstation hardware:

1.
2.

Go to http://www.hp.com/support/linux_hardware matrix.

Select your HP workstation model.

Installing the Linux operating system

To install the Linux operating system on your Linux-enabled system, follow the instructions for Restoring
the Linux operating system on page 18 in this chapter.

For more information concerning the setup of Linux-preinstalled or Linux-enabled workstations, refer to
the HP User Manual for Linux located at http://www.hp.com/support/linux_user_manual.

For more information about HP and Linux, see http://www.hp.com/linux.

ENWW
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HP software

The following HP software may be installed on your workstation depending on the operating system and
options:

e  Computer Setup (F10) Utilities and diagnostic features
e HP Support Software including device drivers

e  Security Management tools (optional)

e  Software Support Management tools

Additional software is available for download:

e HP Client Manager Software is available at http://www.hp.com/go/easydeploy.

e System Software Manager is available at http://www.hp.com/go/ssm.

B NOTE: Additional HP software might be required in certain situations.

Restoring the Microsoft Windows Vista operating system

Your workstation has a several methods to restore your Windows Vista operating system to a near-
factory state, or to the state of the system at a predefined restore point. Your system has a recovery
partition on the system hard drive that contains software and data required for the restore process as
described in the following sections.

The HP Backup and Restore (HPBR) process

The Window operating system and device drivers (for devices shipped with the system) are reinstalled
using this process. The HPBR process can be executed from DVD, CD, or from the recovery partition
contained on your system hard drive. Select Start > All Programs > HP Backup & Recovery > HP
Backup and Recovery Manager to launch the HPBR.

/A CAUTION: Backup your data before you attempt any operating system restore. All data on the
Windows partition will be deleted when you perform a system restore using the HPBR process. However,
the recovery partition on the system drive and other partitions should not be affected.

Creating system recovery DVDs or CDs

You can create a set of the DVDs or CDs from your system if you have a DVD/CD burner. After launching
the HP Backup and Restore Manager, you can create ISO images of the factory image, or burn them
directly to CD or DVD media. You can also create a supplemental HP Backup and Recovery Manager
CD. (There may be additional CDs you can create depending on the options you purchased.) You also
have the option to move images of the CDs to another location, such as a network share, to be burned
to DVD or CD at a later time or from another system.

Restoring from HPBR DVDs or CDs

To start the system recovery process, boot from the previously-created DVD or CD and carefully follow
the online instructions.
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Restoring directly from the recovery partition
Follow these steps to start the HPBR system restore process from the Recovery Manager:
1. Boot the workstation.
2. Press the F11 key when prompted on the boot splash screen to enter the Recovery Manager.

3. Follow the prompts to restore the system to a factory-like condition.

Reclaiming hard disk space from the recovery partition

The recovery partition can be removed to reclaim the hard drive space. If the recovery partition is
removed, the F11 Emergency Recovery function is not available. The ability to recover the system from
data on the recovery partition will be lost. Any recovery images contained in the recovery partition will
be deleted. The ability to create a recovery media set will be lost.

To free up disk space, you can remove just the recovery partition, or you can completely uninstall the
HP Backup and Recovery Manager application.

e The recovery partition can be removed using Remove HP Recovery Partition in the HP Backup
& Recovery program folder. The recovery partition is deleted, the user partition is extended to
reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP Backup and
Recovery Manager application remains and can be used for data backup and restore.

e The HP Backup and Recovery Manager application can be uninstalled using the Windows Control
Panel > Programs and Features utility. The application is uninstalled, the recovery partition is
deleted, the user partition is extended to reclaim the unused space, and the F11 boot prompt is
removed. Emergency recovery as well as data backup and recovery is not possible after the
application is uninstalled.

/A CAUTION: Deleting the recovery partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

Ordering backup software

You can order a Recovery Disc Set from HP by contacting the HP support center. To obtain the support
center telephone number for your region:

1. Visit http://welcome.hp.com/country/us/en/wwcontact us.html.

2. Select your region.

3. Under the Call HP heading, click Technical support after you buy.

Bf NOTE: Before calling HP to order the software, be sure to have the serial number of your workstation
available. See Serial number and COA label location on page 5 for details.

Restoring the Microsoft Windows XP operating system

Your workstation has a several methods to restore your Windows XP operating system to a near-factory
state, or to the state of the system at a predefined snapshot in time. Your system has a recovery partition
on the system hard drive that contains software and data required for the restore process as described
in the following sections.

The RestorePlus! process

The Window operating system and device drivers (for devices shipped with the system) are reinstalled
using this process. Some application software may not be restored using the RestorePlus! process. In
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this case you must install the application software from the appropriate application CD. The RestorePlus!
process can be executed from CD or from the recovery partition contained on your system hard drive.

/\ CAUTION: Backup your data before you attempt any operating system restore. All data on the
Windows partition will be deleted when you restore using the RestorePlus! process. However, the
recovery partition on the system drive and other partitions should not be affected.

Creating a RestorePlus! CD

You can create a set of the CDs from your system if you have a CD burner. When you first boot your

system, you will be prompted to make CDs for RestorePlus!, the Windows operating system, and a

supplemental HP Backup and Recovery Manager CD. (There may be additional CDs you can create

depending on the options you purchased.) You also have the option to move images of the CDs to

another location, such as a network share, to be burned to CD at a later time or from another system.
Restoring from RestorePlus! CDs

The RestorePlus! process can be started by booting from the RestorePlus! CD.

Restoring from RestorePlus! on the Recovery Partition
Follow these steps to start the RestorePlus! process from the Emergency Recovery menu:

1. Boot the workstation.

2. Pressthe F11 key when prompted during the boot process to enter the Emergency Recovery menu.
The F11 prompt appears briefly during the boot process.

If you have a recovery partition but the F11 prompt is not visible:

a. Press F10 to access the setup menu. (Refer to Using the Computer Setup (F10) Utility
on page 26 for details.)

b. Select Advanced from the drop down menu.

c. Select Power-On Options.

d. Ensure that the F11 prompt is set to Displayed.

e. Ensure that Factory Recovery Boot Support is set to Enabled.
f. Reboot the workstation and press F11 when prompted.

3. Select Recover PC’s factory installed operating system, drivers, utilities, and applications
from the Emergency Recovery menu.

Bf NOTE: Some applications may not be restored using this method.

HP Backup and Recovery Manager restore points

HP Backup and Recovery Manager is preinstalled on your workstation. This software allows you to
backup and restore your system and data. You will be prompted to make RestorePlus! CDs at the first
boot of the system. An Initial Restore Point (IRP) will be created automatically. This restore point is a
complete snapshot of the system partition at the time the IRP was created. The IRP is stored in the
recovery partition on the system hard drive, but you can also burn the IRP to CDs, DVDs, or copy it to
another location. The restore point can be used to return the system partition back to the state the system
was when captured.
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Restoring from the HP Backup and Recovery Manager restore point CD or
DVDs

The HP Backup and Recovery Manager (HPBR) restore point can be burned to CD or DVDs and used
to restore the system. Typically you would used the CD/DVD set if the hard drive has been replaced or
all partitions have been corrupted. Boot the system from the HPBR restore point CD/DVD and follow
the online instructions.

Restoring from the HP Backup and Recovery Manager restore point on the
Recovery Partition

The HP Backup and Recovery Manager (HPBR) Initial Restore Point is stored in the system recovery
partition and can be restored using the Emergency Recovery menu. Boot your system and press the
F11 key when prompted to enter the Emergency Recovery menu. The F11 prompt appears briefly during
the boot process. From the Emergency Recovery menu, choose Recover PC to a specific point in
time and follow the instructions.

Protecting the software

To protect software from loss or damage, keep a backup copy of all system software, applications, and
related files stored on the hard drive. See the operating system or backup utility documentation for
instructions on making backup copies of data files.

Ordering backup software

If you are unable to create system recovery CDs or DVDs, the HP Restore Plus CD set can be obtained
through product support on http://www.hp.com/support.

Bf NOTE: Before calling HP to order the software, be sure to have the serial number of your workstation
available.
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System management

This section describes the various tools and utilities that allow for the system management of the
workstation.

° Computer Setup (F10) Utility on page 25

° Desktop management on page 33

Computer Setup (F10) Utility

ENWW

The Computer Setup (F10) Utility enables you to:

e Change factory default settings and set or change the system configuration, which might be
necessary when you add or remove hardware.

e Determine if all of the devices installed on the workstation are recognized by the system and
functioning properly.

e Determine information about the operating environment of the workstation.

e  Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

e Establish and manage passwords and other security features.

e Establish and manage energy-saving time-outs (not supported for Linux platforms).
e  Modify or restore factory default settings.

e Set the system date and time.

e Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

e Modify the boot order of installed mass storage devices such as SATA, SAS, diskette drives, optical
drives, network drives, and LS-120 drives.

e  Configure the boot priority of SATA and SAS hard drive controllers.

e Enable or disable Network Server Mode, which enables the workstation to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse attached.
When attached to the system, the keyboard and mouse remain locked until the power-on password
is entered.

e Select POST Messages Enabled or Disabled to change the display status of POST messages.
POST Messages disabled suppresses most POST messages, such as memory count, product
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless
of the mode selected. To manually switch to POST Messages Enabled during POST, press any
key (except F1 through F12).

e Establish an Ownership Tag, the text of which is displayed each time the system is powered on or
restarted.

e Enter the Asset Tag or property identification number assigned by your company to this
workstation.
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Enable power-on password prompting during system restarts (warm boots) and power-on.

Hide or make available the integrated I/O functionality, including the serial, USB, or parallel ports,
audio, or embedded NIC. Any hidden devices are inaccessible and increase overall system
security.

Enable or disable removable media boot ability.
Enable or disable removable media write ability (when supported by hardware).

Replicate your system setup by saving system configuration information on diskette and restoring
it on one or more workstations.

Execute self-tests on specified SATA and SAS hard drives (when supported by the drive).

BIOS ROM

The BIOS of the computer is a collection of machine language programs stored as firmware in ROM.
The BIOS ROM includes such functions as POST, PCI device initialization, plug-in-play support, power
management activities, and the Computer Setup (F10) Utility. The firmware contained in the BIOS ROM
supports the following systems and specifications:

Microsoft WHQL

Alert-On-LAN (AOL) and Wake-On-LAN (WOL)

ACPI 1.0 and OnNow

SMBIOS 2.3.5

PC98/99/00 and NetPC

PXE boot ROM for the integrated LAN controller

BIOS Boot Specification 1.01

Enhanced Disk Drive Specification 3.0

“El Torito” Bootable CD-ROM Format Specification 1.0
ATAPI Removable Media Device BIOS Specification 1.0
MPS Specification 1.4 (for booting Linux SMP)

The BIOS ROM is a 1-MB Serial Peripheral Interface (SPI) part. The runtime portion of the BIOS resides
in a 128-K block from EQ000h to FFFFFh.

Using the Computer Setup (F10) Utility

You can only open the Computer Setup (F10) Utility by powering on the workstation or restarting the
workstation. To access the Computer Setup (F10) Utility menu:

1.
2.

Power on or restart the workstation.

Press the F10 key as soon as your display is active and you see F10=Setup appear in the lower
right corner of the screen.

NOTE: If you do not press F10 at the appropriate time, try again. Turn the workstation off, then
on, and press F10 again to access the utility, or press the Ctrl + Alt + Delete keys before boot if
you miss the opportunity to press F10.

Select your language from the list and press the Enter key. In the Computer Setup (F10) Utility
menu, five headings are displayed: File, Storage, Security, Power, and Advanced.
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4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, and press Enter.

5. To apply and save changes, select File>Save Changes then select Exit.

e If you have made changes that you do not want applied, select Ignore Changes and Exit.

e Toreset to factory settings, select File>Default setup>Restore Factory Settings as
Default. Press F10 to accept the changes. Select Apply Defaults and Exit. This option
restores the original factory system defaults.

/A CAUTION: Do not power off the workstation while the ROM is saving your Computer Setup (F10)
Utility changes because the Complementary Metal-Oxide Semiconductor (CMOS) could become
corrupted. After you exit the F10 Setup screen, it is safe to disconnect power from the workstation.

Computer Setup (F10) Utility menu

Bf NOTE: The following content is subject to change with new BIOS releases, so your menu might be

ENWW

different than shown.

Table 3-1 Computer Setup (F10) Utility menu descriptions

Heading Option Description
File System Lists:
Information e  Product Name
e  SKU Number
e  Processor Type/Speed/Stepping
e  Cache Size (L1/L2)
e Installed Memory Size
e Integrated MAC
e  System BIOS
e  Chassis Serial Number
e  Asset Tracking Number
e Boot Block Date
About Displays copyright information.
Set Time and Enables you to set system time and date.
Date
Flash System Diskette A:
ROM
Enables you to upgrade the BIOS from a ROM image on diskette.
CD-ROM
Enables you to upgrade the BIOS from a ROM image on CD.
uSB
Enables you to upgrade the BIOS from a ROM image on a USB drive or memory stick.
Replicated Save to Removable Media
Setup

Saves the system configuration, including CMOS in a system file. This file can be saved to a
formatted, blank 1.44-MB diskette or to a USB device.

Restore to Removable Media
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)

Heading Option

Description

Restores system configuration from a diskette.

Default Setup

Save Current Settings as Default

Saves the current settings as default settings for the next operation.

Restore Factory Settings as Default

Restores the factory settings as the default settings for the next operation.

Apply Defaults
and Exit

Restores factory default settings, which includes clearing any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes

Saves changes to system configuration and exits Computer Setup.

and Exit
Storage Device Lists all installed non-SCSI storage devices (except SATA devices) and provides options for getting
Configuration specific information about each device.

NOTE: SCSI storage drives will not be listed in Computer Setup (F10).

Hard Disk

Provides information about the hard disk drives in the system.

CD-ROM

Provides information about the CD-ROM drives in the system.

Diskette Type (for legacy diskette drives only) |dentifies the highest capacity media type accepted
by the diskette drive. Options are 3.5" 1.44 MB, 5.25" 1.2 MB, and Not Installed.

Default Values

Resets devices to their default configuration.

Multisector Transfers Options are 8, 16, and Disable.

Transfer Mode Specifies the active data transfer mode. Options (subject to device capabilities) are
Max UDMA, PIO 0, Max PIO, Enhanced DMA, and Ultra DMAO

A new Automatic option has been added to allow for BIOS to automatically determine the
translation mode used to configure a previously formatted SATA or USB mass storage device. This
prevents you from having to know how the mass storage device was previously formatted.

Ordinarily, the translation mode selected automatically by the BIOS should not be changed. If the
selected translation mode is not compatible with the translation mode that was active when the
disk was partitioned and formatted, the data on the disk will be inaccessible.

Translation Mode Options are Automatic, Bit Shift, LBA Assisted, Use (Cylinders, Heads, Sectors),
and Off.

Storage Options

Removable Media Boot

Enables/disables ability to boot the system from removable media.
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)

Heading Option

Description

Legacy Diskette Write

Enables/disables ability to write data to removable media.

BIOS DMA Transfers
Enable/disables the BIOS use of DMA for transfers.

SATA Emulation
Sets the SATA emulation mode with the following options:

e RAID + AHCI-AHCI functionality does not require an OPROM to execute. RAID OPROM
executes. This emulation mode offers the best performance and most functionality.

e  Separate IDE Controller—Offers standard SATA supports (four ports only).

e Combined IDE Controller—Makes the SATA controller look like an IDE controller and offers
best IDE compatibility (two ports only).

e  AHCI-Offers full SATA and SATA-II functionality with no support for RAID.
NOTE: DrivelLock is not available in RAID+AHCI mode.

IDE Controller

Enables/disables primary IDE controller.

Primary SATA Controller
Enables/disables SATA controller #0.

Secondary SATA Controller
Enables/disables SATA controller #1.

DPS Self-test

Enables you to select a drive test for a SATA drive. It is not displayed by default and not available
for RAID and AHCI configurations.

Boot Order

Enables you to configure the boot, diskette drive, and hard drive orders by physically reordering
the menu entries. The default boot order presents these selections:

e  Optical Drive

e  Diskette Drive

e USB Device

e  Hard Drive

e  Broadcom Ethernet controller

Press Enter to drag a device to a preferred place. Press F5 to remove the device from consideration
as a bootable device.

NOTE: MS-DOS drive lettering assignments might not apply after a non-MS-DOS operating
system has started.

Boot devices can be disabled from participating in the boot order process. These order changes
are reconciled with the IPL/BCV historical information and stored in the physical ROM part when
the F10 Setup changes are confirmed with File/Save Changes and Exit.

Shortcut to Temporarily Override Boot Order: To boot one time from a device other than the default
device specified in Boot Order, restart the workstation and press F9 when the F9=Boot Menu
message appears on the screen. After POST completes, a list of bootable devices is displayed.
Use the arrow keys to select the preferred bootable device and press Enter. The workstation then
boots from the selected non-default device for this one time.
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)

Heading Option Description

Controller Order  Allows you to specify the order of the attached hard drive controller. The first hard drive controller
in the order will have priority in the boot sequence and will be recognized as drive C (if any devices
are attached).

Security Setup Password Allows you to set and enable setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Allows you to set and enable power-on password.

Password

DriveLock Allows you to set and enable the DriveLock password if your workstation hard drive supports this
Security function.

NOTE: Enabling DriveLock can render a hard drive permanently inaccessible if the master
password is lost or forgotten. No method exists to recover the password or access the data.

Smart Cover Allows you to disable cover removal sensor or to notify user if sensor has been activated.

Device Security Makes the following devices available or unavailable to the system:
e  Serial Port
e Parallel Port
e AllUSB Ports
e Front USB Ports
e  System Audio
e  Network Controller
e Embedded Security Device

For each device, Device available is the default setting and allows the operating system access
to the device. Device Hidden makes the device unavailable; it is disabled by the BIOS and cannot
be enabled by the operating system.

When enabled, Embedded Security Device offers these options:
e Enable/Disable—Turns the TPM on/off.

e  Power-On Authentication Support—Enables/disables an authentication feature that requires
you to enter a TPM user key password to boot the system. This feature uses the TPM to
generate and store the authentication password.

e Reset Authentication Credential—Resets the authentication functionality and clears all
authentication credentials.

NOTE: A setup password must be set to enable the Embedded Security Device and to access
any security features associated with the Embedded Security Device.

Network Service Enables/disables the ability to boot to the network by way of the F12 key or the boot order.
Boot

System IDs Asset Tag
A 16-byte string identifying the system.

Ownership Tag

An 80-byte string identifying ownership of the system. This tag is displayed on the screen during
POST.

30 Chapter 3 System management ENWW



ENWW

Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)

Heading Option Description
Universal Unique Identifier (UUID)
Can only be updated if the current chassis serial number is invalid. (These ID numbers are normally
set in the factory and are used to uniquely identify the system.)
Keyboard
Enables you to set the keyboard locale for System ID entry.
OS Security Data Execution Prevention
Enables/disables Data Execution Prevention mode in the processors. This mode prohibits code
from running in pages that were set up as data pages, and prevents attacks such as buffer
overflows. Operating system support is required for this feature.
Intel Virtualization Technology
Enables Intel Virtualization Technology to increase workstation performance.
OS Management of Embedded Security Device
Enables/disables the ability of the operating system to control the TPM device. This includes turning
it on/off, initializing it, and resetting it.
Reset of Embedded Security Device through OS.
Enables/disables the ability of the operating system to reset the TPM.
Power OS Power Enables/disables:
Management
e ACPI S3 Support
e ACPI S3 Hard Disk Reset
e ACPI S3 PS2 Mouse Wakeup
e  USB Wake on Device Insertion
e Idle Power Savings
Hardware Power Enables/disables SATA Power Management
Management
Thermal Allows you set the rate of the system fan when CPU is in idle.
Advanced* Power-On Allows you to set:
* Options

e POST Mode (QuickBoot, FullBoot, or FullBoot every 1-30 days).
e POST Messages (Enable/Disable).

e F9 Prompt (Enable/Disable). Enabling this feature will display the text F9=Boot Menu during
POST. Disabling this feature prevents the text from being displayed. However, pressing
the F9 key will still access the boot menu.

e F10Prompt (Enable/Disable). Enabling this feature displays the text F10=Setup during POST.
Disabling this feature prevents the text from being displayed but pressing F10 still accesses
the Setup screen.

e F11 Prompt (Enable/Disable). Makes the Factory Recovery option visible during POST.

e F12 Prompt (Enable/Disable). Enabling this feature displays the text F12=Network Service
Boot during POST. Disabling this feature prevents the text from being displayed
but pressing F12 still forces the system to attempt booting from the network.

e  Factory Recovery Boot Support (Enable/Disable). Recovery partition (HDD) option available
for Vista. Vista leaves the factory with this support in place.

e  Option ROM prompt* (Enable/Disable). Enabling this feature causes the system to display a
message before loading options ROMs.
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)

Heading Option

Description

e Remote Wakeup Boot Source
o  After Power Loss (on/off)

e POST Delay (in seconds) (Enable/Disable). Enabling this feature adds a user-specified delay
to the POST process. This delay is sometimes needed for hard disks on some PCI cards that
spin up slowly—so slowly that they are not ready to boot by the time POST is finished. The
POST delay also gives you more time to select F10 to enter Computer Setup (F10).

e 1/O APIC Mode (Enable/Disable)

e  Limit (PUID Maximum Value to 3) (Enable/Disable)

e  Setup Browse Mode (Enable/Disable)

e ACPI/USB Buffers @ Top of Memory (Enable/Disable)

Execute
Memory Test

The system will reboot and any changes that have been made will be lost. The system might boot
with memory in a sub-optimal configuration.

BIOS Power-On

Enables you to disable or specify a weekday and time for BIOS power-on.

Onboard
Devices

Enables you to set resources for or disable onboard system devices (serial ports, USB ports,
diskette controllers, and so on).

PCI Devices

Enables you to set resources for the following devices:
Intel HD Audio Device (IRQ 5, 10, 11, or Disable)

Intel USB Controller (IRQ 5, 10, 11, or Disable)

Intel USB Controller (IRQ 5, 10, 11, or Disable)

Intel USB Controller (IRQ 5, 10, 11, or Disable)

Intel USB Controller (IRQ 5, 10, 11, or Disable)

Intel USB Controller (IRQ 5, 10, 11, or Disable)

Intel IDE Controller (Enable/Disable)

Intel SATA Controller (IRQ 5, 10, 11, or Disable)

VGA Controller (IRQ 5, 10, 11, or Disable)

Broadcom Ethernet Controller (IRQ 5, 10, 11, or Disable)

Bus Options

The options are:

PCI SERR# Generation (Enable/Disable)
PCI VGA Palette Snooping (Enable/Disable)
ECC Support (Enable/Disable)

Memory Remapping (Enable/Disable)

Device Options

Printer Mode (EPP + ECP, Output-Only, Bi-Directional)
Num Lock State at Power-On (off/on)

S5 Wake-on-LAN (Enable/Disable)

Processor Cache (Enable/Disable)

Unique Sleep State Blink Rates (Enable/Disable)
Internal Speaker (Enable/Disable)

Monitor Tracking (Enable/Disable)

NIC PxE Option ROM Download (Enable/Disable)

32 Chapter 3 System management ENWW



Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)

Heading Option Description

SATA RAID Option ROM Download (Enable/Disable)

Slot 1 (PCI Configures the option ROM.

Express x 16)

Slot 2 (PCI) Configures the option ROM and latency timer.
Slot 3 (PCI Configures the option ROM.

Express x

8’ (x4))

Slot 4 (PCI Configures the option ROM.

Express x1)

Slot 5 PCI Configures the option ROM and latency timer.
Slot 6 PCI Configures the option ROM and latency timer.

* Available on selected models.

**These options should be used by advanced users only.

Desktop management

HP Client Management Solutions (available for download from http://www.hp.com/go/easydeploy)

provides standards-based solutions for managing and controlling workstations in a networked
environment. This section summarizes the capabilities and features of the key components of desktop
management:

Initial configuration and deployment
Remote system installation
Updating and managing software
ROM flash

Asset tracking and security

Fault notification and recovery

Bf NOTE: Support for specific features described in this guide might vary by model or software version.

Initial configuration and deployment

ENWW

The workstation comes with a preinstalled system software image. After a brief software “unbundling”
process, the workstation is ready to use.

You might prefer to replace the preinstalled software image with a customized set of system and
application software. Several methods are available for deploying a customized software image,
including:

Installing additional software applications after unbundling the preinstalled software image

Using a disk cloning process to copy the contents from one hard drive to another

The best deployment method depends on your information technology environment and processes. The

PC Deployment section of the HP Lifecycle Solutions website (http://whp-sp-orig.extweb.hp.com/
country/us/en/solutions.html) provides information to help you select the best deployment method.

Desktop management
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The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery
of system software, configuration management and troubleshooting, and power management.

Remote system installation

Remote system installation enables you to start and set up your system using the software and
configuration information located on a network server. This feature is usually used as a system setup
and configuration tool and can be used for the following tasks:

e Deploying a software image on one or more new PCs

e Formatting a hard drive

e Installing application software or drivers

e Updating the operating system, application software, or drivers

To initiate a remote system installation, press F12 when the F12=Network Service Boot message
appears in the lower-right corner of the HP logo screen. Follow the on-screen instructions to continue
the process. The default boot order is a BIOS configuration setting that can be changed to always
attempt to PXE boot.

HP and Altiris have partnered to provide tools designed to make the task of corporate PC deployment
and management easier and less time-consuming, ultimately lowering the total cost of ownership and
making HP PCs the most manageabile client PCs in the enterprise environment.

Updating and managing software

HP provides several tools for managing and updating software on desktops and workstations—HP Client
Manager Software, Altiris Client Management Solutions, System Software Manager, Proactive Change
Notification, and Subscriber’s Choice.

HP Client Manager Software

HP Client Manager Software (HP CMS) assists HP customers in managing the hardware aspects of
their client workstations with features that include:

e Detailed views of hardware inventory for asset management
e PC health check monitoring and diagnostics
e Proactive notification of changes in the hardware environment

e Web-accessible reporting of business-critical details such as machines with thermal warnings,
memory alerts, and more

e Remote updating of system software such as device drivers and ROM BIOS
e Remote changing of boot order
e  Configuring the system BIOS settings

For more information on the HP Client Manager, see http://h18000.www1.hp.com/im/prodinfo.html.

34 Chapter 3 System management ENWW


http://h18000.www1.hp.com/im/prodinfo.html#deploy

Altiris Client Management Solutions

System
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HP and Altiris have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the foundation for
additional Altiris Client Management Solutions that address:

e Inventory and asset management
o Software license compliance
0 PC tracking and reporting
° Lease contract and fixing asset tracking
e Deployment and migration
0 Microsoft Windows XP Professional or Home Edition migration
0 System deployment
° Personality migrations
e Help desk and problem resolution
0 Managing help desk tickets
o Remote troubleshooting
° Remote problem resolution
° Client disaster recovery
e Software and operations management
0 Ongoing desktop management
o HP system software deployment
0 Application self-healing

See http://h18000.www1.hp.com/im/prodinfo.html for more information about:

e How HP Client Manager Software works
e  Which solutions are compatible with your operating system

e How to download a fully-functional, 30-day evaluation version of the Altiris solutions

Software Manager

System Software Manager (SSM) is a utility that enables you to update system-level software on multiple
systems simultaneously. When executed on a PC client system, SSM detects both hardware and
software versions, and then updates the appropriate software from a central repository, also known as
a file store. Driver versions that are supported by SSM are denoted with a special icon on the software,
the driver download website, and on the Support Software CD. To download the utility or to obtain more
information on SSM, see http://www.hp.com/go/ssm.
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Proactive Change Notification

The Proactive Change Notification program uses the Subscriber's Choice website to proactively and
automatically:

e Send you Proactive Change Notification (PCN) emails informing you of hardware and software
changes to most commercial workstations and servers, up to 60 days in advance

e Send you emails containing customer bulletins, customer advisories, customer notes, bulletins,
and driver alerts for most commercial workstations and servers

You can create your own profile to ensure that you only receive the information relevant to a specific IT
environment. To learn more about the Proactive Change Notification program and create a custom
profile, see http://www.hp.com/go/pcn.

Subscriber’s Choice

Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply you with
personalized product tips, feature articles, and driver and support alerts and notifications. Subscriber’'s
Choice Driver and Support Alerts/Notifications will deliver emails notifying you that the information you
subscribed to in your profile is available for review and retrieval. To learn more about Subscriber’s
Choice and create a custom profile, see http://www.hp.com/go/pcn.

ROM flash

The workstation comes with a programmable flash ROM. By establishing a setup password in the
Computer Setup (F10) Utility, you can protect the ROM from being unintentionally updated or
overwritten. This is important to ensure the operating integrity of the workstation. Should you need or
want to upgrade the ROM, you can:

e  Order an upgraded SoftPaq from HP support.

e Download the latest SoftPaq images from HP driver and support page, http://www.hp.com/support/
files.

Bf NOTE: For maximum ROM protection, be sure to establish a setup password. The setup password
prevents unauthorized ROM upgrades. System Software Manager enables you to set the setup
password on one or more PCs simultaneously. For more information, visit http://www.hp.com/go/ssm

Remote ROM Flash

Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP
workstations directly from the centralized network management console, resulting in a consistent
deployment of and greater control over HP PC ROM images over the network. It also results in greater
productivity and lower total cost of ownership.

The workstation must be powered on, or turned on through Remote Wakeup, to use Remote ROM Flash.

For more information on Remote ROM Flash, see the HP Client Manager Software or System Software
Manager sections at http://h18000.www1.hp.com/im/prodinfo.html.

HPQFlash

The HPQFlash utility is used to locally update or restore the system ROM on individual PCs through a
Windows operating system.

For more information on HPQFlash, see http://www.hp.com/support/files and enter the name of the
workstation when prompted.
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FailSafe Boot Block ROM

ENWW

The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash failure,
for example, if a power failure were to occur during a ROM upgrade. The Boot Block is a flash-protected
section of the ROM that checks for a valid system ROM flash when power to the system is connected.

e Ifthe system ROM is valid, the system starts normally.

e Ifthe system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support
to start the system from a SoftPaq, which programs the system ROM with a valid image.

NOTE: Some models also support recovery from a SoftPaq. ISO SoftPaq images are included with
selected models in the downloadable SoftPags.

When the boot block detects an invalid system ROM, the System Power LED blinks red eight times,
one every second, followed by a two-second pause. Also, eight simultaneous beeps will be heard. A
Boot Block recovery mode message is displayed on the screen (some models).

To recover the system after it enters Boot Block recovery mode:

1. Ifthere is a diskette in the diskette drive or a CD in the CD drive, remove the diskette and CD and
power off the system.

2. Insert a SoftPaq diskette into the diskette drive or, if permitted on this workstation, insert a SoftPaq
CD into the CD drive. USB media such as an HP DriveKey can also be used.

3. Power on the workstation.

If no SoftPaq diskette or SoftPaq CD is found, you will be prompted to insert one and restart the
workstation.

If a setup password has been established, the Caps Lock light will illuminate and you will be
prompted to enter the password.

4. Enter the setup password.

If the system successfully starts from the diskette and successfully reprograms the ROM, then the
three keyboard lights will illuminate. A rising tone series of beeps also signals successful
completion.

5. Remove the diskette or CD and power off the system.
6. Restart the workstation.

The following table lists the various keyboard light combinations used by the Boot Block ROM (when a
PS2 keyboard is attached to the workstation) and explains the meaning and action associated with each
combination.

Table 3-2 Keyboard light combinations used by boot black ROM

FailSafe Boot Keyboard LED activity* State/Message

Block mode

Num Lock On SoftPaq diskette or SoftPag CD not present, is bad, or drive not ready.
Caps Lock On Enter password.

Num, Caps, Flash on in sequence, Keyboard locked in network mode.

Scroll Lock one at a time—N,C, SL

Num, Caps, On Boot Block ROM Flash successful. Reboot the system.

Scroll Lock

*Diagnostic lights do not flash on USB keyboards.
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Replicating the setup

The following procedures enable you to easily copy one setup configuration to other workstations of the
same model for faster, more consistent configuration of multiple workstations.

Bf NOTE: Both procedures require a diskette drive or a USB device such as an HP Drive Key.

To collect and replicate BIOS settings on multiple computers, use System Software Manager or HP
Client Manager Software. For more information, see http://www.hp.com/go/easydeploy.

Copying to a single workstation

/A CAUTION: A setup configuration is model-specific. File system corruption can result if source and
target workstations are not the same model. For example, do not copy the setup configuration from an
HP xw4200 Workstation to an HP xw4400 Workstation.

1.
2.

9.

Select a setup configuration to copy, and reboot the workstation.

As soon as the workstation powers on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, you may see a Keyboard Error message—disregard it.

If you are using a diskette or other storage device, insert it now. If not, proceed.

Click File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette.

Power off the workstation to be configured and insert the configuration diskette.
Power on the workstation to be configured.

Press and hold the F10 key until you enter the Computer Setup (F10) Utility. Press Enter to bypass
the title screen, if necessary.

Click File>Replicated Setup>Restore from Removable Media, and follow the instructions on the
screen.

Restart the workstation when the configuration is complete.

Copying to multiple workstations

/A CAUTION: A setup configuration is model-specific. File system corruption can result if source and
target workstations are not the same model. For example, do not copy the setup configuration from an
HP xw4200 Workstation to an HP xw4400 Workstation.

This method takes a little longer to prepare the configuration diskette, but copying the configuration to
target workstations is significantly faster.

Bf NOTE: A bootable diskette is required for this procedure. If Windows XP is not available to use to
create a bootable diskette, use the method for copying to a single workstation instead (see Copying to
a single workstation on page 38

1.
2,
3.

Create a bootable diskette.
Select a setup configuration to copy.

Restart the workstation.
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4. As soon as the workstation powers on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

B NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, you might see a Keyboard Error message—disregard it.

5. If you are using a diskette or other storage device, insert it now.

6. Click File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette.

7. Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration diskette.
To obtain this utility, go to http://www.hp.com/support/files and enter the model number of the
workstation.

8. On the configuration diskette, create an autoexec.bat file containing the following command:
repset.exe cpgsetup.txt.

9. Power off the workstation to be configured. Insert the configuration diskette, and power on the
workstation. The configuration utility runs automatically.

10. Restart the workstation when the configuration is complete.

Dual-State Power Button

With ACPI enabled, the power button can function either as an on/off switch or as a button. The feature
does not completely turn off power, but instead causes the workstation to enter a low-power standby
state. This allows you to power down without closing applications and to return to the same operational
state without any data loss.

To change the power button configuration:
1. Click Start, and select Control Panel>Power Options.
2. In Power Options Properties, click the Advanced tab.

3. Inthe Power Button section, select Hibernate. (Hibernate must be enabled in the Hibernate
tab.)

After configuring the power button to function as a button, press the power button to put the system in
a very low power state. Press the button again to bring the system out of the very low power state to full
power status. To completely turn off all power to the system, press and hold the power button for four
seconds.

CAUTION: Do not use the power button to power off the workstation unless the system is not
responding; turning off the power without operating system interaction could cause damage to or loss
of data on the hard drive.

World wide website
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HP engineers rigorously test and debug software developed by HP and third-party suppliers and develop
operating system specific support software to ensure performance, compatibility, and reliability for HP
workstations.

When making the transition to new or revised operating systems, you must implement the support
software designed for that operating system. If you plan to run a version of Microsoft Windows that is
different from the version included with the workstation, you must install corresponding device drivers
and utilities to ensure that all features are supported and functioning properly.
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HP has made the task of locating, accessing, evaluating, and installing the latest support software easier.
You can download the software from http://www.hp.com/support. This website contains the latest device
drivers, utilities, and flashable ROM images needed to run the latest Microsoft Windows operating
system on the HP workstation.

Building blocks and partners

HP management solutions integrate with other systems management applications and are based on
industry standards, such as:

e Web-Based Enterprise Management (WBEM)
e Windows Management Interface (WMI)

e Wake-on-LAN technology

e ACPI

e SMBIOS

e PXE support

e  Alert Standard Format

Asset tracking and security

Asset tracking features incorporated into the workstation provide key asset tracking data that can be
managed using HP Systems Insight Manager, HP Client Manager Software, or other system
management applications. Seamless, automatic integration between asset tracking features and these
products enables you to choose the management tool that is best suited to the environment and to
leverage the investment in existing tools.

HP also offers several solutions for controlling access to valuable components and information.
ProtectTools Embedded Security, if installed, prevents unauthorized access to data and checks system
integrity and authenticates third-party users attempting system access. Security features such as
ProtectTools and the Hood Sensor (Smart Cover Sensor) help prevent unauthorized access to your
data and to the internal components of the workstation. By disabling parallel, serial, or USB ports or by
disabling removable media boot capability, you can protect valuable data assets. Memory Change and
Hood Sensor (Smart Cover Sensor) alerts can be automatically forwarded to system management
applications to deliver proactive notification of tampering with a workstation’s internal components.

NOTE: ProtectTools, the Hood Sensor (Smart Cover Sensor), and the Hood Lock (Smart Cover Lock)
are available as options on select systems.

Use the following utilities to manage security settings on the HP workstation:
e Locally, using the Computer Setup (F10) Utility.

e Remotely, using HP Client Manager Software or System Software Manager. This software enables
the secure, consistent deployment and control of security settings from a simple command line
utility.

The following table and sections refer to managing security features of the workstation locally through
the Computer Setup (F10) Utility.

Table 3-3 Security Features Overview

Feature Purpose How it is established

Removable Media Boot Control Prevents booting from the removable media  From the Computer Setup (F10)
drives. Utility Menu.
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Table 3-3 Security Features Overview (continued)

Feature Purpose How it is established
Serial, Parallel, USB, or Infrared Prevents transfer of data through the From the Computer Setup (F10)
Interface Control integrated serial, parallel, USB, or infrared Utility menu.
interface.
Power-On Password Prevents use of the workstation until the From the Computer Setup (F10)

password is entered. This can apply to both  Utility menu.
initial system startup and restarts.

Setup Password Prevents reconfiguration of the workstation From the Computer Setup (F10)
(use of the Setup Utilities) until the password  Utility menu.
is entered.

Network Server Mode Provides unique security features for From the Computer Setup (F10)
workstations being used as servers. Utility menu.

NOTE: For more information about the Computer Setup (F10) Utility, see Computer Setup (F10) Utility menu on page 27.

Password security

ey

The power-on password prevents unauthorized use of the workstation by requiring entry of a password
to access applications or data each time the workstation is powered on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as
an override to the power-on password. That is, when prompted for the power-on password, entering the
setup password instead will allow access to the workstation.

You can establish a network-wide setup password to enable the system administrator to log in to all
network systems to perform maintenance without having to know the power-on password.

NOTE: System Software Manager and HP Client Manager Software allow remote management of
Setup Passwords and other BIOS settings in a networked environment. For more information, see http://
www.hp.com/go/easydeploy.

Establishing a setup password using the Computer Setup (F10) Utility

Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the
workstation (via use of the Computer Setup (F10) Utility) until the password is entered.

To establish a setup password using workstation setup:
1.  Power on or restart the workstation.

2. As soon as the computer is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, you might see a Keyboard Error message—disregard it.

3. Select Security>Setup Password and follow the on-screen instructions.

4. Before exiting, select File>Save Changes and Exit.

Establishing a power-on password using workstation setup
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Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the
workstation when power is connected, unless the password is entered. When a power-on password is
set, the Computer Setup (F10) Utility presents Password Options under the Security menu. The
password options include Network Server Mode and Password Prompt on Warm Boot.
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When Network Server Mode is disabled, the password must be entered each time the workstation is
powered on when the key icon appears on the monitor. When Password Prompt on Warm Boot

is enabled, the password must also be entered each time the workstation is rebooted. When Network
Server Mode is enabled, the password prompt is not presented during POST, but any attached PS2
keyboard remains locked until you enter the power-on password.

To enable Network Server Mode, a power-on password must be set. The option is available under
Advanced>Password Options. This option enables the system to boot without asking for the power-
on password, but the keyboard and mouse are locked until you enter it. The keyboard LEDs rotate
constantly when the system is in locked mode.

To establish a power-on password through workstation setup:
1. Power on or restart the workstation.

2. Assoon as the computer is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

B NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, you might see a Keyboard Error message—disregard it.

3. Select Security>Power-On Password and follow the on-screen instructions.

4. Before exiting, select File>Save Changes and Exit.

Entering a power-on password
1. Restart the workstation.

2.  When the key icon appears on the monitor, enter the current password, and press Enter.

Bf NOTE: Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.

Entering a Setup Password

If a setup password has been established on the workstation, you will be prompted to enter it each time
you run the Computer Setup (F10) Utility.

To enter a setup password:
1. Restart the workstation.

2. Assoon as the workstation is powered on, press and hold the F 10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, you might see a Keyboard Error message—disregard it.

3. When the key icon appears on the monitor, enter the setup password, and press Enter.

Bf NOTE: Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.
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Changing a power-on or setup password
1. Restart the workstation.

2. To change the Setup password, as soon as the workstation is turned on, press and hold the F10
key until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if
necessary.

= NOTE: Ifyoudo notpress F10 at the appropriate time, you must restart the workstation and press
and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, you might see a Keyboard Error message—disregard it.

3. When the key icon appears, enter the current password, a slash (/) or alternate delimiter character,
your new password, another slash (/) or alternate delimiter character, and your new password again
as shown: current password/new password/new password

B NOTE: Type carefully. For security reasons, the characters you enter do not appear on the
screen.

4. Press Enter.

The new password takes effect the next time you turn on the workstation.

Bf NOTE: See a National keyboard delimiter characters on page 43 for information about the alternate
delimiter characters. The power-on password and setup password can also be changed using the
Security options in the Computer Setup (F10) Utility.

Deleting a power-on or setup password
1. Power on or restart the workstation.

2. To delete the power-on password, go to step 3. To delete the Setup Password, as soon as the
workstation is powered on, press and hold the F10 key until you enter the Computer Setup (F10)
Utility. Press Enter to bypass the title screen, if necessary.

To delete the Setup Password, as soon as the workstation is powered on, press and hold the
F10 key until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if
necessary.

= NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer
and press and hold the F10 key again to access the utility.

Use the appropriate operating system shutdown process. To delete the setup password, run the
Computer Setup (F10) Utility.

3.  When the key icon appears, enter your current password followed by a slash (/) or alternate
delimiter character as shown: current password/

4. Press Enter.

B NOTE: See the National keyboard delimiter characters on page 43 section for information about the
alternate delimiter characters. The power-on password and setup password can also be changed using
the Security options in the Computer Setup (F10) Utility.

National keyboard delimiter characters

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use
for changing or deleting your password depend on the keyboard that came with your workstation.
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Table 3-4 National keyboard delimiter characters

Language Delimiter Language Delimiter Language Delimiter
Arabic / Greek - Russian /
Belgian = Hebrew . Slovakian -
BHCSY* - Hungarian - Spanish -
Brazilian / Italian - Swedish/Finnish /
Chinese / Japanese / Swiss -
Czech - Korean / Taiwanese /
Danish - Latin American - Thai /
French ! Norwegian - Turkish
French é Polish - U.K. English /
Canadian
German - Portuguese - U.S. English /

NOTE: * For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia.

Clearing passwords

If you forget your password, you cannot access the workstation. See the section on resetting the
password jumper for instructions on clearing passwords.

DriveLock

/A WARNING! Enabling DriveLock can render a hard drive permanently inaccessible if the master
password is lost or forgotten. No method exists to recover the password or access the data.

DriveLock is an industry-standard security feature that prevents unauthorized access to the data on an
ATA hard drive. DriveLock has been implemented as an extension to Computer Setup. Itis only available
when hard drives that support the ATA Security command set are detected.

DriveLock is intended for HP customers for whom data security is the paramount concern. For such
customers, the cost of the hard drive and the loss of the data stored on it is inconsequential when
compared with the damage that could result from unauthorized access to its contents.

In order to balance this level of security with the practical need to accommodate a forgotten password,
the HP implementation of DriveLock employs a two-password security scheme. One password is
intended to be set and used by a system administrator while the other is typically set and used by the
end-user. There is no "back-door" that can be used to unlock the drive if both passwords are lost.
Therefore, DriveLock is most safely used when the data contained on the hard drive is replicated on a
corporate information system or is regularly backed up. In the event that both DriveLock passwords are
lost, the hard drive is rendered unusable. For users who do not fit the previously defined customer profile,
this may be an unacceptable risk. For users who do fit the customer profile, it may be a tolerable risk
given the nature of the data stored on the hard drive.

DriveLock applications

The most practical use of the DriveLock security feature is in a corporate environment. The system
administrator would be responsible for configuring the hard drive which would involve, among other
things, setting the DriveLock master password and a temporary user password. In the event that the
user forgets the user password or the equipment is passed on to another employee, the master
password can always be used to reset the user password and regain access to the hard drive.
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HP recommends that corporate system administrators who choose to enable DriveLock also establish
a corporate policy for setting and maintaining master passwords. This should be done to prevent a
situation where an employee intentionally or unintentionally sets both DriveLock passwords before
leaving the company. In such a scenario, the hard drive would be rendered unusable and require
replacement. Likewise, by not setting a master password, system administrators may find themselves
locked out of a hard drive and unable to perform routine checks for unauthorized software, other asset
control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users
in this category include personal users or users who do not maintain sensitive data on their hard drives
as a common practice. For these users, the potential loss of a hard drive resulting from forgetting both
passwords is much greater than the value of the data DriveLock has been designed to protect.

Access to Computer Setup and DriveLock can be restricted through the Setup password. By specifying
a Setup password and not giving it to end users, system administrators are able to restrict users from
enabling DriveLock.

Using DrivelLock
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When one or more hard drives that support the ATA Security command set are detected, the DriveLock
option appears under the Security menu in Computer Setup. You are presented with options to set the
master password and to enable DriveLock. A user password must be provided in order to enable
DriveLock. Since the initial configuration of DriveLock is typically performed by a system administrator,
a master password should be set first. HP encourages system administrators to set a master password
whether they plan to enable DriveLock or keep it disabled. This will give the administrator the ability to
modify DriveLock settings if the drive is locked in the future. Once the master password is set, the system
administrator may enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a power-on
password is set and it matches the device’s user password, POST will not prompt the user to re-enter
the password. Otherwise, the user will be prompted to enter a DriveLock password. On a cold boot,
either the master or the user password may be used. On a warm boot, enter the same password used
to unlock the drive during the preceding cold-boot. Users will have two attempts to enter a correct
password. On a cold boot, if neither attempt succeeds, POST will continue but the drive will remain
inaccessible. On a warm boot or restart from Windows, if neither attempt succeeds, POST will halt and
the user will be instructed to cycle power.

To enable and set the DriveLock user password:
1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the ultility. If you are using a PS2 keyboard, you
might see a Keyboard Error message—disregard it.

3. Select Security > DriveLock Security.
4. For each DriveLock-capable drive, select a drive by pressing the F10 key to accept.

5. Under Enable/Disable Drive Lock options, select Enable and press the F10 key to enable the
DriveLock for a particular drive.

/A WARNING! Forgetting the DriveLock password will render the drive unusable.

6. Enter a new user password and press the F10 key to accept. This password may be 1 to 32
characters long.
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7. Enter the password again in the Enter New Password Again field. If you forget this password, the
drive will be rendered permanently disabled.

8. Select File > Save Changes and Exit and press the F10 key. After you press the F10 key, the
system does a “cold boot” before invoking the DriveLock function.

Ef NOTE: This process can also be used to set the DriveLock Master password by selecting Master in
Step 5.

When the unit “cold boots,” you will be prompted to enter the DriveLock password for each DriveLock-
capable drive for which you have previously set a password. You have two chances to entire the
password correctly. If the correct password is not entered correctly, the unit will attempt to boot anyway,
but the boot process will most likely fail as data from an unlocked drive cannot be accessed.

In a single drive system, if the drive is drive-locked, then the system will most likely not boot to the
operating system. The system may try to boot from the network instead, depending on the boot ordering
options. Regardless, the drive-locked drive remains inaccessible without the DriveLock password.

In a two drive system where there is a boot drive and a data drive, one can apply the DrivelLock feature
only to the data drive. In this case, the unit can always boot, but the data drive is accessible only when
the DriveLock password is known.

Any cold boot requires you to enter DriveLock passwords. But DriveLock passwords are required for
warm boots as well. For example, if you booted to DOS and entered Ctrl-Alt-Del, you would need to
enter the DriveLock password before the unit will complete the next boot cycle. This warm boot behavior
is consistent with the DriveLock feature found on IDE hard drives.

Hood sensor (smart cover sensor)

The optional hood sensor is a combination of hardware and software technology that can alert you when
the workstation side access panel has been removed if the sensor has been properly configured in the
Computer Setup Utility. There are three levels of protection, as described in the following table.

Table 3-5 Hood Sensor Protection Levels

Level Setting Description
Level 0 Disabled Hood sensor is disabled (default).
Level 1 Notify User When the workstation restarts, the screen displays a

message indicating that the workstation side access
panel has been removed.

Level 2 Setup Password When the workstation is restarted, the screen displays
a message indicating that the workstation side access
panel has been removed. You must enter the setup
password to continue.

These settings can be changed using the Computer Setup (F10) Utility.

Setting the hood sensor protection level
1. Power on or restart the workstation.

2. Assoon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

B NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, you might see a Keyboard Error message—disregard it.
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3. Select Security>Smart Cover>Cover Removal Sensor, and follow the on-screen instructions.

4. Before exiting, click File>Save Changes and Exit.

Hood lock (smart cover lock)

When installed, the hood lock can prevent unauthorized access to the internal components.

/A CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup
password prevents unauthorized access to the Computer Setup utility.

Locking the solenoid lock
1. Power on or restart the workstation.

2. As soon as the workstation is powered on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the ultility. If you are using a PS2 keyboard, you
might see a Keyboard Error message—disregard it.

3. Select Security>Smart Cover>Cover Lock>Lock.

4. Select Fire>Save Changes and Exit.

Unlocking the solenoid lock
1. Turn on or restart the workstation.

2. As soon as the workstation is powered on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the ultility. If you are using a PS2 keyboard, you
might see a Keyboard Error message—disregard it.

3. Select Security>Smart Cover>Cover Lock>Unlock.

4. Select Fire>Save Changes and Exit.

Using the FailSafe key

If you enable the hood lock and cannot enter your password to disable the lock, you will need a FailSafe
Key to open the workstation side access panel. You will need the key in any of the following
circumstances:

e Power outage
e  Startup failure
e PC component failure (such as processor or power supply)

e Forgotten password

/A CAUTION: The side access panel FailSafe Key is a specialized tool available from HP. Be prepared;
order this key before you need one.
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To obtain the FailSafe Key, complete any one of the following tasks:
e Contact your authorized HP reseller or service provider.

e Access the HP website (http://www.hp.com) for ordering information.

e Access the Contact HP Worldwide website (http://welcome.hp.com/country/us/en/
wwcontact.html) for contact information.

Clearing Passwords

If you forget your password, you cannot access the workstation. See the section on resetting the
password jumper in the appendix.

Cable lock provision (optional)

The rear panel of the chassis can accommodate a cable lock accessory that allows the workstation to
be physically secured to a work area.

Security lock (optional)

The security lock prevents entire system theft and discourages access panel removal.

Universal chassis clamp lock (optional)

The version without a cable discourages side access panel removal and prevents theft of I/O devices.
The version with a cable also prevents entire system theft and allows multiple systems to be secured
with a single cable.

Hood lock (Smart cover lock) (optional)

Prevents removal of the access panel and all internal components including optical and diskette drives.
This lock eliminates the need for a physical key by enabling password-protected locking and locking by
a local or a remote user.

Hood sensor (Smart cover sensor) (optional)

This sensor is set in the Computer Setup utility. You can set this to notify a user if the access panel has
been removed.

Access panel key lock

This lock prevents removal of the access panel and all internal components. The key is shipped on the
rear of the workstation.

Fault notification and recovery

Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.

If the workstation is connected to a network managed by HP Client Manager Software, the computer
sends a fault notice to the network management application. With HP Client Manager Software, you can
also remotely schedule diagnostics to automatically run on all managed PCs and create a summary
report of failed tests.
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Drive Protection System

The Drive Protection System (DPS) is a diagnostic tool built into the hard drives that is installed in select
HP workstations. the DPS is designed to help diagnose problems that might result in unwarranted hard
drive replacement.

When HP workstations are built, each installed hard drive is tested using the DPS, and a permanent
record of key information is written onto the drive. Each time the DPS is run, test results are written to
the hard drive. The service provider can use this information to help diagnose conditions that caused
you to run the DPS software.

ECC fault prediction and prefailure warranty

When the workstation encounters an excessive number of error checking and correcting (ECC) memory
errors, the workstation displays a Local Alert message. This message contains detailed information
about the errant memory module, enabling you to take action before you experience non-correctable
memory errors. The Prefailure Warranty for ECC memory modules enables you to replace these
modules, free of charge, before the modules actually fail. ECC memory modules are optional on selected
HP systems.

Thermal sensor
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There are multiple sensors on your workstation:
e  One per processor

e  One per memory module (DIMM)

e  One for the system board

e Some hard drives

The processor thermal sensor is a hardware and software feature that tracks the internal temperature
of the workstation. When combined with HP Client Manager Software, this features notifies the network
administrator when the normal range is exceeded.

The thermal sensor monitors the processor temperature. If the temperature gets too hot, the processor
clock automatically begins to throttle. If the temperature does not go down, then the system eventually
shuts down.
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Removal and replacement procedures

This chapter describes removal and replacement procedures of most internal components.

e Warnings and cautions on page 51

e Service considerations on page 52

e Customer Self-Repair on page 56

° Predisassembly procedures on page 57

° System board components on page 57

° Steps for removal and replacement of components on page 58

° Product recycling on page 99

Warnings and cautions

A

A
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WARNING! If a product is shipped in packaging marked with this symbol %I? the product must
always be lifted by two persons to avoid personal injury due to product weight.

WARNING! @ Any surface or area of the equipment marked with these symbols indicates the
presence of a hot surface or hot component. If this surface is contacted, the potential for injury exists.
To reduce the risk of injury from a hot component, allow the surface to cool before touching.

WARNING! A Any surface or area of the equipment marked with these symbols indicates the
presence of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open
any enclosed area.

WARNING! To reduce the risk of electric shock or damage to your equipment:
— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.
— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper
workstation, setup, posture, and health and work habits for computer users, and provides important
electrical and mechanical safety information. This guide is located on the Web at http://www.hp.com/
ergo and/or on the documentation CD if one is included with the product.

CAUTION: Static electricity can damage the electronic components of the workstation. Before
beginning these procedures, be sure you are discharged of static electricity by briefly touching a
grounded metal object.
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CAUTION: Observe the following cautions when removing or replacing a processor:

— Installing a processor incorrectly can damage the system board. Have an HP authorized reseller or
service provider install the processor. If you plan to install it yourself, read all of the instructions carefully
before you begin.

— Failure to follow the workstation preparation instructions and these result in an improperly installed
processor, causing extensive system damage.

— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor
in the socket.

/A CAUTION: To prevent damage to this system, observe the following Electro Static Discharge (ESD)
precautions while performing the system parts removal/replacement procedures:

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body
to the ground.

— Create a common ground for the equipment you are working on by connecting the static-free mat,
static strap and peripheral units to that piece of equipment.

L)

NOTE: HP accessories are for use in HP workstation products. They have been extensively tested for
reliability and are manufactured to high quality standards. HP, therefore, warrants only those
accessories that are manufactured or sold by HP.

Service considerations

The following sections discuss service considerations that should be reviewed and practiced before
removing and replacing any system components.

/A WARNING! When lifting or moving the workstation, do not use the front bezel as a handle or lifting
point. Lifting the workstation from the front bezel or lifting it incorrectly can cause the unit to fall and harm
you and damage the workstation. To properly and safely lift the workstation, lift it from the bottom of the
unit.

Cautions, warnings, and safety precautions

For your safety, review the cautions, warnings, and safety precautions before accessing the workstation
components. Also, review the Safety and Regulatory Guide that came with your workstation for more
information.

Electrostatic discharge information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) might not appear to be affected at all and can function
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating static

The following table shows that different activities generate different amounts of static electricity. Static
electricity increases as humidity decreases.
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Table 4-1 Static electricity

Relative humidity

Event 55% 40% 10%
Walking across carpet 7,500 V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000V 12,000 V
Motions of bench worker 400V 800V 6,000 V
Removing bubble pack from PCB 7,000 V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.

Transport products in static-safe containers, such as tubes, bags, or boxes, to avoid hand contact.
Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.
Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

Place items on a grounded surface before removing them from their containers.

When handling or touching a sensitive component or assembly, ground yourself by touching the
chassis.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal grounding methods and equipment

ENWW

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one megohm + 10% resistance in the ground
cords. To provide a proper ground, wear the strap against bare skin. The ground cord must be
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

Heel straps, toe straps, and boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a maximum of one-megohm + 10% resistance between the operator and ground.

Table 4-2 Static shielding protection levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000
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Grounding the work area
To prevent static damage at the work area:

e  Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

e Use static-dissipative mats, foot straps, or air ionizers to give added protection.

e Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

e Disconnect power and input signals before inserting and removing connectors or test equipment
e Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

e Keep work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

° Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:
e Antistatic tape
e Antistatic smocks, aprons, or sleeve protectors
e Conductive bins and other assembly or soldering aids
e Conductive foam
e Conductive tabletop workstations with ground cord of one-megohm + 10% resistance
e  Static-dissipative table or floor mats with hard tie to ground
e Field service kits
e  Static awareness labels
e  Wrist straps and footwear straps providing one-megohm * 10% resistance
e Material handling packages
e Conductive plastic bags
e  Conductive plastic tubes
e Conductive tote boxes
e Opaque shielding bags
e Transparent metallized shielding bags

e Transparent shielding tubes

Tools and software requirements

e Torx T-15 screwdriver or flathead screwdriver

e Diagnostics software
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Screws

The screws used in the workstation are not interchangeable. They might have standard or metric threads
and might be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the removed part, and then returned to their proper locations.

B NOTE: Metric screws have a black finish. American National (unified) screws have a silver finish.

NOTE: As each subassembly is removed from the workstation, place the subassembly away from the
work area to prevent damage.

If necessary, additional drive guide screws are provided on the system chassis. There are eight Metric
screws (1) located on the chassis near the 5.25-inch optical drive bays. These screws can be used to
mount additional optical drives or an optional diskette drive. There are four American National screws
(2) located on the chassis near the hard drive. These screws can be used to mount additional hard
drives in the 3.5” hard drive cage.

Bf NOTE: The Metric (black) and American National (silver) screws are not interchangeable.

Figure 4-1 Metric and American National screw identification

n

n

1 Metric screws

2 American National screws

Special handling of components

The following components require special handling when servicing the workstation.

/A WARNING! Do notuse the front bezel as a handle or lifting point when lifting or moving the workstation.
Lifting the workstation from the front bezel or lifting it incorrectly could cause the unit to fall and cause
harm to the user and damage to the workstation. To properly and safely lift the workstation, lift it from
the bottom of the unit from either the desktop or minitower configuration.
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Cables and connectors

Cables must be handled with care to avoid damage. Apply only the tension required to seat or unseat
the cables during insertion or removal from the connector. Handle cables by the connector or pull strap
whenever possible. In all cases, avoid bending or twisting the cables, and be sure that the cables are
routed in such a way that they cannot be caught or snagged by parts being removed or replaced.

/A CAUTION: When servicing this workstation, be sure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the workstation.

Hard drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
guideline applies to failed drives as well as replacement spares.

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the workstation.

Avoid dropping drives from any height onto any surface.

If you are inserting or removing a hard drive, power off the workstation. Do not remove a hard drive
while the workstation is on or in standby mode.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, see
Electrostatic discharge information on page 52.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

Lithium coin cell battery

The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.

For instructions on battery removal and replacement, see the Battery on page 80.

/A WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140° Fahrenheit (60° Centigrade).

149,

B NOTE: Batteries, battery packs, and accumulators should not be disposed of together with general

household waste.

Customer Self-Repair

Customer Self-Repair enables you to obtain replacement parts and install them yourself on your
workstation. See http://www.hp.com/go/selfrepair/ for more information.
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Predisassembly procedures

Perform the following steps before servicing the workstation:

N o a &~ w0 Dd =

Close any open software applications.

Remove any diskettes or CDs from the workstation.

Shut down the operating system.

Power off the workstation and any peripheral devices that are connected to it.

Remove or disengage any security devices that prohibit opening the workstation.

Disconnect the power cord from the electrical outlet and then from the workstation.

Disconnect all peripheral device cables from the workstation.

System board components

The following image shows the system board connectors and sockets on the HP xw4400 Workstation.
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Figure 4-2 System board identification

Table 4-3 System board components

No. Component No. Component No. Component
1 Second serial port 12  Battery 23 Auxiliary audio
adapter
2 Rear chassis fan 13  Serial ATA 24 PCI32/33
3 Auxiliary power 14  Clear CMOS button 25 PCI Express x1
4 Processor 15  Front chassis fan 26  PCI Express x16 (4)
5 Solenoid hood lock 16  Front control panel 27 PCI 32/33
6 Processor fan 17  Front chassis fan 28 PCI Express x16

Predisassembly procedures
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Table 4-3 System board components (continued)

No. Component No. Component No. Component
7 Memory module 18  Front USB 29  Network/USB
sockets
8  Main power 19  Hard disk activity LED 30 Audio
9  Diskette drive 20 Internal USB 31 USB
10  Primary IDE 21  Speaker 32  Parallel
11 Chassis intrusion 22 Front audio 33  Serial
switch

34  Keyboard/Mouse

* Electrically x4 bandwidth

System board architecture

The following image shows the HP xw4400 Workstation block diagram.
Figure 4-3 System board block diagram
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Steps for removal and replacement of components

This section discusses the procedures necessary to remove and install various hardware components
on your workstation. Review the safety and precautions and the Service considerations on page 52, as
well as the Safety and Regulatory Information, before servicing or upgrading your system.

1. Read all safety information and precautions.
2. Locate and clear a suitable work area.

3. Shut down the system and remove power from the unit.
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4.
5.
6.

Gather your tools.
Service your unit.

Restore power to your unit.

Disassembly order

ENWW

Use the following table to determine the sequence in which to remove the major components.

Predisassembly

(Predisassembly
procedures on page 57)

Locks (Security lock
(optional) on page 60

Side access panel (Side access panel
on page 62)

Hood sensor (Hood sensor
(Smart cover sensor)

on page 64)

Front bezel (Front Bezel
on page 63)

Front panel I/0 device assembly (Front
panel I/0 device assembly on page 65)

Power button and front
speaker (Power button

on page 67)

Optical drive (Optical drive
(Desktop position)

on page 85)

Diskette drive (Diskette
drive (optional

on page 87)

Bezel blanks (Bezel
blanks on page 63)

Power supply (Power
supply on page 68)

System fan (System fan
assembly on page 69)

Front fan removal
(optional) (Front PCI card
guide and fan removal
(optional) on page 79)

Battery (Battery
on page 80)

Hard drive (SAS hard
drive on page 88)

CPU heatsink (CPU heatsink

on page 95)

Steps for removal and replacement of components
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Processor (Processor
on page 97)

PCI retainer (PCl retainer on page 74)

PCI or PCI express card (PCI
on page 77)

CPU heatsink (CPU
heatsink on page 95)

Processor (Processor
on page 97)

System board (System
board on page 98)

Security lock (optional)

If a security padlock is installed, remove it before servicing the unit. To remove the padlock, unlock it
and slide it out of the padlock loop as shown in the following image.

Figure 4-4 Removing the security lock
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Cable lock (optional)

If a cable lock is installed, remove it before servicing the unit. To remove the cable lock, unlock it and
pull it out of the cable lock slot as shown in the following image.

Figure 4-5 Removing the cable lock

Universal chassis clamp lock (optional)
If a universal chassis clamp lock is installed, remove it before servicing the unit.
To remove the lock:

1. Unlock the device and remove the locking mechanism.
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2. Remove the screw attaching the lock to the chassis.

Side access panel
Before accessing the internal components of the workstation, the side access panel must be removed.

To remove the side access panel:

/A WARNING! Before removing the workstation side access panel, be sure that the workstation is
powered off and that the power cord is disconnected from the electrical outlet.

1. Disconnect power from the system (Predisassembly procedures on page 57) and lay the
workstation on its side as shown.

2. If necessary, unlock the side access panel. The keys are on the rear panel. Also, unlock any other
locks that are present (Cable lock or Padlock).

3. Pull up on the latch (1), slide the side access panel 2 toward the rear of the workstation and then
lift off the cover (2).

Figure 4-6 Opening the side access panel
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To replace the side access panel, align the bottom groove of the side access panel with the bottom edge
of the chassis, rotate the side access panel toward the chassis and press firmly until the latch engages.

Front Bezel
1. Lift up on the two release snaps (1) located on the front bezel.
2. Rotate the front bezel away (2) from the chassis to remove the bezel.

Figure 4-7 Opening the front bezel

To replace the front bezel, align front bezel on the bottom and rotate in until it snaps into place.

Bezel blanks

To remove the bezel blanks:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the front
bezel (Front Bezel on page 63).

2. Gently push the subpanel (1) out the back of the front bezel.

3.  Remove the desired bezel blank by applying outward pressure on the subpanel (1) and pulling the
blank (2) away.

Figure 4-8 Removing the bezel blanks
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Bf NOTE: The bezel blanks are keyed to assist you in replacing the blanks. Also, the subpanel can be
rotated 90 degrees to install the optical drives in desktop orientation if desired.

Hood sensor (Smart cover sensor)

To remove the hood sensor:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Disconnect the hood sensor connector (1) from system board.
3. Slide the hood sensor forward, push it down, and remove it (2) from the chassis. .

Figure 4-9 Removing the hood sensor

To replace the hood sensor, reverse the previous steps.

Solenoid hood lock (Smart cover lock) (optional)

To remove the hood lock:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Disconnect the solenoid hood lock cable (1) from the system board.

3. Using the FailSafe key (T-15 wrench), unscrew the two screws (2) from the back of the chassis as
shown in the following illustration.

To purchase a FailSafe key, contact your authorized HP reseller or service provider or visit the HP
website for ordering information.
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Slide the solenoid hood lock assembly (3) away from the chassis and out of the unit.

Figure 4-10 Removing the hood lock

To install the hood lock, reverse the previous steps.

Front panel I/O device assembly

To remove the front panel I/O device assembly:

1.
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Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the front bezel (Front Bezel

on page 63).

Unlatch the plastic snap that secures the cables inside the chassis and disconnect the front panel
I/O device assembly cables from the system board.

Remove the two smaller Torx screws (1) that hold the front panel I/O device assembly (3) and
bracket to the chassis.

Remove the two larger Torx screws (2) that hold the front panel I/O device assembly (3) to the
bracket.

Separate the bracket away from the front panel I/0 device assembly.

Pull the front panel I/O device assembly out about two inches away (4) from the chassis.
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7. Pull the front panel cables through the chassis and out the front of the unit. You might have to slide
the cables out one at a time.

Figure 4-11 Removing the front panel I/O device assembly

To replace the front panel I/O device assembly:

1. Thread each front panel I/O device assembly cable through the same holes from which they were
removed.

2. Push the front panel I/O device assembly into the chassis. Using your fingers, orient the cables so
that there is enough room form the front panel I/O device assembly to easily fit in its slot.

3. Loosely put the bracket on the front panel I/O device assembly and hook the bracket to the chassis.
4. Screw the bracket to the front panel I/O device assembly and screw the bracket to the chassis.

5. Connect the front audio cable to (1). Connect the front USB cable to (2). Connect the front control
panel cable to (3). If an IEEE-1394 card is installed, connect the front IEEE-1394 cable to the card.

Figure 4-12 Attaching front panel I/0 device assembly cables

Jmniod
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Power button

To remove the power button:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), remove the front bezel (Front Bezel on page 63),
and remove the front panel I/O device assembly (Front panel I/O device assembly on page 65).

2. Disconnect the power button assembly cable from the system board.
3. Pressin on the clips (1) that secure the power button to the chassis.

4. Dislodge the metal clip from the chassis by rocking the power button back and forth. Then slide
the power button assembly (2) out from the front of the chassis.

Figure 4-13 Removing the power button

To replace the power button, reverse the previous steps.

System speaker

To remove the speaker:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Disconnect the speaker cable (1) from the system board.
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3.  Remove the four screws (2) securing the speaker to the chassis and lift the speaker out (3) of the
chassis.

Figure 4-14 Removing the speaker

To replace the speaker, reverse the previous steps.

Power supply

To remove the power supply:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

X TIP: This next step requires disconnecting several power cables. To speed up reinstalling the
power supply, it is helpful to write down the numbers on the cables so that you can easily reconnect

the cable to the correct devices.

2. Disconnect all cables from the system board, drives, or cards.
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3. Remove the four screws (1) from the back panel.
4. Slide the power supply toward the front and lift it (2) out of the chassis.
Figure 4-15 Removing the power supply

To replace the power supply, reverse the previous steps.

System fan assembly

To remove the system fan assembly:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Disconnect the fan plug (1) from the system board. .
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3. Remove the four screws (2) from the rear of the chassis with a Phillips screwdriver, and lift it (3)
out of the chassis.

Figure 4-16 Removing the system fan

To replace the system fan assembly, reverse the previous steps.

/A CAUTION: When replacing the system fan, be sure that the fan is situated so that the airflow direction
arrow is pointing toward the rear of the chassis.

Memory

To remove a memory module:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

/A CAUTION: To ensure that memory modules are not damaged during removal or installation,
power off the workstation and unplug the power cord from the AC power outlet. Wait until the LED
on the back of the power supply turns off before removing memory. If you do not unplug the power
cord while installing memory, your memory modules might be damaged and the system will not
recognize the memory changes.

2. Gently push outwards on the socket levers (1).
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3. Lift the DIMM (2) straight up and remove it from the unit. Store the DIMM in an anti-static bag.

Figure 4-17 Removing memory module

Memory module features

e  Contains four memory slots for DIMMs
e  Supports 256-MB to 8-GB configurations
e  Supports dual-channel DIMMs

Memory module requirements

/A CAUTION: HP only ships DIMMs that are electrically and thermally compatible with this product.
Because third-party DIMMs might not be electrically or thermally compatible, they are not supported by
HP.

Bf NOTE: DIMMs and their sockets are keyed for proper installation. Be sure these guides line up when
installing DIMMs.

e Use only industry-standard, unbuffered, PC2—4200 (533 MHz) or PC2-5300 (667 MHz) DIMMs.
e Match DIMM pairs by size and type
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Required loading order
Use the following illustration as a guide for installing memory:
e Ifinstalling only one DIMM, install it in socket (1).
e Install the first DIMM pair in sockets (1) and (3).
e Install the second DIMM pair in sockets (2) and (4).
Figure 4-18 Required loading order

To install a memory module:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Gently push outwards on the socket levers.

3. Lower the DIMM straight down (1) and secure the socket levers (2) into place.
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Figure 4-19 Installing a memory module

PCI Slots

This section contains information on PCI slots.

Your workstation contains three PCI slots, one PCI Express x1 slot, one PCI Express x16 ( x4) slot, and
one PCI Express x16 (usually used for high-end graphics.

Figure 4-20 Identifying the PCI slots

Table 4-4 PCI slots

Slot Type Slot power (Maximum)
1 PCI Express x16 75 W*
2 PCI 32/33 25 W+
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Table 4-4 PCI slots (continued)

Slot Type Slot power (Maximum)
3 PCI Express x16 (4) 25W
4 PCI Express x 1 25 W
5 PCI 32/33 25 W
6 PCI 32/33 25 W

* In addition to these slot power specifications, the overall power consumption of the system
(including I/O cards, processor, and memory) must not exceed the maximum ratings of the
system power supply.

PClI retainer
For added protection, some cards have PCI retainers installed to prevent movement during shipping.
To remove the PCI retainer:

1.  Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Remove the two screws (1) retaining the retainer and lift it (2) out of the chassis.

Figure 4-21 Removing the PCI retainer

i

To install the PCI retainer:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Engage the rear bracket (1) with the holes in the rear of the chassis before rotating it down (2) into
position. .
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3. Secure the bracket with two screws (3).

Figure 4-22 Installing the PCI retainer
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PCI Express
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PCI Express is a point-to-point architecture and uses a serial data transmission protocol. A single PCI
Express lane consists of four wires and can transmit 250 MB in a single direction or 500 MB in both
directions simultaneously. This bandwidth is not affected by what is happening on other PCI Express
buses or legacy PCI/PCI-X buses (provided that total bandwidth can be handled by the CPU and the
memory subsystem). The transmission protocol is somewhat similar to that used for a LAN connection
and contains error correction and detection, packet addressing, and other network features.

PCI Express improves system attributes. PCl Express enables a low-power, scalable, high-bandwidth
communication path with a small number of connections (wires) compared to traditional parallel
interfaces (e.g., PCI).

The PCI Express /O slots can support other PCI Express cards with lesser bus bandwidth than what is
physically defined for the slot. Use the following table to determine compatibility.

Table 4-5 PCI Express compatibility matrix for xw4400

Mechanical compatibility = Electrical compatibility

PCI Express x1 slot x1 cards X1 modes
PCI Express x16 (x4) slot x1, x4, x8, and x16 cards x1 and x4 modes
PCI Express x16 slot x1, x4, x8 and x16 cards x1 and x16 modes

To remove a PCI Express card:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the PCI retainer (PCI retainer

on page 74), if installed.
2. Lift the PCl levers (1) by first pressing down and then up.

3. If removing a PCI Express x16 graphics card, press in on the “hockey stick” lever (2) while lifting
the card (3) out of the chassis. Store the card in an anti-static bag.
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If removing another type of PCI Express card, lift the card out of the chassis. You do not need to
press in on the “hockey stick” lever.

4. Install a PCI slot cover and close the PCI levers. If the PCI levers do not close, be sure all cards
are properly seated and then try again.

Figure 4-23 Removing the PCI Express card

To install a PCI Express card:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the PCI retainer (PCI retainer

on page 74), if installed.
2. Lift the PCl levers (1) by first pressing down and then up.

Remove the PCI slot cover (2).

4. Lower the PCI (3) card into the chassis. Verify that the keyed components of the card align with
the socket.
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5. Close the PCI retention clamp (4) by rotating the clamp downward and pushing on the two green
snaps down from the rear panel of the chassis.

Figure 4-24 Installing the PCI card

PCI

To remove a PCI card:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the PCI retainer (PClI retainer

on page 74), if installed.
2. Lift the PCl levers (1) by first pressing down and then up.

3. Lift the PCI card (2) out of the chassis. Store the card in an anti-static bag.

4. Install a PCI slot cover and close the PCI levers. If the PCI levers do not close, be sure all cards
are properly seated and then try again.

Figure 4-25 Removing the PCI card
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To install a PCI card:

1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the PCI retainer (PCI retainer

on page 74), if installed.
Lift the PCI levers (1) by first pressing down and then up.

Remove the PCI slot cover (2).

Lower the PCI (3) card into the chassis. Verify that the keyed components of the card align with
the socket.

Close the PCI retention clamp (4) by rotating the clamp downward and pushing on the two green
snaps down from the rear panel of the chassis.

Figure 4-26 Installing the PCI card

IEEE-1394 (optional)
To remove an IEEE-1394 card:

1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the front bezel (Front Bezel

on page 63).
Lift the PCl levers (1) by first pressing down and then up.

Disconnect the front I/O cable and power cable (2) from the card.

Lift the IEEE card (3) out of the chassis. Store the card in an anti-static bag.
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5. Install a PCI slot cover and close the PCI levers. If the PCI levers do not closed, be sure all cards
are properly seated and then try again.

Figure 4-27 Removing the IEEE-1394

To install an IEEE-1394 card, reverse the previous steps.

Front PCI card guide and fan removal (optional)

Bf NOTE: The fan is only used for special configurations, but the card guide is used with all full-length
add-in cards.

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the front bezel (Front Bezel

on page 63).

2. Disconnect the fan wire (1) from the connector on the system board and thread it out of the card
guide.
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3. Unsnap the fan housing from the chassis (2) and lift it out of the chassis (3).

Figure 4-28 Removing the front fan

4. Remove the fan from the fan housing by applying outward pressure on the fan housing while
pushing the fan out of the housing.

Figure 4-29 Removing the fan from the card guide

To replace the front fan, reverse the previous steps, but be sure that the airflow direction arrow on the
side of the fan points to the rear of the chassis.

Battery

The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.

/A WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140°F (60°C).
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/A CAUTION: Before removing the battery, be sure your CMOS settings are backed up as all CMOS
settings are lost when the battery is removed. To back up the CMOS settings, use Computer Setup and
run the Save to Diskette option from the File menu.

Bf NOTE: Batteries, battery packs, and accumulators should not be disposed of together with general
household waste.

To remove the battery:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. On the system board, press on the release tab of the battery holder.
3. Rotate the battery enough to get beyond the latch and lift it straight up.
Figure 4-30 Removing the battery

To install the battery, confirm the polarity (positive-negative), position battery edge under plastic housing
tabs, and press down until the metal snaps engage.
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Power connections to drives

For help in identifying power cables, refer to the following information. Route or tie cables so that there
is no possible way for them to interfere with the CPU heatsink fans.

Figure 4-31 Identifying the correct power connections for a typical configuration

Fa

/\ P7 E Fil ZATA

GEESTS e
iz sare e

Connector Description
P1 Main power on system board
P2 N/A
P3 CPU power
P4 PCI Express graphic auxiliary
P5 PCI auxiliary (e.g. 1394)
P6 ODD IDE top bay
P7 ODD IDE mid bay
P8 FDD
P9 Third HDD SATA bottom ODD bay
P10 Fourth HDD SATA mid ODD bay
P11 ODD IDE or 3rd HDD SAS ODD bottom bay
P12 First HDD SATA bottom HDD bay
P13 Second HDD SATA top HDD bay
P14 First HDD SAS bottom HDD bay
P15 Second HDD SAS top HDD bay
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Optical drive (Minitower position)
Your workstation might have an IDE or SATA optical drive. To remove an optical drive:

1.  Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and remove the front bezel (Front Bezel

on page 63).

2. Disconnect the data (1), power (2), and audio (3) cables from the drive. The connector colors might
be different than illustrated.

Bf NOTE: The audio cable is only required for Linux-based systems.

Figure 4-32 Disconnecting the cables from the optical drive

3. Lift the green drive-lock release lever (1) and gently slide the drive (2) out of the chassis.

Figure 4-33 Removing the optical drive from the chassis
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4. After pulling the drive (1) out, remove the four guide screws (2) from the drive. Only remove the
four guide screws if you plan to install another drive.

Figure 4-34 Removing the optical drive screws

To install an optical drive:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and remove the front bezel (Front Bezel

on page 63).
2. Insert the four guide screws (1) into the drive.

3. Align the screws with the grooves in the drive bay and gently slide 2 the drive into the unit until it
shaps into place.

/A CAUTION: Ensure that the optical drive is secure by pulling to see if the drive can become easily
disengaged. Failure to do so can cause damage to the drive when moving the workstation.
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4. Connect the power, drive, and audio (if required) cables to the drive and system board. On Linux
systems, connect the audio cable to the AUX-IN connector.

Bf NOTE: The audio cable is only required for Linux-based systems.

Figure 4-35 Installing the optical drive

Optical drive (Desktop position)

To remove an optical drive:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and remove the front bezel (Front Bezel

on page 63).

2. Disconnect the data (1), power (2), and audio (3) cables from the drive. The connector colors might
be different than illustrated.

EBf NOTE: The audio cable is only required for Linux-based systems.

Figure 4-36 Disconnecting the cables from the optical drive
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3. Press down on the yellow drive-lock release lever (1) and gently slide the drive 2 out of the chassis.

Figure 4-37 Removing the optical drive from the chassis

4. After pulling the drive (1) out, remove the four guide screws (2) from the drive. Only remove the
four guide screws if you plan to install another drive.

Figure 4-38 Removing the optical drive screws

To install an optical drive:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and remove the front bezel (Front Bezel

on page 63).
2. Insert the four guide screws (1) into the drive.

3. Align the screws with the grooves in the drive bay and gently slide (2) the drive into the unit until it
snaps into place.

/A CAUTION: Ensure that the optical drive is secure by pulling to see if the drive can become easily
disengaged. Failure to do so can cause damage to the drive when moving the workstation.
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4. Connect the power, drive, and audio (if required) cables to the drive and system board. On Linux
systems, connect the audio cable to the AUX-IN connector.

Bf NOTE: The audio cable is only required for Linux-based systems.

Figure 4-39 Connecting the optical drive cable to the system board

Diskette drive (optional)
To remove a diskette drive:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and the front bezel (Front Bezel on page 63).

2. Disconnect the data (1) and power (2) cables from the back of the diskette drive.

Figure 4-40 Disconnecting the cables from the diskette drive
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3. Lift the green drive-lock release tab (1) and gently slide the drive 2 out at the same time.

Figure 4-41 Removing the diskette drive from the chassis
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To replace a diskette drive:

1. Align the metal protrusions on the side of the drive with the grooves in the diskette drive bay and
slide the diskette drive into the bay until it stops.

2. Connect the data cable to the diskette drive (1) and to the system board (2).

3. Connect the cables to the back of the diskette drive.

SAS hard drive

To remove a hard drive:

1.  Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).
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2. Disconnect the data (1) and power (2) cables from the hard drive.

Figure 4-42 Removing the hard drive

3. Lift up on the green drive-lock release tab (1) and slide the hard drive (2) out of the chassis.

Figure 4-43 Removing the hard drive

To install a SAS hard drive:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side

access panel (Side access panel on page 62).
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2. Attach a SAS-to-SATA cable adapter to the connector on the hard drive.
Figure 4-44 Attaching the adapter

3. Push the drive (1) into the selected bay until it snaps into place.
4. Attach the data (2) and power (3) cables to the drive.
Figure 4-45 Installing the SAS hard drive

5. Insert the SAS controller card into an available PCI slot.

6. Connect the data cable from the hard drive (1) to the controller card (2).
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7. Connect the hard drive LED cable from the card to the hard drive LED connector on the system
board. You can find the location of this connector on the illustration on the inside of the side access
panel.

Figure 4-46 Connecting the SAS cable to the hard drive

SATA hard drive

For more information on SATA hard drives and the SATA RAID configurations, refer to the SATA devices
appendix.

To remove a hard drive:

1.  Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Disconnect the data (1) and power (2) cables from the hard drive.

Figure 4-47 Removing the hard drive
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3.  Lift up on the green drive-lock release tab (1) and slide the hard drive (2) out of the chassis.

Figure 4-48 Removing the hard drive

To install one or two SATA hard drives:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2. Select a drive bay in which to install the drive.

3. Push the drive into the selected bay until it snaps into place.

4. Attach the data (1) and power (2) cables to the drive.
Figure 4-49 Installing the SATA hard drive
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5. Connect the data cable from the hard drive (1) to the serial ATA port (2). SATAO port is shown in
the following illustration.

e Connect SATA 0 to SATAOQ.
e Connect SATA 1 to SATA1.
Figure 4-50 Connecting the SATA cable to the hard drive

To install three to four SATA hard drives:
1.  Follow the instructions for installing two SATA hard drives above.

2. Follow the instructions for installing the hard drive into the optical drive slot.

Bf NOTE: Ifinstalling three SATA hard drives, you must install hard drives in at least one optical
drive bay. If installing four SATA hard drives, you must install hard drives in at least two optical
drive bays.

3. Connect the data and power cable to the drives.
e Connect SATA 2 to SATA2.
e Connect SATA 3 to SATAS.

Installing hard drives in the optical drive bays (optional)

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and the front bezel (Front Bezel on page 63).
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2. Place the hard drive in the bracket (1) and secure with American National screws (2) as shown in
the following illustration.

Figure 4-51 Installing hard drive into bracket

3.  Screw four screws to the bracket (1). Align the screws with the grooves in the optical drive bay and
slide the drive in (2) the chassis.

Figure 4-52 Installing hard drive into optical drive bay

4. Connectthe data cable to the hard drive (1) and to the system board (2). SATA installation is shown.
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5. Connect the power cables (not shown).

Figure 4-53 Connecting the data cable to the system board

CPU heatsink

Bf NOTE: The following illustrated CPU heatsink is typical of what you might have in your workstation.
Be aware that different variations of the CPU heatsinks exist, but the overall procedures listed are

sufficient to assist you in removing the CPU heatsink.

To remove the CPU heatsink:
1. Shut down the system, disconnect power from the system, and remove the side access panel.
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2. Loosen the four processor screws slowly and evenly. Loosen one pair of diagonally opposite
screws (1) until the screw shanks disengage from the system board, and then loosen the remaining
pair (2). Do not fully loosen one screw, and then move on to the next. Loosen all of the screws a
little at a time, being sure the processor remains level.

Figure 4-54 Identifying proper screw loosening sequence

3. Disconnect the CPU heatsink fan cable (1) from the system board.
4. Gently twist the heatsink unit to break the thermal grease binding.
5. Lift the CPU heatsink (2).

Figure 4-55 Removing the CPU heatsink from the system board

6. Use alcohol and a soft cloth to clean all of the thermal interface residue from the CPU heatsink and
processor.

/A CAUTION: Allow the alcohol on the processor and CPU heatsink to dry completely.
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To replace the CPU heatsink:

1. Disconnect power from the system (Predisassembly procedures on page 57). Remove the side
access panel (Side access panel on page 62) and the CPU heatsink.

2. Use alcohol and a soft cloth to clean all of the thermal interface residue from the CPU heatsink and
processor.

/A CAUTION: Allow the alcohol on the processor and CPU heatsink to dry completely.

3. Check for proper processor seating in the socket by carefully trying to lift the processor out of the
socket with your fingers. A properly seated processor does not lift out of the socket.

4. Apply the thermal grease to center of the processor. If using a new CPU heatsink, remove and
discard the thermal grease protective liner from the bottom of the new CPU heatsink.

Bf NOTE: Do not touch the exposed thermal grease when handling the CPU heatsink.

5. Lower the CPU heatsink onto the system board.

6. Carefully tighten the four screws a little at a time; do not fully tighten one screw and move onto the
next. Be sure the processor remains level and be sure you do not overtighten the screws. If you
have a torque-limited driver available, tighten the screws to the correct torque setting of 6 in-Ibs.

/A CAUTION: Do not overtighten the screws. If you overtighten the screws, you risk stripping the
threads in the system board tray.
Processor
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To remove the processor:
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and the CPU heatsink (CPU heatsink on page 95).

Raise the lever (1) on the processor socket handle and open the cover (2).
Pull the processor (3) straight out of the socket. .

Figure 4-56 Raising the processor socket handle
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/A CAUTION: Avoid bending the protrusions in the CPU socket. This mishandling can damage the CPU
socket.

B NOTE: Store the processor in a safe place where it will not be damaged.

To replace the processor:

1. Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), the CPU heatsink (CPU heatsink on page 95), and
the processor (Processor on page 97).

2. Raise the processor socket handle fully (the full swing angle of the lever is approximately 90
degrees).

/\ CAUTION: Processor pins are delicate and bend easily. Use extreme care when placing the
processor in the socket to avoid bending pins.

3. Align the triangle on the top of the processor with the triangle on the corner of the processor socket
and install the processor into the socket. Ensure that the underside of the processor is level with
the top of the processor socket. Lightly press down on the top of the processor while closing the
socket lever.

Figure 4-57 Seating the processor

4. Check for proper processor seating in the socket by carefully trying to lift the processor out of the
socket with your fingers. A properly seated processor does not lift out of the socket.

System board

To remove the system board:

1. Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62), remove all expansion boards, graphics cards, and
the CPU heatsink (CPU heatsink on page 95)

2. Disconnect all cabling from the system board.

Bf NOTE: Make note of the cable connections before disconnecting them from the system board.
Refer to Power connections to drives on page 82 for more information.

3. Press the release tab (1) as shown in the following illustration.
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4. Slide the system board toward the front of the chassis and then lift it (2) out of the unit. .

Figure 4-58 Removing the system board

To replace the system board:

1. Lay the system board back in the chassis slightly away from the rear of the chassis. The mounting
hooks should fall into the recesses of the tray so the tray lays flat on the chassis base.

2. Slide the tray towards the rear of the chassis until the heat sink mounting holes line up.

3. Reinstall the CPU heatsink, cards, and cables.

Product recycling

HP's Planet Partners recycling service provides an easy way to recycle computer equipment,
rechargeable batteries or HP printing supplies. HP processes ensure that unwanted hardware or empty
HP printing supplies are recycled responsibly.

For information on recycling HP components or products, visit http://www.hp.com/go/recycle.
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5 System diagnostics and
troubleshooting

This chapter discusses the tools available for diagnosing and troubleshooting system issues.

E-Support on page 101

Troubleshooting checklist on page 102

LED color definitions on page 102

HP Insight Diagnostics Offline Edition on page 102

Diagnostic error codes on page 106

Troubleshooting scenarios and solutions on page 108

POST and error messages on page 124

E-Support

Help & Support Center and E-Support

Help & Support Center (HSC) provides online access to technical support information, software updates
and downloads, diagnostic tools, and HP support contact information.

To open HSC from your desktop, click Start>Help and Support.

HSC contains four sections:

ENWW

HP Product Information (requires Internet access)—Links to the HP Technical Support website for
your product. You can access all related documentation, downloads and updates, tools, and more.

HP Software & Driver Downloads (requires Internet access)—Links to HP specific software
downloads and updates.

HP Support Tools (requires Internet access)—Links to self-help tools and diagnostics offered by
HP Instant Support Professional Edition.

Contact HP for Support (does not require Internet access)—Provides two different options:

° Chat with an expert online (requires Internet access)—Provides a tool to communicate with
a support specialist online through Active Chat.

o Call a support agent—Provides hardware details about the workstation and HP support
contact phone number worldwide.
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Troubleshooting checklist

Before running any of the diagnostic utilities, use the following checklist to find possible solutions for
workstation or software problems.

LED col

Are the workstation and monitor connected to a working electrical outlet?

Is the workstation powered on?

Is the green power light illuminated?

Is the monitor on?

Is the green monitor light illuminated?

Adjust the monitor brightness and contrast controls if the monitor is dim.

Press and hold any key. If the system beeps, then the keyboard is operating correctly.
Check all cables for loose or incorrect connections.

Reconfigure the workstation after installing a non-PnP expansion board or other option, such as a
diskette drive.

Are all of the necessary device drivers installed?
Have all printer drivers been installed for each application?
Remove all diskettes and CDs from the drives before you power on the system.

Are you running the latest BIOS version, drivers, and software updates?

or definitions

An LED light exists on the front panel of your workstation. The following table describes what each color
signifies.

Table 5-1 LED color definitions

LED state LED color System status
Solid Green System is on.
Flashing Green System is in Standby.
Solid or flashing Red System has experienced an error. Refer
to Diagnostic LED codes on page 106
None No light System is in Hibernate, or it is off.

HP Insight Diagnostics Offline Edition

The diagnostics utility enables you to perform testing and to view critical computer hardware and
software configuration information from various sources. This utility enables you to:

Run diagnostics

View the hardware configuration of the system
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Key features and benefits

HP Insight Diagnostics simplifies the process of effectively identifying, diagnosing, and isolating the
hardware issues.

In addition to robust management tools, service tools can be invaluable in quickly resolving system
problems. To streamline the service process and resolve problems quickly, it is necessary to have the
right information available at the time that a service call is placed. The primary information requirement,
which is also the one that provides the greatest insight into potential system issues, is the configuration
of the system. Insight Diagnostics helps provide higher system availability. Typical uses of the Insight
Diagnostics are:

e Testing and diagnosing apparent hardware failures

e Documenting system configurations for upgrade planning, standardization, inventory tracking,
disaster recovery, and maintenance

e  Sending configuration information to another location for more in-depth analysis

Theory of operation

Insight Diagnostics Offline Edition operates in offline mode only. The operating system is not running
and software information from the system is not available to the diagnostics.

Offline Survey is available to display the current system configuration.

The Insight Diagnostics Test feature provides the capability to test functionality of all the major hardware
components in the system. The Test feature is designed to be flexible to enable you to customize test
selections by providing different modes and types of testing.

A Quick Test provides a predetermined script where a sample of each hardware component is exercised
and requires no user intervention.

A Complete Test provides a predetermined script during which each hardware component is fully tested.
You can select Interactive or Unattended tests. This will change the devices tested during the Complete
Test. There are more tests available in the interactive mode, but these require user intervention.

A Custom Test provides the most flexibility in controlling the testing of a system. The Custom Test mode
enables you to specifically select which devices, tests, and test parameters are run. You can select tests
that do not require any user interaction through the Interactive and Unattended tests modes.

Diagnostic Utility on CD
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HP Insight Diagnostics is available on the Documentation Library CD that was shipped with your
workstation.

To start the diagnostic utility on the Documentation Library CD:

1. Power on your workstation and press the F10 key during the initial boot process to enter the
Computer Setup (F10) Utility.

2. Select your language from the list and press the Enter key. In the Computer Setup Utilities menu,
four headings are displayed: File, Storage, Security, and Advanced. There may be other
headings depending on the workstation.

3. Use the right arrow key to select Storage.
4. Use the down arrow key to select Boot Order, and press Enter.

5. Select CD-ROM Drive and enable it as a bootable device by pressing the F5 key (if not already
enabled, pressing the F5 key again disables the device). Default setting is Enabled.
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6. Setthe CD-ROM Drive to the top of the boot order. To do this, select CD-ROM, press the Enter
key, and use the up arrow to move it to the top of the boot order.

7. To apply and save changes, press the F10 key, and select File>Save Changes and Exit
8. Insert the Documentation Library CD into the workstation.

9. Restart your system and HP Insight Diagnostics launches automatically.

Downloading the latest diagnostic utility

1. Access http://www.hp.com.

Click the Support & Drivers link.

Select the Download driver and software radio button.
Enter your product number (for example, xw4400) in the text box and press the Enter key.
Select your operating system.

Click the Diagnostic link.

N o a e DN

Locate HP Insight Diagnostics Offline and click Download.

User Interface

Navigation

The Insight Diagnostics home page contains the following tabs: Survey, Test, Status, Log, and
Help. These tabs separate the major functions of Insight Diagnostics.

Survey tab

When the Survey tab is selected, the Survey menu displays and enables you to view important system
configuration information. The Summary view limits the amount of data displayed, while the
Advanced view shows all the data in the selected category. Regardless of whether you choose
Advanced or Summary, the following categories of information are available on the Survey menu:

Overview—Gives you a listing of general information about the computer.
All—Gives a listing of all information about the computer.

Architecture—Shows the type of bus the computer uses as well as BIOS information. In addition, if the
bus is PCI, information about the PCI configuration is displayed.

Asset Control—Shows the serial number of the computer and also provides processor information.

Communication—Shows information about the computer parallel (LPT) and serial (COM) port settings,
USB, and network controller information.

Graphics—Shows information about the graphics subsystem of the computer.
Input Devices—Shows information about the type of keyboard and mouse.

Memory—Shows information about all memory in the computer, including memory on the board and
any memory modules installed.

Miscellaneous—Shows information obtained from the computers configuration memory (CMOS), BIOS
data area, Interrupt Vector table, and diagnostics component information.

Storage—Shows information about storage media connected to the computer, including all fixed disks,
floppy drives, and CD-ROM drives.
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Test tab

Status
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System—Shows product type, processor type and speed, coprocessor information, and information
about all ROMs in the computer.

The Insight Diagnostics utility provides the capability to test all the major pieces of hardware in the
system. You can select from several types of tests:

Quick Test—Provides a predetermined script during which a sample of most hardware components is
exercised and requires no user intervention.

Complete Test—Provides a predetermined script during which most hardware components are fully
tested. You can select Interactive or Unattended tests. This will change the devices tested during the
Complete Test. More tests are available in the interactive mode, but these require user intervention.

Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test mode
enables you to specifically select which devices, tests, and test parameters are run. You can select tests
that do not require any user interaction through the Interactive and Unattended test modes. More tests
are available in the interactive mode, but these tests require user intervention.

To begin testing:

1. Click the Test tab.

2. Select Type of Test to perform and then select Test Mode, either Interactive or Unattended.
3. Choose how you want the test to be executed, either Number of Loops or Total Test Time.

e  When choosing to run the test over a specified number of loops, enter the number of loops to
perform.

e If you want to run the diagnostic test for a specified time period, enter the amount of time in
minutes.

4. Click Begin Testing in the lower right corner of the display to start the test.

While tests are being performed, you can monitor the progress by viewing the Status tab. Any errors
that are detected are summarized in the Error Log. Select Save to save the report to floppy or a USB
Key Drive if attached.

If the diagnostics utility detects an error during a test, the user can mouse-over the failed text in the
Status tab to display additional information for the type of error and the error code.

To view all test failure information, Error Log. To view the status of all testing that has been performed,
click the Log tab.

tab

The Status tab displays the status of the selected tests. The type of test executed (for example,
Quick, Complete, Custom) is displayed. The main progress bar displays the percent complete of the
current set of tests. While testing is in progress, Cancel Testing is displayed. This selection will cancel
the test job.

After testing has completed, the Cancel testing button is replaced with two buttons, Select New
Tests and Retest. The Select New Tests button enables you to go back to the previous test selection
page to select a new set of tests. The Retest button retests the last set of tests executed. This enables
you to rerun the set of tests without having to go back to the test selection page.
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The Status page also shows:
e The devices being tested
e  The tests that are running
e The overall Test time

e The individual Test times

e The condition status of each test

Log tab

The Log tab consists of three views.

Test Log—Displays all tests that have been executed, number of times the test has been executed,
number of times the test failed, and the time it took to complete the test. The Clear Test Log button will
clear the contents of the Test Log.

Error Log—Displays the tests that have failed during the diagnostic testing. Besides displaying the
device and test, this section might also include error details. The description section describes the error
that the diagnostic test found. The Recommended Repair will give a recommended action that should
be performed to resolve the failed hardware. The error count is the number of times the test has failed.
The Clear Error Log button will clear the contents of the Error Log.

Help tab

The Help tab has three views:

e HP Insight Diagnostics—Provides introductory and detailed information about Insight Field
Diagnostics.

e Error Codes—Provides error code listings. It includes device tested, message, and recommended
repair information.

e Test Components—Reloads and refreshes all components and display component details after
the refresh.

Diagnostic error codes

This sections provides an overview of the diagnostic LEDs and error codes that are related to your
workstation.

Diagnostic LED codes

Ef NOTE: The beeps are heard through the on-board piezo speaker and not the chassis speaker. The
flashing lights and beeps repeat for five cycles. After that, only the flashing lights repeat.

Table 5-2 Diagnostic LED codes

Chassis indicator LEDs

Power LED and sound Diagnosis and service action
activity
None System does not power on. Press the power button. If HDD LED = GREEN, then:

1. Remove expansion cards one at a time.

2. Replace the system board.
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Table 5-2 Diagnostic LED codes (continued)

Chassis indicator LEDs

Power LED and sound
activity

Diagnosis and service action

OR

Press the power button. If HDD LED does not illuminate, then:

1.
2.

Verify that the unit is plugged into a working AC outlet.

Open access panel and verify that the power button harness is properly connected
to the inline front panel /O device assembly connector.

Verify that the power supply cables are properly connected to the system board.
Verify the power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply cables from the system board.

c. Plugin AC power.

° If the power supply fan spins and the BIST LED illuminates, then the power
supply is good. Replace the system board.

o If the power supply fan does not spin or the BIST LED does not illuminate,
replace the power supply.

Blinks red 2 times, once per
second, then 2-second pause,
2 beeps

Thermal shutdown has occurred:

1.

3.
4.

Ensure that the workstation air vents are not blocked and the cooling fan is
running.

Open the access panel, press power button, and determine whether the processor
fan spins. Ifit does not spin, ensure the fan cable is plugged into the system board.
Ensure that the fan is properly seated.

If the fan is plugged in and seated but not spinning, then replace processor fan.

Reseat the CPU heatsink and verify that the fan assembly properly attached.

Blinks red 3 times, once per
second, then 2-second pause,
3 beeps

CPU not installed.

1.
2.

Install CPU.
Reseat CPU.

Blinks red 4 times, once per
second, then 2-second pause,
4 beeps

Power supply failure.

1.

Open the access panel, and be sure the four-wire power supply cable is properly
connected to the system board.

Locate faulty device by removing all devices and then reinstalling one at a time
until workstation fails. Replace the device causing the failure. Continue adding
devices to ensure all are functioning properly.

Verify the power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply cables from the system board.
c. Plugin AC power.

e  Ifthe power supply fan spins and the BIST LED illuminates, then the
power supply is good. Replace the system board.

e If the power supply fan does not spin or the BIST LED does not
illuminate, replace the power supply.

Diagnostic error codes
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Table 5-2 Diagnostic LED codes (continued)

Chassis indicator LEDs

Power LED and sound
activity

Diagnosis and service action

Blinks red 5 times, once per
second, then 2-second pause,
5 beeps

Pre-video memory error.

1.  Reseat memory modules.
2. Replace memory modules one at a time to find the faulty module.
3. Replace third-party modules with HP memory.

4.

Replace system board.

Blinks red 6 times, once per
second, then 2-second pause,
6 beeps

Pre-video graphic card error. For systems with integrated graphics, replace system
board. For systems with graphic cards:

1. Reseat the graphic card. Power on the system.
2. Replace the graphic card.

3. Replace the system board.

Blinks red 7 times, once per
second, then 2-second pause,
7 beeps.

System board failure (ROM detected failure before video). Replace system board.

Blinks red 8 times, once per
second, then 2-second pause,
8 beeps

Invalid ROM based on bad checksum.
1. Reflash ROM.

2. Replace system board.

Blinks red 9 times, once per
second, then 2-second pause,
9 beeps

System powers on but is unable to boot.
1. Replace the system board.

2. Replace the processor.

Troubleshooting scenarios and solutions

This section presents an extensive overview of various troubleshooting scenarios and includes possible

solutions for each.

Solving minor problems

Table 5-3 Minor problems

Problem

Cause Possible Solution

Workstation appears locked
up and will not shut down when
the power button is pressed.

Software control of the power 1.
switch is not functional.

Press and hold the power button for at least four
seconds until the workstation shuts down.

2. Disconnect electrical plug from outlet.

Workstation seems to be
locked up.

Program in use has stopped 1.
responding to commands.

Attempt the normal Windows shutdown procedure.

2. Restart the workstation using the power button.

Workstation date and time
display is incorrect.

Real-time clock (RTC) battery 1. Reset the date and time under Control Panel.

might need to be replaced.
2. Replace the RTC battery.
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Table 5-3 Minor problems (continued)

Problem

Cause

Possible Solution

Workstation appears to pause
periodically.

Network driver is loaded and no
network connection is
established.

Establish a network connection, or use Computer Setup or
Microsoft Windows Device Manager to disable the network
controller.

Cursor will not move using the
arrow keys on the keypad.

The Num Lock key might be on.

Press the Num Lock key. The Num Lock key can be
disabled (or enabled) in Computer Setup.

Poor performance is
experienced.

Processor is hot.

1. Be sure airflow to the workstation is not blocked.

2. Be sure the fans are connected and working properly
(some fans only operate when needed).

3. Be sure the CPU heatsink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on
the hard drive.

Workstation powered off
automatically and the Power
LED flashes red 2 times, once
every second, followed by a 2-
second pause, and two
simultaneous beeps are
heard.

Processor thermal protection
activated.

A fan might be blocked or not
turning.

OR

The CPU heatsink is not properly

attached to the processor.

1. Be sure workstation air vents are not blocked and the
cooling fan is running.

2.  Open the access panel, press the power button, and
see if the processor fan spins. If not spinning, be sure
the fan’s cable is plugged into the system board
header. Be sure the fan is fully/properly seated or
installed.

3. Replace the processor fan.

4. Reseat CPU heatsink and verify that the fan assembly
is properly attached.

System does not power on,
and the LEDs on the front of
the workstation are not
flashing.

System unable to power on.

Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1.  Remove the expansion cards.
2. Replace the system board.

OR Press and hold the power button for less than 4 seconds.
If HDD LED does not illuminate, then:

1. Verify that the unit is plugged into a working AC outlet.

2. Open the access panel and verify that the power button
harness is properly connected to the inline front panel
I/O device assembly connector.

3. Verify that the power supply cables are properly
connected to the system board.

4.  Verify the power supply functionality.
a. Disconnect AC power.

b. Remove all internal power supply cables from the
system board.

c. Plugin AC power.

e If the power supply fan spins and the BIST
LED illuminates, then the power supply is
good. Replace the system board.

e If the power supply fan does not spin or the
BIST LED does not illuminate, replace the
power supply.
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Solving power supply problems

Testing power supply

Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply
still works.

To test the power supply:

1. Unplug the AC power.

2. Disconnect all internal power supply cables from the system board.
3.  Plugin AC power.

e Ifthe green BIST LED (illustrated below) on the rear of the workstation is illuminated and the
fan is spinning, the power supply is functional.

e Ifthe green BIST LED (illustrated below) is not illuminated or the fan is not spinning, replace
the power supply.

Figure 5-1 Testing power supply with BIST LED
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Table 5-4 Power supply problems
Problem Cause Solution
Power supply shuts down Power supply fault. Replace the power supply.

intermittently.
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Table 5-4 Power supply problems (continued)

Problem Cause

Solution

Workstation powered off
automatically and the Power LED
flashes red 2 times, once every
second, followed by a 2-second
pause.

Processor thermal protection
activated.

A fan might be blocked or not
turning.

OR

The CPU heatsink fan
assembly is not properly
attached to the processor.

Be sure that the workstation air vents are not blocked
and the cooling fan is running.

Open the access panel, press the power button, and
determine whether the processor fan spins. If the
processor fan is not spinning, be sure the fan’s cable
is plugged into the system board header. Be sure the
fan is properly seated or installed.

Replace the processor fan.

Reseat CPU heatsink and verify that the fan
assembly is properly attached.

Power LED flashes red, once every
2 seconds.

Power failure (power supply is
overloaded).

Determine whether a device is causing the problem
by removing all attached devices). Power on the
system. If the system enters the POST, then power
off and replace one device at a time and repeat this
procedure until failure occurs. Replace the device
causing the failure. Continue adding devices one at a
time to ensure all devices are functioning properly.

Verify the power supply functionality.
a. Disconnect AC power.

b. Remove all internal power supply cables from
the system board.

c. Plugin AC power.

e Ifthe power supply fan spins and the BIST
LED illuminates, then the power supply is
good. Replace the system board.

e Ifthe power supply fan does not spin or the
BIST LED does not illuminate, replace the
power supply.

Solving diskette problems
Table 5-5 Diskette problems

Problem Cause

Solution

Diskette drive light stays on. Diskette is damaged.

In Microsoft Windows 2000 and Microsoft Windows XP,
right-click Start, click Explore, and select a drive.
Select File>Properties>Tools. Under Error-checking,
click Check Now.

Diskette is incorrectly inserted.

Remove and reinsert diskette.

Files on diskette are damaged.

Verify the program diskettes.

Drive cable is not properly
connected.

Reconnect power cable. Be sure that all four pins are
connected.

Drive not found. Cable is loose.

Reseat diskette drive data and power cables.

Removable drive is not seated
properly.

Reseat the drive.

Diskette drive cannot write to a Diskette is not formatted.

diskette.

Format the diskette.
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Table 5-5 Diskette problems (continued)

Problem Cause

Solution

Diskette is write-protected.

Use another diskette or remove the write protection.

Writing to the wrong drive.

Verify the drive letter in the path statement.

Not enough space is left on the
diskette.

Use another diskette.

Diskette write control is
enabled.

Use Computer Setup to verify the storage security feature
disabled settings.

Diskette is damaged.

Replace the damaged disk.

Cannot format diskette. Invalid media reported.

When formatting a disk in MS-DOS, you might need to
specify diskette capacity. For example, to format a 1.44-
MB diskette, enter the following command at the MS-
DOS prompt:

FORMAT A: /F:1440

A problem has occurred with a disk
transaction.

The directory structure is bad,
or there is a problem with a file.

In Windows 2000 and Windows XP, right-click Start,
click Explore, and select a drive. Select
File>Properties>Tools. Under Error-checking, click
Check Now.

Diskette drive cannot read Diskette is not formatted.

a diskette.

Format the diskette.

You are using the wrong
diskette type for the drive type.

Verify the type of drive that you are using and use the
correct diskette type.

You are reading the wrong
drive.

Verify the drive letter in the path statement.

Diskette is damaged.

Replace the diskette with a new one.

A diskette that does not contain
the system files needed to start
the workstation has been
inserted in the drive.

“Invalid system disk” message is
displayed.

When drive activity stops, remove the diskette and press
the Spacebar. The workstation should start up.

Diskette error has occurred.

Restart the workstation by pressing the power button.

Cannot Boot to Diskette. Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been
disabled in Computer Setup.

Run Computer Setup and enable diskette boot in
Storage>Boot Order.

Removable media boot has
been disabled in Computer
Setup.

Run Computer Setup and enable Removable Media Boot
in Storage>Storage Options.

Diskette MBR validation is
enabled.

Run Computer Setup and disable Diskette MBR
Validation in Storage>Storage Options.

Solving

Table 5-6 Hard drive problems

Problem Cause

Solution

Hard disk has bad sectors or
has failed.

Hard drive error occurs.

Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Or, run DPS Self-test if the drive is detected by the BIOS.
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Table 5-6 Hard drive problems (continued)

Problem Cause

Solution

Disk transaction problem. The directory structure is bad,

or there is a problem with a file.

Right-click Start, click Explore, and select a drive.
Select File>Properties>Tools. Under Error-checking,
click Check Now.

Drive not found (identified). Loose cable.

Verify cable connections.

The system might not have
automatically recognized a
newly installed device.

1. Run Computer Setup.

2.  If the system still does not recognize the new device,
verify to see if the device is listed within Computer
Setup. If it is listed, the probable cause is a driver
problem. If it is not listed, the probable cause is a
hardware problem.

3. Ifthis drive is newly installed, enter Setup and try
adding a POST delay under Advanced>Power-On.

Drive jumper settings might be
incorrect.

If the drive is a secondary drive that has just been installed
on the same cable as the primary drive, verify that the
jumpers for both drives are set correctly.

Drive responds slowly
immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced>Power-On Options.

Non-system disk/NTLDR missing
message.

System is trying to start from a
non-bootable diskette.

Remove the diskette from the diskette drive.

Non-system disk/NTLDR missing
message.

System is trying to start from a
damaged hard drive.

1. Insert a bootable diskette into the diskette drive and
restart the workstation.

2. Ifthe hard drive is still inaccessible and MBR Security
is enabled, try restoring the previously saved
MBR image by entering Setup and selecting
Security>Restore Master Boot Record.

System files missing or not
properly installed.

1. Insert a bootable system diskette and restart.
2. Verify that the hard drive is partitioned and formatted.

3. Install system files for the appropriate operating
system if necessary.

Hard drive boot disabled in
Computer Setup.

Run Computer Setup and enable the hard drive entry in
the Storage>Boot Order list.

Second Ultra ATA hard drive does
not perform optimally.

Using the wrong cable for the
drive type.

Reinstall the second Ultra ATA hard drive using an 80-
conductor cable (standard on select models.)

Both slow and fast UATA
devices are on the same data
cable.

Connect slower UATA devices to a separate data cable
connected to the secondary IDE (ATA) controller.

Workstation will not start. Hard drive is damaged.

Observe the beeps and LEDs on the front of the
workstation. Refer to POST and error messages

on page 124.

Solving display problems

Table 5-7 Display problems

Problem Cause

Solution

The cable connections are not
correct.

Blank screen (no video).

Verify the cable connections from the monitor to the
workstation and to a working electrical outlet.
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Table 5-7 Display problems (continued)

Problem

Cause

Solution

The monitor is off.

Switch the monitor to on (LED is on). You might need to
refer to the monitor manual for an explanation of the LED
signals.

Screen blanking utility installed
or energy saver features
enabled.

Press any key or click the mouse button, and, if set, enter
your password.

System ROM is bad; system is
running in FailSafe Boot Block
mode (indicated by 8 beeps).

Reflash the ROM using a SoftPaq diskette.

Fixed-sync monitor will not
sync at the resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Monitor settings in the
workstation are not compatible
with the monitor.

1. Restart the workstation and press F8 during startup
when you see Press F8 in the bottom-right corner of
the screen.

2. Using the keyboard arrow keys, select Enable VGA
Mode and press Enter.

3. In Windows Control Panel, double-click the Display
icon and select the Settings tab.

4. Use the sliding control to reset the resolution.

The display works properly during
the POST but goes blank when the

operating system starts.

The display settings in the
operating system are
incompatible with your
graphics card and monitor.

1.  Restart your workstation in VGA mode.

2.  After the operating system starts, change the display
settings to match those supported by your graphics
card and monitor.

3. Refer to your operating system and graphics card
documentation for information on changing display
settings.

Power LED flashes red 6 times,

once every second, followed by a

2—second pause, and the
workstation beeps 6 times.

Pre-video graphics error.

For systems with a graphics card:
1. Reseat the graphics card.
2. Replace the graphics card.

3. Replace the system board.

Monitor does not function properly

when used with energy saver
features.

Monitor without energy saver
capabilities is being used with
energy saver features
enabled.

Disable monitor energy saver feature.

Dim character s.

The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly
connected.

Verify that the graphics cable is securely connected to the
graphics card and the monitor.

Blurry video or requested
resolution cannot be set.

If the graphics controller was
upgraded, the correct video
drivers might not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of
displaying requested
resolution.

Change requested resolution.
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Table 5-7 Display problems (continued)

Problem Cause Solution
The picture is broken up, rolls, The monitor connections might 1.  Be sure the monitor cable is securely connected to the
jitters, or flashes. be incomplete, or the monitor workstation.

might be incorrectly adjusted.
In a 2-monitor system or if another monitor is in close

proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

3. Fluorescent lights or fans might be too close to the
monitor.

Monitor must be degaussed. Degauss the monitor.

Vibrating or rattling noise coming Monitor degaussing coil has None. It is normal for the degaussing coil to be activated

from inside a CRT monitor when been activated. when the monitor is powered on.

powered on.

Clicking noise coming frominside a  Electronic relays have been None. It is normal for some monitors to make a clicking
CRT monitor. activated inside the monitor. noise when turned on and off, when going in and out of

Standby mode, and when changing resolutions.

High pitched noise coming from Brightness and contrast Lower brightness and contrast settings.

inside a flat-panel monitor. settings are too high.

Fuzzy focus; streaking, ghosting, Flat-panel monitor’s internal 1. Select the monitor's Auto-Adjustment option in the
or shadowing effects; horizontal digital conversion circuits monitor’s on-screen display menu.

scrolling lines; faint vertical bars; or might be unable to correctly
unable to center the picture on the interpret the output

screen. (Flat-panel monitors using  synchronization of the graphic
an analog VGA input connection card.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. Download SoftPaq
SP20930 or SP22333, depending on the monitor, to
assist with the synchronization.

only.)
Certain typed symbols do not The font you are using does Use the Character Map to locate the and select the
appear correctly. not support that particular appropriate symbol. ClickStart>All Programs>

symbol. Accessories>System Tools>Character Map. You can
copy the symbol from the Character Map into a document.

Solving audio problems
Table 5-8 Audio problems

Problem Cause Solution
Sound does not come out of the Software volume control is Double-click the Speaker icon on the taskbar and use the
speaker or headphones. turned down. volume slider to adjust the volume.

The external speakers are not  Turn on the external speakers.
turned on.

External speakers plugged into  See the sound card documentation for proper speaker
the wrong audio jack. connection.

Audio cable not connected. Connect audio cable between CD or DVD-ROM drive and
the system board.

Digital CD audio is Enable digital CD audio:

not enabled.
1. From the Control Panel, select System.

2.  On the Hardware tab, click the Device Manager
button.
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Table 5-8 Audio problems (continued)

Problem

Cause

Solution

Right-click the CD/DVD device and select
Properties.

On the Properties tab, be sure Enable digital CD
audio for this CD-ROM device is selected.

Headphones or devices
connected to the line-out

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external

connector mute the internal speakers.
speaker.
Volume is muted. 1. From the Control Panel program, click Sound,

Speech and Audio Devices, then click Sounds and
Audio Devices.

Click the Mute checkbox to remove the checkmark
from the box.

Computer is in Standby mode.

Press the power button to resume from Standby mode.

Noise or no sound comes out of the
speakers or headphones.

1.

If using digital speakers that have a stereo jack and
want the system to auto-switch to digital, use a stereo-
to-mono adapter to properly engage the auto-sense
feature or use the multimedia device properties

to manually switch the audio signal from analog to
digital.

If the headphones have a mono jack, use the
multimedia device properties to switch the system to
analog out.

NOTE:

you switch back to an auto-sense or analog mode.

If you set digital as the Output Mode, the internal speaker and external analog speakers will no longer output audio until

If you set analog as the Output Mode, external digital speakers will not function until you change the output mode back to an

auto-sense or digital mode.

The sound occurs intermittently.

Processor resources are being  Shut down all open processor-intensive applications.

used by other open
applications.

Workstation appears to be locked
up while recording audio.

The hard disk might be full.

1.

2.

Before recording, be sure there is enough free space
on the hard disk.

Try recording the audio file in a compressed format.

Solving printer problems

Table 5-9 Printer problems

Problem

Cause

Solution

Printer does not print.

Printer is not turned on and
online.

Turn the printer on and be sure it is online.

The correct printer driver for

the application is not installed.

1.
2,

Install the correct printer driver for the application.
Try printing using the MS-DOS command:
DIR C:\> [printer port]

where [printer port] is the address of the printer
being used. If the printer works, reload the printer
driver.
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Table 5-9 Printer problems (continued)

Problem

Cause

Solution

If you are on a network, you
might not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer might have failed.

Run printer self-test.

Printer does not turn on.

The cables might not be
connected properly.

Reconnect all cables.

Printer prints garbled information.

The correct printer driver is not
installed.

Install the correct printer driver for the application.

The cables might not be
connected properly.

Reconnect all cables.

Printer memory might be
overloaded.

Reset the printer by turning it off for one minute, then turn
it back on.

Printer is offline.

The printer might be out of
paper.

1. Verify the paper tray and refill it if it is empty.

2. Select online.

Solving keyboard and mouse problems

Table 5-10 Keyboard and mouse problems

Problem

Cause

Solution

Keyboard commands and typing
are not recognized by the
workstation.

Keyboard connector is not
properly connected.

1. Power off the workstation.

2. Reconnect the keyboard to the back of the
workstation and restart the workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the mouse, and then
restart the workstation.

Keyboard needs repairs.

Replace the keyboard.

Keyboard key is stuck down.

Remove any debris from the keyboard.

Workstation is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Cursor will not move using the
arrow keys on the keypad.

The Num Lock key might be
on.

Press the Num Lock key. The Num Lock light should not
be on if you want to use the arrow keys. The Num Lock key
can be disabled or enabled in Computer Setup.

Mouse does not respond to
movement or is too slow.

Mouse connector is
not properly plugged into the
back of the workstation.

1. Shut down the workstation using the keyboard.

2. Plug the mouse connector into the PS/2 mouse
connector slot in the workstation, and restart the
workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the keyboard and then
restart the workstation.

Mouse needs repairs.

Replace the mouse.

Workstation is in Standby
mode.

Press the power button to resume from Standby mode.

Mouse will only move vertically or
horizontally, or movement is jerky.

Mouse roller ball is dirty.

Remove roller ball cover from the bottom of the mouse and
clean it. Then, replace cover.
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Solving front panel component problems

If you are experiencing problems with one of the front panel ports, you might be able to try your device
in the corresponding port on the back side of the computer. If this does not fix the problem or you must
use the front panel ports, continue troubleshooting.

Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.

Table 5-11 Front panel component problems

Problem Cause Solution

A USB device, headphone, or The device is not properly 1. Power off the workstation.
microphone is not recognized by connected.

the workstation. 2. Reconnect the device to the front of the workstation

and restart the workstation.

The device does not have If the USB device requires AC power, be sure one end is
power. connected to the device and one end is connected to a live
outlet.

The correct device driverisnot 1. Install the correct driver for the device.

installed.
2. You might need to reboot the workstation.

The cable from the device to 1. If possible, replace the cable.

the computer does not work.
Restart the workstation.

The device is not working. 1. Replace the device.

2. Restart the workstation.

A USB, audio, or IEEE-1394 The internal cables might not 1.  Power off the workstation.
devices is not working. be connected to the system
board or the PCI card. 2. Connect the cables correctly.

A device in the IEEE-1394 portis  Cables of new external device Be sure that all cables are properly and securely

not responsive. are loose, or power cables are connected.
unplugged.
The power switch on the Power off the workstation, power on the external device,
device is not turned on. then power on the workstation to integrate the device

with the workstation system.

The IEEE-1394 port is not active. ~ The portis not there because it You can buy an IEEE 1394 PCI adapter card. Contact an
was not purchased with the HP seller.
system.

Solving hardware installation problems

You might need to reconfigure the workstation when you add or remove hardware, such as an additional
diskette drive. If you install a Plug and Play (PnP) device, Windows 2000 and Windows XP automatically
recognize the device and configure the workstation. If you install a non-PnP device, you must reconfigure
the workstation after completing installation of the new hardware.

Table 5-12 Hardware installation problems

Problem Cause Solution
A new device is not recognized as  Device is not seated or Be sure that the device is properly and securely connected
part of the system. connected properly. and that pins in the connector are not bent down.
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Table 5-12 Hardware installation problems (continued)

Problem

Cause

Solution

Cables of new external device
are loose, or power cables are
unplugged.

Be sure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external
device is not turned on.

Power off the workstation, power on the external device,
then power on the workstation to integrate the device
with the workstation system.

When the system advised you
of changes to the
configuration, you did not
accept them.

Reboot the workstation and follow the instructions for
accepting the changes.

A PnP board might not
automatically configure when
added if the default
configuration conflicts with
other devices.

Use Windows XP Device Manager to deselect the
automatic settings for the board and choose a basic
configuration that does not cause a resource conflict. You
can also use Computer Setup to reconfigure or disable
devices to resolve the resource conflict.

Device hardware is not
properly jumpered or
otherwise configured.

Read the device-specific configuration information and
check for incorrect settings or conflicts with other devices
already installed in the system.

Workstation will not start.

Wrong memory modules were
used in the upgrade, or
memory modules were
installed in the wrong location.

1. Review the documentation that came with the system
to determine if you are using the correct memory
modules and to verify the proper installation.

2. Observe the beeps and LEDs on the front of the
workstation. Refer to POST and error messages
on page 124 to determine possible causes.

PCI Express power cable
might be plugged into the
wrong connector on the
system board.

Connect the auxiliary PCI Express power cable to the PCI
Express card.

Power LED flashes red 5 times,
once every second, followed by a
2-second pause, and the
workstation beeps 5 times.

Memory is installed incorrectly
or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.
Replace the system board.

Power LED flashes red 6 times,
once every second, followed by a
2-second pause, and the
workstation beeps 6 times.

Video card is not seated
properly or is bad, or system
board is bad.

For systems with a graphic card:
1. Reseat the graphics card.
2. Replace the graphics card.

3. Replace the system board.

Solving network problems

These guidelines do not discuss the process of debugging the network cabling.

Table 5-13 Network problems

Problem

Cause

Solution

Wake-on-LAN feature is not
functioning.

Wake-on-LAN is not enabled.

Use the Network control application to enable Wake-on-
LAN.
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Table 5-13 Network problems (continued)

Problem Cause

Solution

Network driver does not detect Network controller is disabled.
network controller.

Run Computer Setup and enable network controller.

Incorrect network driver.

Verify the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’'s
website.

Network status link light does not No active network is detected.
illuminate or it never flashes.

Verify cabling and network equipment for proper
connection.

The network status light should  Network controller is not set up
flash when there is network properly.

activity.

Use the Network control application to verify that the
device is working properly.

Network driver is not properly
loaded.

Reinstall network drivers.

System cannot auto-sense the

Disable auto-sensing capabilities and force the system

network. into the correct operating mode.
Diagnostics reports a failure. The cable is not securely Be sure that both ends of the data cable are securely
connected. connected.

The cable is attached to the
incorrect connector.

Be sure that the cable is attached to the correct connector.

There is a problem with the cable
or a device at the other end of the
cable.

Be sure that the cable and device at the other end are
operating correctly.

Network controller interrupt is
shared with an expansion board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller

Replace the NIC.

is defective.
Diagnostics passes, but the Network drivers are not loaded, or 1. Be sure the network drivers are loaded and that the
workstation does not driver parameters do not match driver parameters match the configuration of the

commu

nicate with the network.  current configuration.

network controller.

2. Be sure the correct network client and protocol is
installed.

The network controller is not
configured for this workstation.

Double-click the Network icon in the Control Panel and
configure the network controller.

Network controller stopped Network controller interrupt is
working when an expansion shared with an expansion board.
board was added to the

workstation.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires
drivers.

Verify that the drivers were not accidentally deleted when
the drivers for a new expansion board were installed.

The expansion board installed is a
network card and conflicts with the
embedded network card.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working The files containing the network

without

apparent cause. drivers are corrupted.

Reinstall the network drivers, using the Restore Plus! CD.

The cable is not securely
connected.

Be sure that both ends of the cable are securely attached
to the correct devices.

The network controller is
defective.

Replace the NIC.
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Table 5-13 Network problems (continued)

Problem

Cause

Solution

New network card will not boot.

New network card might be
defective or might not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the
boot sequence to boot from another source.

Cannot connect to network
server when attempting remote
system installation.

The network controller is not
configured properly.

Verify network connectivity, that a DHCP Server is
present, and that the Remote System Installation Server
contains the NIC drivers for your NIC.

System setup utility reports
unprogrammed EEPROM.

Unprogrammed EEPROM.

Flash the ROM.

Solving memory problems

/A CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-

ECC memory. Otherwise, the system will not boot the operating system.

Table 5-14 Memory problems

Problem

Cause

Solution

System will not boot or does not
function properly after installing
additional memory modules.

Memory module is not the
correct type or speed or the
new memory module is not
seated properly.

Replace module with the correct industry-standard device
for the workstation.

On some models, ECC and non-ECC memory modules
cannot be mixed.

Out of memory error.

Memory configuration might
not be set up correctly.

Use the Device Manager to verify memory configuration.

You have run out of memory to
run the application.

Verify the application documentation to determine the
memory requirements.

Memory count during POST is
wrong.

The memory modules might
not be installed correctly.

Verify that the memory modules have been installed
correctly and that proper modules are used.

Insufficient memory error during
operation.

Too many Terminate and Stay
Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory
for the application.

Verify the memory requirements for the application or add
more memory to the workstation.

Power LED flashes red 5 times,
once every second, followed by a
2-second pause, and the
workstation beeps 5 times.

Memory is installed incorrectly
or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving processor problems

Table 5-15 Processor problems

Problem Cause

Solution

Poor performance is experienced.  Processor is hot.

1. Be sure the airflow to the workstation is not blocked.

2. Be sure the fans are connected and working properly

(some fans only operate when needed).

3. Be sure the CPU heatsink is installed properly.

Power LED is red and stays on. Processor is not seated
properly or not installed.

1. Verify that the processor is present.

2. Reseat the processor.

Solving CD-ROM and DVD problems

Table 5-16 CD-ROM and DVD problems

Problem Cause

Solution

System will not boot from CD-ROM  The CD-ROM or DVD boot is
or DVD drive. not enabled through the
Computer Setup utility.

Run the Computer Setup utility and enable booting to
removable media and verify boot order settings.

Non-bootable CD in drive.

Try a bootable CD in the drive.

CD-ROM or DVD devices are not  Drive is not connected properly
detected or driver is not loaded. or not properly configured.

1. Reconnect power and data cables to the drive.

2. Install correct device driver.

Movie will not play in the DVD drive. Movie might be regionalized
for a different country.

See the documentation that came with the DVD drive.

Decoder software is not

Install decoder software.

installed.
Cannot eject CD (tray-load unit). Disc not properly seated inthe 1.  Power off the workstation and insert a thin metal rod
drive. into the emergency eject hole and push firmly.

2.  Slowly pull the tray out from the drive until the tray is

fully extended, and remove the disc.

CD-ROM, CD-RW, DVD-ROM, or  CD has been inserted upside
DVD-R/RW drive cannot read a down.

Reinsert the CD with the label facing up.

disc or takes too long to start.
The DVD-ROM drive takes

longer to start because it has to
determine the type of media
played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive

determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit.
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Table 5-16 CD-ROM and DVD problems (continued)

Problem Cause Solution

Windows does not detectthe 1.  Use Device Manager to remove or uninstall the
CD-ROM or DVD-ROM drive. device in question.

2. Restart the workstation and let Windows detect the
device.

Recording audio CDs is difficult or  Wrong or poor quality media 1. Use a slower recording speed.

impossible. type. ) ) )
2. Verify that you are using the correct media for the

drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving Internet access problems

Table 5-17 Internet access problems

Problem Cause Solution

Unable to connect to the Internet.  Internet Service Provider (ISP) Verify Internet settings or contact the ISP for assistance.
account is not set up properly.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up Verify that the web browser is installed and set up to work
properly. with your ISP.

Cable/ DSL modem is not Plug in cable/DSL modem. You should see a “power” LED
plugged in. on the front of the cable/DSL modem.

Cable/DSL service is not Try connecting to the Internet at a later time or contact your
available or has been ISP. (If the cable/DSL service is connected, the “cable” LED
interrupted because of bad light on the front of the cable/DSL modem will be on.)
weather.

The CAT5 10/100/1000 cable  Connect the CAT5 10/100/1000 cable between the cable

is disconnected. modem and the workstations’s RJ-45 connector. (If the
connection is good, the “PC” LED on the front of the cable/
DSL modem will be on.)

IP address is not configured Contact the ISP for the correct IP address.

properly.
Cookies are corrupted. 1.  Select Start>Control Panel.
2. Double-click Internet Options.
3. Onthe General tab, click the Delete Cookies button.
Cannot automatically launch You must log on to the ISP Log on to the ISP and launch the desired program.
Internet programs. before some programs will
start.

Internet takes too long to download Modem is not set up properly. 1.  Select Start>Control Panel.

websites.
Continue with step #2.

Double-click System. Click the Hardware tab.

> 0N

In the Device Manager area, click the Device
Manager button.

5. Double-click Ports (COM & LPT).
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Table 5-17 Internet access problems (continued)

Problem

Cause

Solution

Right-click the COM port your modem uses, then
click Properties.

Under Device status, verify that the modem is working
properly.

Under Device usage, verify the modem is enabled.

If there are further problems, click the Troubleshoot
button and follow the on-screen instructions.

POST and error messages

POST is a program run at startup that initializes and runs some tests on installed hardware. An audible
and/or visual message occurs if the POST encounters a problem. POST checks the following items to

ensure that the workstation system is functioning properly:

e Keyboard
e Memory modules

° Diskette drives

e Al SATA and SAS mass storage devices

° Processors

e Controllers

must enter the password before continuing.

¥ NOTE: If the power-on password is set, a key icon appears on the screen while POST is running. You

Table 5-18 POST error messages

Screen message

Probable cause

Recommended action

101—Option ROM Error

System ROM checksum.

Verify the correct ROM:
1. Flash the ROM if needed.

2. If an expansion card was recently added, remove
it and see if the problem remains.

3. Clear CMOS. If the message disappears, there
might be a problem with the expansion card

4. Replace the system board.

102—System Board Failure

DMA, timers, etc.

1. Clear CMOS.
2. Remove expansion boards.

3. Replace the system board.

103—System Board Failure

DMA, timers, etc.

1. Clear CMOS.
2. Remove expansion boards.

3. Replace the system board.

110—Out of Memory for
Option ROMs

Option ROM for a device was unable
to run due to memory constraints.

Run Computer Setup and enable the ACPO/USB
Buffers at Top of Memory under the
Advanced>Power-On option.
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Table 5-18 POST error messages (continued)

Screen message

Probable cause

Recommended action

150—SafePost Active A PCI expansion card is not 1. Restart the workstation.
responding. .
2. Disable SafePost.
3.  If the expansion card does not respond, replace
the card.
162—System Options Not Set  Configuration incorrect. RTC battery 1. Run Computer Setup (F10 Setup).
might need to be replaced.
2. Set the date and time under Control Panel or in
F10 Setup depending on the operating system.
3.  If the problem persists, replace the RTC battery.
163—Time and Date Not Set  Invalid time or date in configuration 1.  Set the date and time under Control Panel or in
memory. F10 Setup depending on the operating system.
RTC battery might need to be 2. If the problem persists, replace the RTC battery.
replaced.
CMOS jumper might not be properly
installed.
164—Memory Size Error Memory configuration is incorrect. 1. Run Computer Setup (F10 Setup) or Windows
utilities.
2. Be sure memory modules (if any) are installed
properly.
3.  If third-party memory has been added, test using
HP memory only.
4. Verify proper memory module type.

183—Invalid Processor

Jumper Setting

System board jumper improperly set.

Reset system board jumpers to match processor and
bus speeds (select models).

201—Memory Error

RAM failure.

1.

Run Computer Setup (F10 Setup) or Windows
utilities.

Be sure that memory and continuity modules are
installed correctly.

Verify proper memory module type.

Remove and replace memory modules one at a
time to isolate faulty module.

Replace the faulty memory modules.

If error persists after replacing memory modules,
replace the system board.

202—Memory Type Mismatch

Memory modules do not match each
other.

Replace memory modules with matched sets.

207—ECC Corrected Single Single-bit ECC error. 1. Verify proper memory module type.
Bit Errors
2. Insert the DIMM in another memory socket.
3. Replace memory module if problem persists.
212—Failed Processor Processor has failed to initialize. 1.  Reseat the processor in its socket.
2.  If the processor does not respond, replace it.
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Table 5-18 POST error messages (continued)

Screen message

Probable cause

Recommended action

213—Incompatible memory
Module

A memory module in memory socket
identified in the error message is
missing critical SPD information or is
incompatible with the chipset.

1. Verify proper memory module type.
2. Insert the DIMM in another memory socket.

3. Replace memory with a module conforming to the
SPD standard.

214—DIMM Configuration
Warning

DIMMs not installed correctly (not
paired correctly).

See the illustration on the side access panel for the
correct memory configurations and reseat the DIMMs
accordingly.

215—Memory Mismatch
Warning

There are one or more mismatched
pairs of DIMMs between channel A and
channel B. Some memory has been
disabled. Install matching pairs or
remove the mismatched DIMMs from
channel B.

See the illustration on the side access panel for the
correct memory configurations and reseat the DIMMs
accordingly.

216—Memory Size Exceeds
Maximum Supported

The amount of memory installed
exceeds that supported by the
hardware.

1. Verify how much memory your system can
support.

2. Remove the excessive memory.

219—ECC Memory Module
Detected.

ECC modules not supported on this
platform.

Remove the ECC module.

301—Keyboard Error

Keyboard failure.

1. Reconnect the keyboard with workstation
powered off.

2. Check the connector for bent or missing pins.
3. Be sure that none of the keys are pressed.

4. Replace the keyboard.

303—Keyboard Controller
Error

1/0O board keyboard controller.

1. Reconnect keyboard with workstation turned off.

2. Replace the system board.

304—Keyboard or System
Unit Error

Keyboard failure.

1. Reconnect the keyboard with workstation turned
off.

2. Be sure that none of the keys are pressed.
3. Replace keyboard.

4. Replace system board.

401—~Parallel Port 1 Address
Assignment Conflict

IRQ address conflicts with another
device.

Reset the IRQ.

402—Parallel Port 2 Address
Assignment Conflict

IRQ address conflicts with another
device.

Reset the IRQ.

403—Parallel Port 3 Address
Assignment Conflict

IRQ address conflicts with another
device.

Reset the IRQ.

404—~Parallel Port Address
Conflict Detected

Both external and internal ports are
assigned to parallel port X.

1. Remove any parallel expansion cards.
2. Clear CMOS.

3. Reconfigure card resources and run Computer
Setup (F10 Setup).

410—Audio Interrupt Conflict

IRQ address conflicts with another
device.

Reset the IRQ.
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Table 5-18 POST error messages (continued)

Screen message

Probable cause

Recommended action

411—Network Interface Card
Interrupt Conflict

IRQ address conflicts with another
device.

Reset the IRQ.

501—Display Adapter Failure

Graphics display controller.

1. Reseat the graphics card (if applicable).
2. Clear CMOS.

3. Verify that the monitor is attached and turned on.

510—Splash Screen image
corrupted

Splash Screen image has errors.

Install latest version of SoftPaq to restore image.

511—CPU, CPUA, or CPUB
Fan not detected

Fan is not connected or might have
malfunctioned.

1.  Reseat the fan cable.
2. Reseat the fan.

3. Replace the fan.

512—Chassis, rear chassis, or
front chassis fan not detected

Fan is not connected, might have
malfunctioned.

1. Reseat the chassis, rear chassis, or front chassis
fan cable.

2. Reseat the chassis, rear chassis, or front
chassis fan.

3. Replace the chassis, rear chassis, or front
chassis fan.

514—CPU or Chassis Fan not
detected

CPU fan is not connected or might
have malfunctioned.

1. Reseat the CPU or chassis fan.

2. Replace the CPU or chassis fan.

601—Diskette Controller Error

Diskette controller circuitry or diskette

drive circuitry incorrect.

1. Run Computer Setup (F10 Setup).
2. Verify and replace cables.

3. Clear CMOS.

4. Replace diskette drive.

5

Replace the system board.

605—Diskette Drive Type
Error

Mismatch in drive type.

1. Run Computer Setup (F10 Setup).

2. Disconnect any other diskette controller devices
(tape drives).

3. Clear CMOS.

610—External Storage Device
Failure

External tape drive not connected.

Reinstall tape drive or press F1 and allow system to
reconfigure without the drive.

611—Primary Diskette Port
Address Assignment Conflict

Configuration error.

1. Run Computer Setup (F10 Setup).
2. Remove expansion cards.

3. Clear CMOS.

912—Computer Cover Has
Been Removed Since Last
System Start Up

N/A

No action required.

914—Hood Lock Coil is not
Connected

Hood lock mechanism is missing or not

connected.

1. Reconnect or replace hood locking mechanism.

2. Reseat orreplace hood locking mechanism cable.

916—Power Button Not
Connected

The power button is not connected.

Connect power button.
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Table 5-18 POST error messages (continued)

Screen message

Probable cause

Recommended action

917—Front Audio Not
Connected

The front audio cable is not connected.

Connect front audio cable.

918—Front USB Not
Connected

Front USB is not connected.

Connect front USB cable.

919—MultiBay Riser Not
Connected

MultiBay riser is not connected.

Connect MultiBay riser.

920—Fan Command 2 Pin
Connector from Power Supply
Not Connected

The 2-pin fan connector from the
power supply is not connected.

Connect 2-pin fan connector.

940—Extended ROM
signature not found

The signature at the start of the ROM
flash is missing. Your firmware (BIOS)
is incomplete.

Run SoftPaq again.

960—CPU Overtemp The ambient temperature could 1. Be sure you are not operating the system in an
occurred exceed operating limits environment that exceeds 957F.
(maximum=957?F), or there are .
obstructions to airflow, including dust 2. Disconnect power and open the access panel.
build up. 3. Verify that cables are not blocking CPU heatsink
fans or front fan, if installed.

4. Verify that there is not excessive dust on major
components.

5. If airflow is acceptable and there is not excessive
dust, the thermal sensing circuitry has failed on the
processors or on the system board. You must
replace the processors and/or the system board.

1151—Serial Port 1 Address  Both external and internal serial ports 1. Remove any Comm port expansion cards.
Conflict Detected are assigned to COM1.

2. Clear CMOS.

3. Reconfigure card resources and run Computer
Setup (F10 Setup).

4. Run Computer Setup or Windows utilities.
1152—Serial Port 2 Address  Both external and internal serial ports 1. Remove any Comm port expansion cards.
Conflict Detected are assigned to COM2.

2. Clear CMOS.

3. Reconfigure card resources and run Computer

Setup (F10 Setup).

4. Run Computer Setup or Windows utilities.
1155—Serial Port Address Both external and internal serial ports 1. Remove any Comm port expansion cards.
Conflict Detected are assigned to same IRQ.

2. Clear CMOS.

3. Reconfigure card resources and run Computer

Setup (F10 Setup).
4. Run Computer Setup or Windows utilities.

1201—System Audio Address
Conflict Detected

Device IRQ address conflicts with
another device.

Reset the IRQ.

1202—MIDI Port Address
Conflict Detected

Device IRQ address conflicts with
another device.

Reset the IRQ.

1203—Game Port Address
Conflict Detected

Device IRQ address conflicts with
another device.

Reset the IRQ
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Table 5-18 POST error messages (continued)

Screen message

Probable cause

Recommended action

1720 SMART Hard Drive Hard drive is about to fail. (Some hard 1. Determine if hard drive is giving correct error
Detect Imminent Failure drives have a firmware patch that will message.
fix an erroneous error message.)

2.  Runthe Drive Protection System test if applicable.

3. Apply firmware patch if applicable
(see http://www.hp.com/support).

4. Back up contents and replace hard drive.

1780—Disk 0 Failure The drive is not installed correctly or 1. Be sure that any jumpers are set correctly, and
has failed. that power and drive cables are connected, both
to the drive and the system board.

2. Verify that the cables are the correct cables for
your computer model. If this message persists,
you might need service for your workstation.

1781—Disk 1 Failure The drive is not installed correctly or 1. Besure that any jumpers are set correctly and that
has failed. power and drive cables are connected, both to the
drive and the system board.

2. Verify that the cables are the correct cables for
your computer model. If this message persists,
you may need service for your workstation.

1782—Disk Controller Failure Hard drive circuitry error. 1. Run Computer Setup (F10 Setup).

2. Clear CMOS.

3. Verify cable seating/jumper settings.

4. Run hard drive diagnostics.

5. Disconnect additional drives.

6. Run the Drive Protection System test if available.

7. Replace the hard drive.

8. Replace the system board.

1785—Multibay incorrectly
installed

No other IDE device may be attached
to the same IDE controller.

Attach the MultiBay as device 0 on the secondary IDE
controller.

1790—Disk 0 Error

The drive is not installed correctly or
has failed.

1.

Be sure that any jumpers are set correctly and that
power and drive cables are connected, both to the
drive and the system board.

2. Verify that the cables are the correct cables for
your computer model. If this message persists,
you may need service for your workstation.

1791—Disk 1 Error The drive is not installed correctly or 1. Besure that any jumpers are set correctly and that
has failed. power and drive cables are connected, both to the
drive and the system board.

2. Verify that the cables are the correct cables for
your computer model. If this message persists,
you may need service for your workstation

1792—Secondary Disk Hard drive circuitry error. 1. Run Computer Setup (F10 Setup).
Controller Failure

2. Clear CMOS.

3. Verify cable seating/jumper settings.

4. Run hard drive diagnostics.
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Table 5-18 POST error messages (continued)

Screen message Probable cause Recommended action

5. Disconnect additional drives.
6. Run the Drive Protection System test if available.

7. Replace the hard drive.

1793—Secondary Controller ~ Hard drive circuitry error. 1. Run Computer Setup (F10 Setup).
or Disk Failure

2. Clear CMOS.
3. Verify cable seating/jumper settings.
4. Run hard drive diagnostics.
5. Disconnect additional drives.
6

Run the Drive Protection System test if available.

7. Replace the hard drive.

1794—Inaccessible devices Devices attached to the primary IDE 1. Run Computer Setup (F10 Setup).

attached to primary IDE controller are inaccessible while the

controller SATA controller is set to “Replace
Primary IDE Controller” in Setup.

Select Storage > Storage Options and set SATA
controller to Add as Separate Controller.

1800—Temperature Alert Internal temperature exceeds 1. Verify that workstation air vents are not blocked
specification. and cooling fan is running.

2. Verify processor speed selection.
3. Replace the processor.

4. Replace the system board.

1801—Microcode Patch Error  Processor not supported by ROM Upgrade BIOS to proper version.

BIOS.
1802—Processor Not The system board does not supportthe Replace the processor with a compatible one.
Supported processor.

1803-BIOS Update Needed for This BIOS revision does not support Install the latest BIOS downloaded from

Processor the installed processor. http://www.hp.com.

1998—Master Boot Record The previously saved copy of the MBR Run Computer Setup and save the MBR of the current
has been lost has been corrupted. bootable disk.

1998—Master Boot Record The current MBR does not match the  Use extreme caution. The MBR might have been

has been changed previously saved copy of the MBR. updated due to normal disk maintenance activities (disk

manager, fdisk, or format). Replacing the previously
saved MBR in such situations can cause data loss. If
certain that the MBR change is unintentional and
undesired (for example, due to a virus), run Computer
Setup and restore the previously saved MBR copy.
Otherwise, run Computer Setup and either disable
MBR security or save the MBR of the current bootable

disk.
Invalid Electronic Serial Electronic serial number has become  Run Computer Setup. If Setup already has data in the
Number corrupted. field or will not allow the serial number to be entered,

download from http://www.hp.com and run the utility
SP5572.EXE (SNZERO.EXE).

Run Computer Setup and try to enter serial number
under Security, System ID, and save the changes.
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Table 5-18 POST error messages (continued)

Screen message Probable cause

Recommended action

ECC Multiple Bit Error Chipset has detected more than one
Detected in Memory Module bad bit in a 64-bit quadword of the
memory array.

Replace the memory module.

Parity Check 2 Parity RAM failure.

Run Computer Setup and Diagnostic utilities.
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A

Appendix A — SAS devices

Supported SAS RAID configurations

The following RAID configurations are supported on the HP xw4400 Workstation.

Bf NOTE: This section does not apply to configuring RAID in the Linux environment. For RAID in the

Linux environment, configure SW RAID configurations as provided by Red Hat Enterprise Linux.

e Up to 3 internal or external SAS hard disk drives
e Internal-to-external cable for external connections
e SAS to SATA data and power converter
e LSI MyStorage Utility for Windows
The following RAID configurations are supported on the HP xw4400 Workstation:
e RAID 0 - Striped disk array

° Two drives minimum

° Improved I/O performance

o No fault tolerance
e RAID 1 — Mirrored disk array

° Two drive minimum

° 100% redundancy

0 Can recover from single drive failure

° Improved read performance
e RAID1E

° Three drives minimum

o Can be an odd number of drives

° Can always recover from a single drive failure and, in some cases, can recover from two drive
failures

SAS RAID 0 configuration

ENWW

Follow the steps below to configure an Integrated Striped (IS) volume with the BIOS-based configuration
utility. The configuration procedure assumes that the system already has the required disk and disk
controllers.

1. On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

2. Press Enter to go to the Adapter Properties screen.

3.  On the Adapter Properties screen, use the arrow keys to select RAID Properties.
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Press Enter to go to the RAID Properties screen.

In the RAID Properties screen, use the arrow keys to select the first disk for the IS volume. Then
use the arrow keys to move to the Array Disk column for this disk, and press the SPACE, +, or -
key to select Yes as the value for this column. If partitions are defined on the selected disk, a
message appears warning you that data on the disk will be lost when the striped volume is created.
Press the M key to migrate, or the D key to delete the data on the drive.

Repeat the previous step to select up to three more disks for the striped volume.

Press the C key to create the array once all drives have been chosen, then press Esc and
select Save.

SAS RAID 1 configuration

Follow the steps below to configure an Integrated Mirroring (IM) volume with the BIOS-based
configuration utility. The configuration procedure assumes that the system already has the required disk
and disk controllers.

1.

a > » DN

On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

Press Enter to go to the Adapter Properties screen.

On the Adapter Properties screen use the arrow keys to select RAID Properties.
Press Enter to go to the RAID Properties screen. .

Chose one of the following options:

To configure a two-disk mirrored volume with an optional hot spare disk:

e Inthe RAID Properties screen, use the arrow keys to select the primary disk for the IM volume
(the disk with the data you want to mirror.)

e Use the arrow keys to move to the Array Disk column for this disk and use the SPACE key to
select Yes as the value. If partitions are defined on the selected disk, a message appears
warning you that data on the disk will be lost when the striped volume is created. Press the
M key to migrate, or the D key to delete the data on the drive.

e When the Keep Data/Erase Disk message appears, press F3 to keep the data currently on
this disk. The value in the Array Disk column changes to Primary.

e Use the arrow keys to select the secondary (mirrored) disk for the IM volume. Select Yes as
the value for the Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk. Continue with Step 6.

To configure a mirrored volume with three to six disks, or three to five disks with an optional hot
spare disk:

o Inthe RAID Properties screen, use the arrow keys to select the first disk for the IM volume.

e Use the arrow keys to move to the Array Disk column for this disk, and use the + and - keys
to select Yes as the value.

e When the Keep Data/Erase Disk message appears, press Delete to erase the disk.
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e Use the arrow keys to select the next disk for the IM volume. Select Yes as the value for the
Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk.

e Repeat the previous steps to select up to four more disks for the IM volume. If you want to
configure a hot spare disk for the volume, you can only select up to three more disks.

(Optional) Use the arrow keys to select a hot spare disk for the IM volume. Select Yes as the value
for the Hot Spare column.

When you have selected all disks for the IM volume, press Esc and select Save changes, then
exit this menu. If you do not want to create the IM volume, select Discard changes, then exit
this menu.

The IM volume exists as soon as you save the changes. The RAID Properties screen now displays
the IM volume properties and status.

SAS RAID 1E configuration

Follow the steps below to configure an Integrated Mirroring Extended (IME) volume with the BIOS-based
configuration utility. The configuration procedure assumes that the system already has the required disk
and disk controllers.

1.
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On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

Press Enter to go to the Adapter Properties screen.
On the Adapter Properties screen use the arrow keys to select RAID Properties on the screen.

Press Enter to go to the RAID Properties screen. Continue with Step 5 to configure a two-disk
mirrored volume. Go to Step 6 to configure a mirrored volume with three to six disks.

Choose one of the following options:
To configure a two-disk mirrored volume with an optional hot spare disk:

e Inthe RAID Properties screen, use the arrow keys to select the primary disk for the IME volume
(the disk with the data you want to mirror.)

e Use the arrow keys to move to the Array Disk column for this disk and use the SPACE, +,
or - key to select Yes as the value. If partitions are defined on the selected disk, a message
appears warning you that data on the disk will be lost when the striped volume is created.
Press the M key to migrate, or the D key to delete the data on the drive.

e Whenthe Keep Data/Erase Disk message appears, press F3 to keep the data that is currently
on this disk. The value in the Array Disk column changes to Primary.

e Use the arrow keys to select the secondary (mirrored) disk for the IME volume. Select Yes as
the value for the Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk. Continue with Step 6.
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To configure a mirrored volume with three to six disks, or three to five disks with an optional hot
spare disk:

In the RAID Properties screen, use the arrow keys to select the first disk for the IME volume.

Use the arrow keys to move to the Array Disk column for this disk, and use the + and - keys
to select Yes as the value.

When the Keep Data/Erase Disk message appears, press Delete to erase the disk.

Use the arrow keys to select the next disk for the IME volume. Select Yes as the value for the
Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk.

Repeat the previous steps to select up to four more disks for the IME volume. If you want to
configure a hot spare disk for the volume, you can only select up to three more disks.

6. (Optional) Use the arrow keys to select a hot spare disk for the IME volume. Select Yes as the
value for the Hot Spare column.

7.  When you have selected all disks for the IME volume, press Esc and select Save changes, then
exit this menu. If you do not want to create the IME volume, select Discard changes, then exit
this menu.

The IME volume exists as soon as you save the changes. The RAID Properties screen now displays
the IME volume properties and status.
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B Appendix B— SATA devices

This appendix describes how to use the Intel Matrix Storage Manager option ROM Configuration Utility
to set up and manage SATA RAID volumes.

Bf NOTE: Ifonly asingle HDD is attached, the Intel Matrix Storage Manager option ROM will not execute.
All associated messages will not be displayed.

The Intel Serial ATA AHCI BIOS always executes when RAID/AHCI is selected for the SATA emulation
mode. This BIOS is only used to support serial attached optical drives. When an HDD is attached, the
AHCI BIOS properly identifies the HDD that is connected to the appropriate SATA port and displays
Device not supported in this configuration. This message is expected and does not indicate a
problem.

Attaching SATA hard drives

Attach the required number of SATA hard drives for the desired RAID level.
e RAID 0: Two to three HDDs

e RAID 1: Two HDDs

e RAID 5: three HDDs

Configuring system BIOS

Configure the system BIOS to enable embedded SATA RAID functionality.

Press F10 to enter the system BIOS setup.

Use the arrow keys to highlight the desired language, then press Enter.

Use the arrows on your keyboard to highlight Storage>Storage Options, then press Enter.
Use the up or down arrow key to highlight SATA Emulation.

Use the left or right arrow key to select RAID/AHCI.

Press F10 to accept the new setting.

N o a &~ w0 Dd =

Use the arrows on your keyboard to highlight Advanced > Power-On Options, then press
Enter.

8. Use the up or down arrow key to highlight POST Messages.

9. Use the left or right arrow key to select Enable.

10. Press F10 to accept the new setting.

11. Use the arrow keys to highlight Advanced>Device Options, and press Enter.

12. Use the up or down arrow key to highlight SATA RAID Option ROM Download, and press
Enter.

13. Use the left or right arrow key to select Enable.

14. Press F10 to accept the new setting.
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15.
16.

Use the arrows on your keyboard to highlight File>Save Changes and Exit, and press Enter.

Press F10 when prompted.

Creating RAID volumes

Use the Intel Matrix Storage Manager option ROM Configuration Utility to create RAID volumes.

1.

10.
11.
12.
13.

14.

Press Ctrl+l when prompted to enter the Intel Matrix Storage Manager option ROM Configuration
Utility.

If required, see Deleting RAID volumes on page 138 to make enough physical drives available to
create the desired RAID volume.

Use the up or down arrow key to highlight 1. Create RAID Volume, and press Enter.
Type the desired RAID volume name in the Name: field, and press Tab.

Use the up or down arrow key to select the desired RAID level in the RAID Level: field, then
press Tab.

Press Enter to display the Select Disks dialog.

Use the up and down arrow keys and Space to mark individual physical disks as members of the
volume.

Press Enter to exit the Select Disks dialog and return to the Create Volume Menu dialog.

If appropriate, use the up or down arrow key to select the Strip Size in the Strip Size: field, and
press Tab.

Type the desired volume size in the Capacity: field, and press Tab.
Press Enter to initiate volume creation.
When prompted, press Y to acknowledge the warning message and create the volume.

Return to step 3 to create additional RAID volumes, or use ? or ? to highlight 4. Exit, and press
Enter.

Press Y when prompted to confirm the exit.

Deleting RAID volumes

Use the Intel Matrix Storage Manager option ROM Configuration Utility to delete RAID volumes.

1.
2,
3.

Use the up or down arrow key to highlight 2. Delete RAID Volume, and press Enter.
Use the up or down arrow key to highlight the RAID volume to be deleted, and press Del.
When prompted, press Y to confirm the deletion of the selected RAID volume.

Choose one of the following steps:

e Return to step 1 to delete additional RAID volumes.

° See Creating RAID volumes on page 138 to create RAID volumes.

e  Use the up or down arrow key to highlight 4. Exit, and press Enter.

e Use the up or down arrow key to highlight 3. Reset Disks to Non-RAID, and press Enter.
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Use the up and down arrow keys and Space to mark individual physical disks to be reset.
Press Enter to complete the selection.

When prompted, press Y to confirm the reset action.

® N o o

Choose one of the following steps:
e Return to step 1. to delete additional RAID volumes.

e See Creating RAID volumes on page 138 to create RAID volumes.

e Use the up or down arrow key to highlight 4. Exit, and press Enter.
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C Appendix C — Connector pins

Connector pin descriptions

Keyboard Pin Signal
1 Data
E?Ev gggggg: 2 Unused
o " 3 Ground
4 +5VDC
5 Clock
6 Unused
Mouse Pin Signal
1 Data
EE !:EI"% m L l 2 Unused
G0 D 3 Ground
4 +5VDC
5 Clock
6 Unused
Ethernet connector Pin Signal
1 1 (+) Transmit Data
“iﬂ —|||F 2 (-) Transmit Data
- 3 (+) Receive Data
4 Unused
5 Unused
6 (-) Receive Data
7 Unused
8 Unused
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Parallel connector

\@@@@@@@@@@@@/ m

PPRPORPRLOOEO n_Jw
Pin Signal Pin Signal Pin Signal

1 Strobe 7 Data Bit 5 13 Select

2 Data Bit 0 8 Data Bit 6 14 Auto Linefeed

3 Data Bit 1 9 Data Bit 7 15 Error

4 Data Bit 2 10 Acknowledge 16 Initialize Printer

5 Data Bit 3 11 Busy 17 Select IN Signal

6 Data Bit 4 12 Paper End 18-25 Ground

Serial connector Pin Signal

Carrier Detect

(ojojoJolo; 2 Receive Data
(0J0JOJO]
3 Transmit Data
4 Data terminal ready

5 Signal ground

6 Data set ready

7 Request to Send
8 Clear to Send

9 Ring Indicator

USB connector Pin Signal
1 +5VDC
3 + Data
4 Ground
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IEEE 1394 connector Pin Signal
2 4 6 1 Power
1 3 5
3 TPB-
4 TPB+
5 TPA-
6 TPA+
Microphone connector (1/8 inch) Pin Signal
123 1 (Tip) Audio
S\
2 (Ring) Power
3 (Shield) Ground
Headphone connector (1/8 inch) Pin Signal
i 23 1 (Tip) Audio_Left
3 (Shield) Ground
Line-in audio connector (1/8 inch) Pin Signal
123 — 1 (Tip) Audio_In_Left
= I —
2 (Ri Audio_In_Right
=3 (Ring) udio_In_Rig
3 (Shield) Ground
Line-out audio connector (1/8 inch) Pin Signal
123 — 1 (Tip) Audio_Out_Left
—
&'_—lﬂ]:D:QZ'& 2 (Ring) Audio_Out_Right
3 (Shield) Ground
SATA connector
S1 S7 P|1 P15
]I [ mooopooooooonn
| i I@ @l 1
1 I
Data Cable Power Cable Power Cable
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SATA connector

Pin Signal Pin Signal Pin Signal
S1 Ground P1 3.3-V power P8 5-V power
S2* A+ P2 3.3-V power P9 5-V power
S3* A- P3 3.3-V power P10 Ground
S4 Ground P4 Ground P11 Reserved
S5** B- P5 Ground P12 Ground
S6** B+ P6 Ground P13 12-V power
S7 Ground P-7 5-V power P14 12-V power
* 82 and S3 differential signal pair P15 12-V power

**85 and S6 differential signal pair

SAS connector

. A s
L] — Y ]
I: : { { I:—
8 Sl4
Segment Pin Backplane receptacle Plug and cable receptacles
Primary signal segment S1 SIGNAL GROUND
S2 TP+ RP+
S3 TP- RP-
S4 SIGNAL GROUND
S5 RP- TP-
S6 RP+ TP+
S7 SIGNAL GROUND
Secondary signal segment S8 SIGNAL GROUND
S9 TS+ RS+
S10 TS- RS-
S11 SIGNAL GROUND
S12 RS- TS-
S13 RS+ TS+
S14 SIGNAL GROUND
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SAS connector

Power segment P1 V35°
P2 V35°
P3 V33 precharge °©
P4 GROUND
P5 GROUND
P6 GROUND
P7 V¢ precharge °©
P8 A
P9 Vg¢
P10 GROUND
P11 READY LED ¢
P12 GROUND
P13 V,, precharge °©
P14 Vy,°
P15 Vi0®
VGA cconnector
(=)
Pin Signal Pin Signal Pin Signal
1 Red Analog 6 GND 11 Monitor ID
2 Green Analog 7 GND 12 DDC Serial Data
3 Blue Analog 8 GND 13 Horizontal Sync
4 Monitor ID 9 +5VvV DC 14  Vertical Sync
5 GND 10 GND 15  DDC Serial Clock
DVI connector
1 8 C1C2
EsssEEEEs g
Os|itiiiiiedEes O
17 24 C3C4
Pin Signal Pin Signal
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DVI connector

1 T.M.D.S DATA 2- 16 HOT PLUG DETECT

2 T.M.D.S DATA 2+ 17 T.M.D.S DATA 0-

3 T.M.D.S DATA 2/4 SHIELD 18  T.M.D.S DATA 0+

4 T.M.D.S DATA 4- 19  T.M.D.S DATA 0/5 SHIELD
5 T.M.D.S DATA 4+ 2 0 T.M.D.S DATA 5-

6 DDC CLOCK 21 T.M.D.S DATA 5+

7 DDC DATA 22  T.M.D.S CLOCK SHIELD
8 ANALOG VERT. SYNC 23  T.M.D.S CLOCK+

9 T.M.D.S DATA 1- 24  T.M.D.S CLOCK-

10 T.M.D.S DATA 1+

11 T.M.D.S DATA 1/3 SHIELD C1  ANALOG RED

12 T.M.D.S DATA 3- C2  ANALOG GREEN

13 T.M.D.S DATA 3+ C3  ANALOG BLUE

14 +5V POWER C4  ANALOG HORZ SYNC
15 GND C5 ANALOG GROUND

ATA/ATAPI (IDE) standard drive cable connector

39 1

40 2
Pin Signal Pin Signal Pin Signal
1 Reset 15 DD1d 29 DMAK
2 Ground 16 DD14 30 Ground
3 DD7 17  DDO 31 INTRQ
4 DD8 18 DD15 32 I0CS16
5 DD6 19  Ground 33 DA1
6 DD9 20 (Key) 34 PDIAG (cable
detect)
7 DD5 21 DMARQ 35
DAO
8 DD10 22  Ground 36
DA2
9 DD4 23 DIOW 37
CS1FX
10 DD11 24  Ground 38
CS3FX
11 DD3 25 DIOR 39 DASP
12 DD12 26 Ground 40 Ground
13 DD2 27 IORDY
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ATA/ATAPI (IDE) standard drive cable connector

14 DD13

28 CSEL

24-Pin Main power connector

1 +33V 8  POK 14  12VL 21  +5VGND

2 +33V 9  +5Vaux 15  GND 22 +5Vand

3 GND 10 +12V-B 16  PS_O +5 V-Rsense
NI

4 +5V 11 +12V-A 17 GND 23 45V

5 GND 12 +33V 18 GND 24 GND

6 +5V 13 +33V 19 GND

7 GND +3.3V-Rsense 20 GND

/\ CAUTION: Be sure you can differentiate between which power cable connects to the PCI Express
x16 graphics card and which power cable connects to the system board. These two cables have different
pin counts and different colors. The PCI Express power cable has a 6-pin black connector, and the
system board power cable has an 8-pin white connector. When power is present, you must never
connect the PCI Express power cable to the system board. If you do so, the system board may be
damaged and your warranty voided. To see a picture of the PCI Express cable and where it must be

connected, see PCI| Express on page 75.

6-Pin power (auxiliary system board) connector Pin Color Signal
1 BLK w/ORG +3.3V
4 Iﬁj 6
= = 2 BLKw/ORG +3.3V
W) +3.
»
3 YEL +12V-A
4 BLK GND
1 3
5 BLK GND
6 YEL -12v
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8-Pin power (for CPUs and memory) Pin Color Signal
1 BLK GND
W=
— —
2 BLK GND
[w]fis]w)
3 BLK GND
=]
4 BLK GND
1 4 5 WHT +12VCPUO
WHT +12VCPUO RSENSE
6 WHT +12VCPUO
7 WHT +12VCPU1
with
stripe
8 WHT +12VCPU1
with
stripe

/\ CAUTION: Be sure you can differentiate between which power cable connects to the PCI Express
x16 graphics card and which power cable connects to the system board. These two cables have different
pin counts and different colors. The PCI Express power cable has a 6-pin black connector, and the
system board power cable has an 8-pin white connector. When power is present, you must never
connect the PCI Express power cable to the system board. If you do so, the system board may be
damaged and your warranty voided. To see a picture of the PCI Express cable and where it must be

connected, see PCI| Express on page 75.

EBf NOTE: The 6-pin power (auxiliary PCI Express) is only required with high-powered graphics cards.

6-Pin power (auxiliary PCI Express) Pin Color Signal
1 YEL +12V-C
_4| Iﬁl '6_ 2 YEL 12V-C
[ il
|i| |i| 3 YEL +12V-C
1 3 4 BLK GND
5 BLK GND
6 BLK GND
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D Appendix D — System board
designators

This appendix lists the system board designators for this system.

Designator Silkscreen Component
MHO02-03, MH06-09, MH14-15  N/A Mounting holes
E14 BBLK_WP Boot block header/jumper
E49 PSWD Clear password header/jumper
J20 SLOT 5 PCI PCI slot
J21 SLOT 6 PCI PCI slot
J22 N/A PCI slot
J33 SLOT 4 PCI Express slot
J31 SLOT4 PCle x1 PCI Express slot
J32 SLOT3 PCle x16 (4) PCI Express slot
J41 SLOT1 PCle x16 PCI Express slot

P60-63, P66-67

SATAO, SATA1, SATA2

SATA Connectors

J50, P53 PAR/SER Parallel port and serial port stack connector
J68 KBD MS PS2 Stacked keyboard/mouse connector
J9 RJ45/USB Stacked RJ 45/dual USB

J10 UsSB Triple stacked USB

J83 AUD Triple stacked audio jack

SW50 CMOS Clear CMOS switch/push button

P1 PWR Power supply connector (24-pin)

P3 PWRCPU Processor and memory 12V header
P10 FDD Diskette driver connector

P11 AUX Auxiliary audio connector

P20 PRIMARY IDE Primary IDE connector

P23 FRNT AUD Front panel audio header

P24 FRNT USB Front panel USB header

P25 INT USB Internal USB header

P29 HDD LED HDD LED connector

ENWW

149



Designator

Silkscreen

Component

P5 CONTROL PANEL Main power/HDD LED/internal speaker
connector

P70 CPUFAN1 Primary CPU fan header

P71 CPU2FAN Secondary CPU fan header

P8 MEM FAN Memory fan header

P130 CHASSIS FAN Chassis fan header

P9 N/A PCI fan header

P93 N/A Front chassis fan header

XBT2 BAT Battery retainer

XMM1 DIMM1 Memory slot

XMM2 DIMM3 Memory slot

XMM3 DIMM2 Memory slot

XMM4 DIMM4 Memory slot

U1 XU1 Primary processor socket

u2 XuU2 Secondary processor socket

N/A ROM ROM socket

E15 RECOVER Crisis recovery header/jumper
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E Appendix E — Routine care

General cleaning safety precautions

Never use solvents or flammable solutions to clean the workstation.

Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

Always unplug the workstation before cleaning the keyboard, mouse, or air vents.
Always disconnect the keyboard before cleaning it.

Wear safety glasses equipped with side shields when cleaning the keyboard.

Maximizing the airflow

Keep your workstation in an area where the airflow is not obstructed.
Keep the unit off of surfaces where dust can gather.
Keep the front of the unit clear of any obstruction.

Remove any dust on the front panel (vent area) and the rear fans with a small vacuum, compressed
air, or dust rag.

Keep the back of the unit at least 0.15 m (6 in.) away from a wall or other obstruction.

Cleaning the workstation case

ENWW

Follow the safety precautions presented in before cleaning the workstation.
To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

For stronger stains, use a mild dish-washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.
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For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed because the alcohol will
evaporate quickly and not leave a residue.

After cleaning, always wipe the unit with a clean, lint-free cloth.

Occasionally clean the air vents on the workstation. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the keyboard

/A CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under
the keys.

Follow the safety precautions presented in Service considerations on page 52 before cleaning the
keyboard.

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.

CAUTION: Neverremove a wide leveled key (like the space bar) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not
to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor

Follow the safety precautions presented in Service considerations on page 52 before cleaning the
keyboard.

To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or
a clean cloth moistened with water.

CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may
result.

Cleaning the mouse

1.

o & 0 BN

Follow the safety precautions presented in Service considerations on page 52 before cleaning the
mouse.

Remove the mouse ball from the housing by removing the retaining plate.
Clean the mouse ball.
Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

Reassemble the mouse.

152 Appendix E Appendix E — Routine care ENWW



ENWW Cleaning the mouse 153



154 Appendix E Appendix E — Routine care ENWW



Appendix F — Additional password
security and resetting CMOS

This workstation supports the following security password features, which can be established through
the Computer Setup Utilities menu:

e  Setup password
e Power-on password

When you establish a setup password, only the power-on password is required to access Computer
Setup and any other information on the workstation. When you establish both passwords, only the setup
password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on password
as an override to log in to the workstation, which is a useful feature for a network administrator.

If you forget the password for the computer, two methods are available for clearing that password so
you can gain access to the information on the workstation:

e Reset the password jumper

° Use the Clear CMOS button

CAUTION: Pushing the CMOS button resets CMOS values to factory defaults and erases any
customized information, including passwords, asset numbers, and special settings. It is important to
back up the workstation CMOS settings before resetting them in case they are needed later. To back
up the CMOS settings, use Computer Setup and run the Save to Diskette option from the File menu.

Resetting the password jumper

ENWW

To disable the power-on or setup password features and clear the power-on and setup passwords:

1. Shut down the operating system, and power off the workstation and any external devices.
Disconnect the power cord of the workstation and any external devices from the power outlets.

2. Disconnect the keyboard, monitor, and any other external devices that are connected to the
workstation.

/A WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

/A CAUTION: When the workstation is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.

CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity
by briefly touching a grounded metal object.

3. Remove the access panel.

4. Locate the password header and jumper. The password header is E49.
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B NOTE: The password jumper is green so that it can be easily identified. For assistance locating
the password jumper and other system board components, see System board components
on page 57 “System Board Components.”

5. Remove the jumper from either pin 1 or 2. Place the jumper on pins 1 and 2 (connecting both pins
together).

6. Replace the access panel.
7. Reconnect the external equipment.

8. Plug in and power on the workstation. Allow the operating system to start. This process clears the
current passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on either pin
1 or pin 2 (but not both), and repeat steps 6 through 8. Establish the new passwords in Computer
Setup.

Clearing and Resetting the CMOS

The CMOS of the workstation stores password information and information about the workstation
configuration. This section describes the steps to successfully clear and reset the CMOS.

Using the CMOS Button

1. Shut down the operating system, and power off the workstation and any external devices.
Disconnect the workstation power cord and any external devices from the power outlets.

2. Disconnect the keyboard, monitor, and any other external devices that are connected to the
workstation.

/A WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

/A CAUTION: When the workstation is plugged in, the power supply always has voltage applied to
the system board even when the unit is powered off. Failure to disconnect the power cord can
result in damage to the system

CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity
by briefly touching a grounded metal object.

3. Remove the access panel.

/A CAUTION: Pushing the CMOS button resets CMOS values to factory defaults and erases any
customized information, including passwords, asset numbers, and special settings. It is important
to back up the workstation CMOS settings before resetting them in case they are needed later. To
back up the CMOS settings, use Computer Setup and run the Save to Diskette option from the File
menu.

4. Locate, press, and hold the CMOS button in for five seconds.

B NOTE: Be sure thatthe AC power cord is disconnected from the power outlet. The CMOS button
does not clear CMOS if the power cord is connected.

NOTE: For assistance locating the CMOS button and other system board components, see
System board components on page 57 “System Board Components.”

5. Replace the access panel.

156 Appendix F Appendix F — Additional password security and resetting CMOS ENWW



6. Reconnect any external devices.

7. Plug in and power on the workstation.

Bf NOTE: The workstation passwords and any special configurations along with the system date
and time will have to be reset.

Using Computer Setup to Reset CMOS

1. Toreset CMOS using Computer Setup, access the Computer Setup (F10) Utilities menu. When
the Computer Setup message appears in the lower-right corner of the screen, press the F10 key.
Press Enter to bypass the title screen, if necessary.

= NOTE: If you do not press the F10 key while the message is displayed, the workstation must be
powered off, then on again, to access the utility.

2.  From the Computer Setup menu, select File>Set Defaults and Exit. This restores the soft settings
that include boot sequence order and other factory settings. It does not, however, force hardware
rediscovery.

B NOTE: The workstation passwords and any special configurations, along with the system date
and time, will have to be reset.

ENWW Clearing and Resetting the CMOS 157



158 Appendix F Appendix F — Additional password security and resetting CMOS ENWW



G Appendix G — Quick troubleshooting
flowcharts

This appendix presents some quick troubleshooting flowcharts for the following issues:
e Initial troubleshooting

e No power

e Novideo

e  Error messages

e No OS loading

e No OS loading from hard drive

e No OS loading from diskette drive

e No OS loading from CD-ROM drive

e No OS loading from network

e Non-functioning device

Bf NOTE: The flowcharts presented are for general troubleshooting purposes only and they might not
apply to your specific workstation.
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Initial troubleshooting

Begin
Troubleshooting

Is there
power?

Is there
video?

Go to
No Power

Go to
No Video

Beeps,
LEDs, or error
messages?

Goto
Error Messages

Is the O/S
loading?

Goto
No O/S Loading

All drives
working?

Go to
Non-Functioning
Device

New
options or
software

added?

Run
Configuration
Utility

End
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No power
No power, part 1

No Power
(Power LED is off)

Power cord
connected?

Turn computer off.
Plug power cord into
computer and power outlet.

Using power
strip or UPS?

UPS is turned on.

Turn computer off.

Plug power cord int0 [ee———

different active wall outlet.

Turn off power,
disconnect power
cord, and open
the computer.

Go to

No Power, Part 2

ENWW

Caution: Power is continuous to the system board and

Ensure power strip or N

h 4

Restart computer
and return to start
of this chart.

power supply even when the power switch is turned off. To
prevent damage to the unit, disconnect the power cord from
the power source or the unit before beginning disassembly

proceedures.
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No power, part 2

Continued from
No Power, Part 1

Power Supply
connected to
system board?

No Power

Part 2

Caution: Power is continuous to the system board and
power supply even when the power switch is turned off.
To prevent damage to the unit, disconnect the power
cord from the power source or the unit before beginning

disassembly procedures.

Plug power connector
into system board.

Replace system
board.

Y

!

Does system
turn on or boot?

L.

Done

Go to
No Power, Part 3

1. Disconnect AC

—P»| power.

2. Remove all internal
power supply cables.
3. Plug in AC power.

Does power
supply fan
spin AND BIST
LED on rear of
chassis light?

Does power
supply fan NOT
sping OR does
BIST LED on
rear of chassis
NOT light?

+Y

Rreplace power
supply.

Y

162 Appendix G Appendix G — Quick troubleshooting flowcharts

Does system
turn on or boot?

by

Done
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No power, part 3

ENWW

Continued from
No Power, Part 2

Drive power
and data cables
connected?

Loose
or damaged
components?

No Power
Part 3
Reseat drive power and
data cable connectors.
Reseat loose components
and replace damaged ) ) .
items in the computer. Caution: Power is continuous
to the system board and the
‘ power supply even when the

Reinstall cover and
restart computer.

Done

power switch is turned off. To
prevent damage to the unit
disconnect the power cord
from the power source or the
unit before beginning
disassembly procedures.

Does
system
boot?

Replace

power switch. Done

Replace system
board, if you haven't
already.

\ 2

Does system boot?

v Y

Done
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No video
No video, part 1

No Video

Beeps or
flashing CPU
or keyboard
lights?

Monitor LED
on?

Monitor
plugged in and
turned on?

Plug in and turn on
monitor, then
return to
Initial Troubleshooting.

No Video
Part 1

Caution: Power is continuous to the system board
Go to and power supply even when the power switch is
Error Messages, |turned off. To prevent damage to the unit,
Part 1 disconnect the power cord from the power source or
the unit before beginning disassembly procedures.

Contrast anc
brightness
turned up?,

Turn contrast and
brightness up.

LED color?
(note 1)

Video
adapter
connected?
(note 2)

Go to
No Video, Part 2

Plug in, turn on, and
return to
Initial Troubleshooting.

Reconnect
monitor (note 3).

Video OK? Done

Replace monitor.

Notes:
1. Older monitors do not support the amber LED.

2. If more than one adapter is installed, monitor
must be connected to primary controller.

3. Turn off and unplug computer before
reconnecting cables.
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No video, part 2

No Video
Continued Part 2
from
No Video, Part 1
Turn off power,
disconnect power cord,
and open the computer.
i Caution: Power is continuous to
the system board and power supply
Reseat processor, riser even when the power switch is
board, video card, and turned off. To prevent damage to
memory, then clear CMOS. the unit, disconnect the power cord
from the power source or the unit
* before beginning disassembly
procedures.
Replace cover and
power cord, then
restart computer.
F1
Video OK, Message “System
computer “System option option
starts? no set”? not set”
routine

Turn off computer and disconnect
power. Replace components in
system one at a time starting with
hard drive. Test system after each
replacement for video or beeps.

!

Go to
No Video, Part 3

ENWW

Notes:
1. System boards without a piezo speaker, or chassis
without an internal speaker require an external
speaker.

2. Some power supplies require a load greater than
the system board alone to function properly. When
disconnecting drives, disconnect the data cables

but leave the power cables attached.

3. Remove auxillary video card1 integrated video.
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No video, part 3

Continues from
No Video, Part 2

!

Restart computer.

See codes

or flashing
lights or hear
beeps?

No Video
Part 3

Caution: Power is continuous to the system board
and power supply even when the power switch is
turned off. To prevent damage to the unit, disconnect
the power cord from the power source or the unit
before beginning disassembly procedures.

Integrated
video?

Replace
video card.

Turn off computer and
disconnect power. Replace
components in system

one at a time starting with
hard drive. Test system
after each replacement for
video or beeps.

Replace
system board.

Video OK?

Done
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Error messages

Error messages, part 1

ENWW

Beeps,

Error Messages

CPU or keyboard lights, Part 1

or POST error messages.

Caution: Power is continuous to the systemboard and power
supply even when the power switch is off. To prevent
damage to the unit, disconnect the power cord from the power
source or the unit before beginning disassembly procedure.

Power LED has no color showing. Computer is off.

Power LED glows green. Computer is on.

Power LED blinks green once per second. Normal suspend mode.

Power LED blinks red two times, once per second, then a two-second pause,
followed by two beeps. CPU thermal shutdown.

Power LED blinks red three times, then a two-second pause, followed by three
beeps. CPU not installing/fetching code

Power LED blinks red four times, once per second, then a two-second pause,
followed by four beeps. Power supply crow bar.

Power LED blinks red five times, once per second, then a two-second pause,
followed by five beeps. Memory error

Power LED blinks red six times, once per second, then a two-second pause,
followed by six beeps. No video.

| R A A A A

Power LED blinks red seven times, once per second, then a two-second pause,
followed by seven beeps. System board failure prior to video.

Power LED blinks red eight times, once per second, then a two-second pause,
followed by eight beeps. System ROM is bad. System is running in Failsafe Boot
Block Mode.

Audible.26. Power-on successful.

11

Continued on Error messages, Part 2.
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Error messages, part 2

Error Messages
Part 2

Continued from

Caution: Power is continuous to the systemboard and power
supply even when the power switch is off. To prevent

Error Messages, Part 1 damage to the unit, disconnect the power cord from the power

source or the unit before beginning disassembly procedure.

Power LED blinks red five times, once per second, then a two-second pause,
followed by five beeps. System memory not present or incompatible. Unplug and
open computer, check memory modules. Ensure that memory modules are the
correct type and match in size and speed.

Power LED blinks red six times, once per second, then a two-second pause,
followed by six beeps. Video controller not present or incorrectly initialized.
Ensure monitor is plugged in. Unplug and open computer, check video card.
Reseat card and ensure it is in the proper expansion slot.

Power LED blinks seven times, once per second, then a two-second pause,
followed by seven beeps. System hardware failure prior to video. Unplug and
open computer, check for physical damage. Ensure all cables and cards are
seated properly. Look for burn marks or smoke.

Power LED blinks eight times, once per second, then a two-second pause,
followed by eight beeps. ROM failure. Create ROM diskette and reload ROM.
Download ROM Pag from HP website at http://www.hp.com.

Continued on Error Messages, Part 3.
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Error messages, part 3

Error Messages
Part 3

Continued from

Error Messages, Part 2 ] ) ]
Caution: Power is continuous to the systemboard and power

supply even when the power switch is off. To prevent
damage to the unit, disconnect the power cord from the power
source or the unit before beginning disassembly procedure.

Error 162. 2S Beeps System Option not set. Select F1. If error occurs after
reboot, unplug and open computer and check CMOS jumper setting.

Error 163. Time & Date Not Set. Set time and date in F10 or boot OS and set
time and date. If error occurs after reboot, unplug and open computer, and check
CMOS setting.

Error 2xx. Memory Error. Unplug, open computer and reseat memory modules.
Ensure modules are correct type and that they match in size and speed.

Error 30x. Keyboard Error. Do not type on keyboard before POST. Ensure
keyboard connected to proper connector.

bl

Error 6xx. Floppy Error. Unplug, open computer, check diskette drive, and check
and reseat power and data cables.

h 4

Error 91x. Misc. Connection Error. Unplug, open computer, check hood lock coil
and thermal sensor pigtail for good connection.

Error 178x. Fixed Disk Error. Unplug, open computer, check hard drive
and check and reseat power and data cables.

Error 1800. Thermal Alert. System overheating. Allow computer to cool. Ensure
processor has a heatsink installed and that speed setting on system board is
correct. Remove obstructions to air vents.

All others POST error messages, see Chapter 5 for definitions and
solutions.

1T ] 1

Notes: Short (S) and long (L) beeps will only be
heard if the system has a speaker.
LEDs will only function on PS/2 keyboards, not USB.

X =Numbers 1-9
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No operating system loading

O/S not loading from:

CD-ROM drive
go to

NO OIS Loading

from
CD-ROM drive.

Diskette drive,

go to No O/S
Loading from
Diskette drive

Hard drive,
go to No O/S
Loading from

Hard drive

Network,
go to No O/S
Loading from

Network

No OS Loading

Factory recommended booting priority
1. CD-ROM drive

2. Diskette drive

3. Hard drive

4. Network

NOTE: Before beginning, always check
drive jumpers, cable connections, cable

ends, and drives for bent or damaged pins.
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No operating system loading from hard drive

No operating system loading from hard drive, part 1

O/S not loading
from hard drive

Non-
System Disk
message?

Boot from
CcD?

Remove CD and
reboot.

Boot from
hard drive?

Done

ENWW

No OS Loading
From Hard Drive
Part 1

Boot from
network?

Go to

Go to

No O/S Loading from
Hard Drive. Part 2

No O/S Loading
from Network

éo to

No O/S Loading from

Diskette Drive

Boot from
diskette?

Remove diskette
and reboot.

Boot from
hard drive?

Done

Change boot priority
through Computer
Setup and reboot.

Boot from
hard drive?

Go to
Non-Functioning
Device

Done

Factory recommended booting priority

1. CD-ROM drive
2. Diskette drive
3. Hard drive

4. Network

NOTE: Before beginning always check drive jumpers
cable connections, cable ends and drives for bent or
damaged pins.
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No operating system loading from hard drive, part 2

Continued from

No O/S Loading
from
Hard Drive, Part 1

CDor
diskette in
drive?

Replace
hard drive.

Remove diskette
and reboot.

Boot from
hard drive?,

Boot

Done

from diskette
drive?

Go to
No O/S Loading
from
Diskette Drive

Done

No OS Loading
From Hard Drive
Part 2

Computer
boot?

Y

Access
hard drive?

Go to
No O/S Loading
from Hard Drive, Part 3

Run FDISK

ard drive
partition?

Create partition, then
format hard drive to
bootable C:\ prompt.

Hard drive
formatted?,

Format hard drive
and bring to a
bottable C:\ prompt.

y v

Load O/S using
Restore CD if
applicable

Go to

No O/S Loading

from

Hard Drive, Part 3
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No operating system loading from hard drive, part 3

ENWW

Continued from
No O/S Loading
from Hard Drive, Part 2

System

No OS Loading
From Hard Drive
Part 3

files on hard
drive?

Virus
on hard
drive?

Run SCANDISK
check for bad
sectors.

Can bad
sectors
be fixed?

Fix bad
sectors.

Clean virus.

Install O/S
and reboot

Boot from
hard drive?

Run
DPS test.

Boot from
hard drive?

Done

Apply Restore CD
if applicable.

Boot from
hard drive?

Done

Replace
hard drive.

Replace
hard drive.
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No operating system loading from diskette drive

No OS Loading
From Diskette Drive

O/S not loading
from diskette drive

Non-

Bootable

System Disk
message”?

Boot
from another
device?

drive enabled
in Computer

Goto
Non-Functioning
Device

Enable drive and
cold boot
computer.

Clear CMOS

Change boot
priority.

Go to
Non-Functioning
Device

(see notes)

diskette
in drive?

Install bootable
diskette and
reboot computer.

Check diskette for
system files. Try
different diskette.

Bootable
diskette
in drive?

Install bootable
diskette and
reboot computer.

Notes:Factory Recommended

Booting Priority
1. CD-ROM drive
2. Diskette drive
3. Hard drive

4, Network
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No operating system loading from CD-ROM drive

ENWW

No O/S Loading
from CD-ROM
drive

CD in drive?

Install
bootable CD.

No OS Loading
From CD-ROM Drive

Install bootable
CD and reboot
computer.

Try another

bootable CD.

|

Boots from CD~

Booting
from another
device?

Done

Goto
Non-Functioning
Device

Clear CMOS

Correct boot order.
(see notes)

=1 Non-Functioning

Notes:

Factory recommended booting priority
1. CD-ROM drive

2. Diskette drive

3. Hard drive

4. Network

Go to

Device
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No operating system loading from network

No OS Loading
From Network

No O/S loading
from network

Select
F12 on
prompt?

F12
prompt during

attached’

Attach network or :
Select F12 when WOL cable. working

promrgted, network jack.

|ﬁeboot computer. Connect to

A J
Turn off power, Goto A
Compaq disconnect power cord, Non-Functioning
supported open computer, and install Device

NIC? HP compatible NIC.

Boots from
network?

Boots
from another
device?

Done

Notes:
Factory recommended booting priority

Boot order
correct?

1. CD-ROM drive

A 4 2. Diskette drive
Go to ;
Correct boot order, Non-Functioning 3. Hard drive
(see notes) Device
4. Network
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Non-functioning device
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H Appendix H— Configuring SATA and
PATA optical disk drives

This section provides information on the sequence in which the workstation detects and assigns optical
disk drive (ODD) IDs and drive letters when both Serial ATA (SATA) and Parallel ATA (PATA) ODDs
are installed in a workstation. It also provides configuration rules that determine which SATA ports are
functional and which ports can be used to update system BIOS. The following information provides
assumptions and configuration rules for installing SATA and PATA ODDs in the same workstation. It
also provides configuration guidelines for installing SATA ODDs in the same workstation with SATA
hard disk drives (HDDs).

Drive detection and assignment sequence

When mixing PATA and SATA ODDs in a workstation, the PATA optical drive will always be detected
first by the system. For example, if the first ODD is a SATA drive and the second ODD is a PATA drive,
the system will detect the PATA ODD drive first. This will generally result in the PATA ODD being
assigned the lower drive ID or drive designation letter by the operating system.

Workstation SATA port configuration rules

Port configuration rules are determined individually by workstation product as shown in the following
sections.

HP w9400 Workstation BIOS configuration

When the xw9400 Workstation is set to RAID Mode in BIOS, any SATA ports that have an ODD
connected to them must have RAID turned off.

HP xw8400/xw6400/xw4400 Workstation SATA configuration mode settings

When the SATA Configuration Mode for these workstations is set to:

e  Separate Mode - Only SATA ports 0, 1, 2, and 3 are functional for any SATA devices.
e Combined Mode - Only SATA ports 0 and 2 are functional for any SATA devices.

e RAID/AHCI Mode - You will not be able to update system BIOS from the SATA ODD.

e Combined Mode or Separate Mode - BIOS can be updated using a SATA ODD attached to
functional ports.
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